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How to Use this Guide

This manual describes the features of the DataStage® Manager. It is 

intended for application developers and system administrators who 

want to use DataStage to design and develop data warehousing 

applications. 

If you are new to DataStage, read the first chapter for an overview of 

the concepts and use of DataStage. For a brief introduction to data 

warehousing see Chapter 1 of the DataStage Designer Guide.

To find particular topics in this guide you can:

Use the Guide’s contents list (at the beginning of the Guide).

Use the Guide’s index (at the end of the Guide).

Use the Adobe Acrobat Reader bookmarks.

Use the Adobe Acrobat Reader search facility (select Edit ➤ 
Search).

The guide contains links both to other topics within the guide, and to 

other guides in the DataStage manual set. The links are shown in blue. 

Note that, if you follow a link to another manual, you will jump to that 

manual and lose your place in this manual. Such links are shown in 

italics.

Organization of This Manual
This manual contains the following:

Chapter 1 introduces the DataStage client and server components 
and covers DataStage concepts and terminology.

Chapter 2 describes the DataStage Manager user interface.

Chapter 3 describes how you can use the DataStage Manager to 
import or enter table definitions or stored procedure definitions.

Chapter 4 describes data elements and how to define them using 
the DataStage Manager.

Chapter 5 describes how to use the DataStage Manager to 
manage DataStage jobs and job sequences.
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Chapter 6 describes how to use the DataStage Manager to 
manage shared containers.

Chapter 7 describes how you can use the DataStage Manager to 
manage plug-in stages.

Chapter 8 gives an overview of the powerful programming 
facilities available within DataStage which make it easy to 
customize your applications.

Chapter 9 describes mainframe machine profiles and how to 
define them.

Chapter 10 describes IMS Database and IMS Viewset objects.

Chapter 11 describes the configuration file used by parallel jobs.

Chapter 12 describes the Usage Analysis tool, which allows you to 
keep track of where particular DataStage components are used in 
job designs.

Chapter 13 describes the reporting and printing facilities available 
within DataStage.

Chapter 14 describes the message handling facilities available for 
parallel jobs.

Chapter 15 describes the import, export, and packaging facilities 
that enable you to move job designs and job components 
between different DataStage systems.

Chapter 16 describes how to use MetaBrokers to move meta data 
between DataStage and other data warehousing tools.

Chapter 17 describes the facilities available for importing routines 
from web service operations.

Appendix A covers how to navigate and edit the grids that appear 
in many DataStage dialog boxes.

Appendix B provides troubleshooting advice.

Appendix C tells you how to define your own HTML templates in 
order to customize Usage Analysis reports.

Documentation Conventions
This manual uses the following conventions: 

Convention Usage

Bold In syntax, bold indicates commands, function names, keywords, 
and options that must be input exactly as shown. In text, bold 
indicates keys to press, function names, and menu selections.
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The following conventions are also used:

Syntax definitions and examples are indented for ease in reading.

All punctuation marks included in the syntax – for example, 
commas, parentheses, or quotation marks – are required unless 
otherwise indicated.

Syntax lines that do not fit on one line in this manual are 
continued on subsequent lines. The continuation lines are 
indented. When entering syntax, type the entire syntax entry, 
including the continuation lines, on the same input line.

UPPERCASE In syntax, uppercase indicates BASIC statements and functions 
and SQL statements and keywords.

Italic In syntax, italic indicates information that you supply. In text, 
italic also indicates UNIX commands and options, file names, 
and pathnames.

Plain In text, plain indicates Windows commands and options, file 
names, and path names.

Lucida 
Typewriter

The Lucida Typewriter font indicates examples of source code 
and system output.

Lucida 
Typewriter

In examples, Lucida Typewriter bold indicates characters that 
the user types or keys the user presses (for example, 
<Return>).

[ ] Brackets enclose optional items. Do not type the brackets unless 
indicated.

{ } Braces enclose nonoptional items from which you must select 
at least one. Do not type the braces.

itemA | itemB A vertical bar separating items indicates that you can choose 
only one item. Do not type the vertical bar.

... Three periods indicate that more of the same type of item can 
optionally follow.

➤ A right arrow between menu commands indicates you should 
choose each command in sequence. For example, “Choose File 
➤ Exit” means you should choose File from the menu bar, 
then choose Exit from the File pull-down menu.

This line 
➥ continues

The continuation character is used in source code examples to 
indicate a line that is too long to fit on the page, but must be 
entered as a single line on screen.

Convention Usage
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User Interface Conventions
The following picture of a typical DataStage dialog box illustrates the 

terminology used in describing user interface elements:

The DataStage user interface makes extensive use of tabbed pages, 

sometimes nesting them to enable you to reach the controls you need 

from within a single dialog box. At the top level, these are called 

“pages”, at the inner level these are called “tabs”. In the example 

above, we are looking at the General tab of the Inputs page. When 

using context sensitive online help you will find that each page has a 

separate help topic, but each tab uses the help topic for the parent 

page. You can jump to the help pages for the separate tabs from 

within the online help.

DataStage Documentation
The DataStage documentation includes the following:

DataStage Manager Guide: This guide describes the DataStage 

Manager and describes how to use and maintain the DataStage 

Repository.

DataStage Designer Guide: This guide describes the DataStage 

Designer, and gives a general description of how to create, design, 

and develop a DataStage application. 

Option
Button

Button

Check
Box

Browse 
Button

Drop

List
Down

The Inputs Page

The

Tab
General

Field
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DataStage Server: Server Job Developer’s Guide: This guide 

describes the tools that are used in building a server job, and it 

supplies programmer’s reference information.

DataStage Enterprise Edition: Parallel Job Developer’s 
Guide: This guide describes the tools that are used in building a 

parallel job, and it supplies programmer’s reference information.

DataStage Enterprise Edition: Parallel Job Advanced 
Developer’s Guide: This guide gives more specialized 

information about parallel job design.

DataStage Enterprise MVS Edition:  Mainframe Job 
Developer’s Guide: This guide describes the tools that are used 

in building a mainframe job, and it supplies programmer’s 

reference information.

DataStage Director Guide: This guide describes the DataStage 

Director and how to validate, schedule, run, and monitor 

DataStage server jobs. 

DataStage Administrator Guide: This guide describes 

DataStage setup, routine housekeeping, and administration.

DataStage Install and Upgrade Guide. This guide contains 

instructions for installing DataStage on Windows and UNIX 

platforms, and for upgrading existing installations of DataStage.

DataStage NLS Guide. This Guide contains information about 

using the NLS features that are available in DataStage when NLS 

is installed.

These guides are also available online in PDF format. You can read 

them with the Adobe Acrobat Reader supplied with DataStage. See 

DataStage Install and Upgrade Guide for details about installing the 

manuals and the Adobe Acrobat Reader.

You can use the Acrobat search facilities to search the whole 

DataStage document set. To use this feature, select Edit ➤ Search 

then choose the All PDF documents in option and specify the 

DataStage docs directory (by default this is C:\Program 

Files\Ascential\DataStage\Docs).

Extensive online help is also supplied. This is especially useful when 

you have become familiar with using DataStage and need to look up 

particular pieces of information.
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1
Introduction

This chapter is an overview of DataStage. For a general introduction to 

data warehousing, see Chapter 1 of the DataStage Designer Guide.

About DataStage
DataStage has the following features to aid the design and processing 

required to build a data warehouse:

Uses graphical design tools. With simple point-and-click 
techniques you can draw a scheme to represent your processing 
requirements. 

Extracts data from any number or type of database. 

Handles all the meta data definitions required to define your data 
warehouse. You can view and modify the table definitions at any 
point during the design of your application.

Aggregates data. You can modify SQL SELECT statements used to 
extract data. 

Transforms data. DataStage has a set of predefined transforms 
and functions you can use to convert your data. You can easily 
extend the functionality by defining your own transforms to use. 

Loads the data warehouse. 

DataStage consists of a number of client and server components. For 

more information, see "Client Components" on page 1-2 and "Server 

Components" on page 1-2.

DataStage jobs are compiled and run on the DataStage server. The job 

will connect to databases on other machines as necessary, extract 
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data, process it, then write the data to the target data warehouse. This 

type of job is known as a server job.

Parallel jobs are compiled and run on the DataStage server in a 

similar way to server jobs, but support parallel processing on SMP, 

MPP, and cluster systems.

If you have Enterprise MVS Edition installed, DataStage is able to 

generate jobs which are compiled and run on a mainframe. Data 

extracted by such jobs is then loaded into the data warehouse. Such 

jobs are called mainframe jobs. 

Client Components
DataStage has four client components which are installed on any PC 

running Windows 2000 or Windows XP: 

DataStage Manager. A user interface used to view and edit the 
contents of the Repository.

DataStage Designer. A design interface used to create 
DataStage applications (known as jobs). Each job specifies the 
data sources, the transforms required, and the destination of the 
data. Jobs are compiled to create executables that are scheduled 
by the Director and run by the Server (mainframe jobs are 
transferred and run on the mainframe).

DataStage Director. A user interface used to validate, schedule, 
run, and monitor DataStage server jobs.

DataStage Administrator. A user interface used to perform 
administration tasks such as setting up DataStage users, creating 
and moving projects, and setting up purging criteria.

Server Components
There are three server components:

Repository. A central store that contains all the information 
required to build a data mart or data warehouse. 

DataStage Server. Runs executable jobs that extract, transform, 
and load data into a data warehouse. 

DataStage Package Installer. A user interface used to install 
packaged DataStage jobs and plug-ins.
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DataStage Projects
You always enter DataStage through a DataStage project. When you 

start a DataStage client you are prompted to attach to a project. Each 

project contains:

DataStage jobs. 

Built-in components. These are predefined components used in a 
job. 

User-defined components. These are customized components 
created using the DataStage Manager. Each user-defined 
component performs a specific task in a job. 

A complete project may contain several jobs and user-defined 

components. 

There is a special class of project called a protected project. Normally 

nothing can be added, deleted, or changed in a protected project. 

Users can view objects in the project, and perform tasks that affect the 

way a job runs rather than the jobs design. Users with Production 

Manager status can import existing DataStage components into a 

protected project and manipulate projects in other ways.

DataStage Jobs
There are three basic types of DataStage job:

Server jobs. These are compiled and run on the DataStage 
server. A server job will connect to databases on other machines 
as necessary, extract data, process it, then write the data to the 
target data warehouse.

Parallel jobs. These are compiled and run on the DataStage 
server in a similar way to server jobs, but support parallel 
processing on SMP, MPP, and cluster systems.

Mainframe jobs. These are available only if you have Enterprise 
MVS Edition installed. A mainframe job is compiled and run on 
the mainframe. Data extracted by such jobs is then loaded into the 
data warehouse. 

There are three other entities that are similar to jobs in the way they 

appear in the DataStage Designer, and are handled by it. These are:

Server Shared containers. These are reusable job elements. 
They typically comprise a number of stages and links. Copies of 
shared containers can be used in any number of server jobs and 
edited as required. They can also be used in parallel jobs as a way 
of incorporating server functionality.
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Parallel Shared containers. These are reusable job elements 
for parallel jobs. They typically comprise a number of stages and 
links. Copies of shared containers can be used in any number of 
parallel jobs and edited as required. 

Job Sequences. A job sequence allows you to specify a 
sequence of DataStage jobs to be executed, and actions to take 
depending on results.

DataStage jobs consist of individual stages. Each stage describes a 

particular database or process. For example, one stage may extract 

data from a data source, while another transforms it. Stages are 

added to a job and linked together using the Designer.

There are three basic types of stage:

Built-in stages. Supplied with DataStage and used for extracting, 
aggregating, transforming, or writing data. All types of job have 
these stages.

Plug-in stages. Additional stages that can be installed in 
DataStage to perform specialized tasks that the built-in stages do 
not support. Only server jobs have these.

Job Sequence Stages. Special built-in stages which allow you to 
define sequences of activities to run. Only Job Sequences have 
these.

The following diagram represents one of the simplest jobs you could 

have: a data source, a Transformer (conversion) stage, and the final 

database. The links between the stages represent the flow of data into 

or out of a stage.

You must specify the data you want at each stage, and how it is 

handled. For example, do you want all the columns in the source data, 

or only a select few? Should the data be aggregated or converted 

before being passed on to the next stage?

You can use DataStage with MetaBrokers in order to exchange meta 

data with other data warehousing tools. You might, for example, 

import table definitions from a data modelling tool.

Data
Source

Transformer
Stage

Data
Warehouse
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DataStage NLS
DataStage has built-in National Language Support (NLS). With NLS 

installed, DataStage can do the following:

Process data in a wide range of languages

Accept data in any character set into most DataStage fields

Use local formats for dates, times, and money

Sort data according to local rules 

Convert data between different encodings of the same language 
(for example, for Japanese it can convert JIS to EUC)

DataStage NLS is optionally installed as part of the DataStage server. 

If NLS is installed, various extra features (such as dialog box pages 

and drop-down lists) appear in the product. If NLS is not installed, 

these features do not appear.

Using NLS, the DataStage server engine holds data in Unicode 

format. This is an international standard character set that contains 

nearly all the characters used in languages around the world. 

DataStage maps data to or from Unicode format as required. 

Character Set Maps and Locales
Each DataStage project has a language assigned to it during 

installation. This equates to one or more character set maps and 

locales which support that language. One map and one locale are 

assigned as project defaults.

The maps define the character sets that the project can use. 

The locales define the local formats for dates, times, sorting order, 
and so on that the project can use. 

The DataStage client and server components also have maps 

assigned to them during installation to ensure that data is transferred 

between them in the correct character set. For more information, see 

DataStage Administrator Guide and DataStage NLS Guide.

When you design a DataStage job, you can override the project 

default map at several levels:

For a job 

For a stage within a job

For a column within a stage (for Sequential, ODBC, and generic 
plug-in stages in server jobs and Sequential file stages in parallel 
jobs)
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For transforms and routines used to manipulate data within a 
stage

For imported meta data and table definitions

The locale and character set information becomes an integral part of 

the job. When you package and release a job, the NLS support can be 

used on another system, provided that the correct maps and locales 

are installed and loaded.

DataStage Terms and Concepts
The following terms are used in DataStage: 

Term Description

administrator The person who is responsible for the maintenance and 
configuration of DataStage, and for DataStage users.

after-job subroutine A routine that is executed after a job runs.

after-stage 
subroutine

A routine that is executed after a stage processes data. 

Aggregator stage A stage type that computes totals or other functions of sets 
of data.

Annotation A note attached to a DataStage job in the Diagram window. 

BCPLoad stage A plug-in stage supplied with DataStage that bulk loads 
data into a Microsoft SQL Server or Sybase table. (Server 
jobs only.)

before-job 
subroutine

A routine that is executed before a job is run.

before-stage 
subroutine

A routine that is executed before a stage processes any 
data.

built-in data 
elements

There are two types of built-in data elements: those that 
represent the base types used by DataStage during 
processing and those that describe different date/time 
formats.

built-in transforms The transforms supplied with DataStage. See "Built-In 
Transforms and Routines" in Server Job Developer’s Guide 
for a complete list.

Change Apply stage A parallel job stage that applies a set of captured changes 
to a data set.

Change Capture 
stage

A parallel job stage that compares two data sets and 
records the differences between them.
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Cluster Type of system providing parallel processing. In cluster 
systems, there are multiple processors, and each has its 
own hardware resources such as disk and memory.

column definition Defines the columns contained in a data table. Includes the 
column name and the type of data contained in the 
column.

Column Export stage A parallel job stage that exports a column of another type 
to a string or binary column.

Column Import stage A parallel job stage that imports a column from a string or 
binary column.

Combine Records 
stage

A parallel job stage that combines several columns 
associated by a key field to build a vector.

Compare stage A parallel job stage that performs a column by column 
compare of two pre-sorted data sets.

Complex Flat File 
stage

A mainframe source stage or parallel stage that extracts 
data from a flat file containing complex data structures, 
such as arrays, groups, and redefines. The parallel stage 
can also write to complex flat files.

Compress stage A parallel job stage that compresses a data set.

container A group of stages and links in a job design. 

Container stage A built-in stage type that represents a group of stages and 
links in a job design. 

Copy stage A parallel job stage that copies a data set.

custom transform A transform function defined by the DataStage developer.

Data Browser A tool used from within the DataStage Manager or 
DataStage Designer to view the content of a table or file.

data element A specification that describes the type of data in a column 
and how the data is converted. (Server jobs only.)

DataStage 
Administrator

A tool used to configure DataStage projects and users. For 
more details, see DataStage Administrator Guide.

DataStage Designer A graphical design tool used by the developer to design 
and develop a DataStage job. 

DataStage Director A tool used by the operator to run and monitor DataStage 
server jobs.

DataStage Manager A tool used to view and edit definitions in the Repository.

DataStage Package 
Installer

A tool used to install packaged DataStage jobs and plug-
ins.

Data Set stage A parallel job stage. Stores a set of data.

Term Description
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DB2stage A parallel stage that allows you to read and write a DB2 
database.

DB2 Load Ready Flat 
File stage

A mainframe target stage. It writes data to a flat file in Load 
Ready format and defines the meta data required to 
generate the JCL and control statements for invoking the 
DB2 Bulk Loader.

Decode stage A parallel job stage that uses a UNIX command to decode 
a previously encoded data set.

Delimited Flat File 
stage

A mainframe target stage that writes data to a delimited 
flat file.

developer The person designing and developing DataStage jobs.

Difference stage A parallel job stage that compares two data sets and works 
out the difference between them.

Encode stage A parallel job stage that encodes a data set using a UNIX 
command.

Expand stage A parallel job stage that expands a previously compressed 
data set.

Expression Editor An interactive editor that helps you to enter correct 
expressions into a Transformer stage in a DataStage job 
design.

External Filter stage A parallel job stage that uses an external program to filter 
a data set.

External Routine 
stage

A mainframe processing stage that calls an external 
routine and passes row elements to it.

External Source 
stage

A mainframe source stage that allows a mainframe job to 
read data from an external source.

A parallel job stage that allows a parallel job to read a data 
source. 

External Target stage A mainframe target stage that allows a mainframe job to 
write data to an external source.

A parallel job stage that allows a parallel job to write to a 
data source.

File Set stage Parallel job stage. A set of files used to store data.

Filter stage Parallel job stage. Filters out records from an 

input data set.

Fixed-Width Flat File 
stage

A mainframe source/target stage. It extracts data from 
binary fixed-width flat files, or writes data to such a file.

Term Description
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FTP stage A mainframe post-processing stage that generates JCL to 
perform an FTP operation.

Funnel stage A parallel job stage that copies multiple data sets to a 
single data set.

Generator stage A parallel job stage that generates a dummy data set.

Graphical 
performance monitor

A monitor that displays status information and 
performance statistics against links in a job open in the 
DataStage Designer canvas as the job runs in the Director 
or debugger.

Hashed File stage A stage that extracts data from or loads data into a 
database that contains hashed files. (Server jobs only)

Head stage A parallel job stage that copies the specified number of 
records from the beginning of a data partition.

Informix Enterprise 
stage

A parallel job stage that allows you to read and write an 
Informix XPS database.

Intelligent Assistant DataStage comes complete with a number of intelligent 
assistants. These lead you step by step through some of 
the basic DataStage operations.

Inter-process stage A server job stage that allows you to run server jobs in 
parallel on an SMP system.

job A collection of linked stages, data elements, and 
transforms that define how to extract, cleanse, transform, 
integrate, and load data into a target database. Jobs can 
either be server jobs or mainframe jobs.

job control routine A routine that is used to create a controlling job, which 
invokes and runs other jobs.

job sequence A controlling job which invokes and runs other jobs, built 
using the graphical job sequencer.

Join stage A mainframe processing stage or parallel job active stage 
that joins two input sources.

Link collector stage A server job stage that collects previously partitioned data 
together.

Link partitioner stage A server job stage that allows you to partition data so that 
it can be processed in parallel on an SMP system.

local container A container which is local to the job in which it was 
created.

Lookup stage A mainframe processing stage and Parallel active stage 
that performs table lookups.

Term Description
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Lookup File stage A parallel job stage that provides storage for a lookup 
table.

mainframe job A job that is transferred to a mainframe, then compiled and 
run there.

Make Subrecord 
stage

A parallel job stage that combines a number of vectors to 
form a subrecord.

Make Vector stage A parallel job stage that combines a number of fields to 
form a vector.

Merge stage A parallel job stage that combines data sets.

meta data Data about data, for example, a table definition describing 
columns in which data is structured.

MetaBroker A tool that allows you to exchange meta data between 
DataStage and other data warehousing tools.

MPP Type of system providing parallel processing. In MPP 
(massively parallel processing) systems, there are multiple 
processors, and each has its own hardware resources such 
as disk and memory.

Modify stage A parallel job stage that alters the column definitions of the 
output data set.

Multi-Format Flat File 
stage

A mainframe source stage that handles different formats in 
flat file data sources.

NLS National Language Support. With NLS enabled, DataStage 
can support the handling of data in a variety of character 
sets.

normalization The conversion of records in NF2 (nonfirst-normal form) 
format, containing multivalued data, into one or more 1NF 
(first normal form) rows.

null value A special value representing an unknown value. This is not 
the same as 0 (zero), a blank, or an empty string.

ODBC stage A stage that extracts data from or loads data into a 
database that implements the industry standard Open 
Database Connectivity API. Used to represent a data 
source, an aggregation step, or a target data table. (Server 
jobs only)

operator The person scheduling and monitoring DataStage jobs.

Oracle 7 Load stage A plug-in stage supplied with DataStage that bulk loads 
data into an Oracle 7 database table. (Server jobs only)

Oracle Enterprise 
stage

A parallel job stage that allows you to read and write an 
Oracle database.

Term Description
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parallel extender The DataStage option that allows you to run parallel jobs. 

parallel job A type of DataStage job that allows you to take advantage 
of parallel processing on SMP, MPP, and cluster systems.

Peek Stage A parallel job stage that prints column values to the screen 
as records are copied from its input data set to one or 
more output data sets.

plug-in A definition for a plug-in stage. 

plug-in stage A stage that performs specific processing that is not 
supported by the standard server job or parallel job stages.

Promote Subrecord 
stage

A parallel job stage that promotes the members of a 
subrecord to a top level field.

Relational stage A mainframe source/target stage that reads from or writes 
to an MVS/DB2 database.

Remove duplicates 
stage

A parallel job stage that removes duplicate entries from a 
data set.

Repository A DataStage area where projects and jobs are stored as 
well as definitions for all standard and user-defined data 
elements, transforms, and stages.

SAS stage A parallel job stage that allows you to run SAS applications 
from within the DataStage job.

Parallel SAS Data Set 
stage

A parallel job stage that provides storage for SAS data 
sets.

Sample stage A parallel job stage that samples a data set.

Sequential File stage A stage that extracts data from, or writes data to, a text file. 
(Server job and parallel job only)

server job A job that is compiled and run on the DataStage server.

shared container A container which exists as a separate item in the 
Repository and can be used by any server job in the 
project. DataStage supports both server and parallel 
shared containers.

SMP Type of system providing parallel processing. In SMP 
(symmetric multiprocessing) systems, there are multiple 
processors, but these share other hardware resources such 
as disk and memory.

Sort stage A mainframe processing stage or parallel job active stage 
that sorts input columns.

source A source in DataStage terms means any database, whether 
you are extracting data from it or writing data to it.

Term Description
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Split Subrecord 
stage

A parallel job stage that separates a number of subrecords 
into top level columns.

Split Vector stage A parallel job stage that separates a number of vector 
members into separate columns.

stage A component that represents a data source, a processing 
step, or the data mart in a DataStage job.

Switch stage A parallel job stage which splits an input data set into 
different output sets depending on the value of a selector 
field.

table definition A definition describing the data you want including 
information about the data table and the columns 
associated with it. Also referred to as meta data.

Tail stage A parallel job stage that copies the specified number of 
records from the end of a data partition.

Teradata Enterprise 
stage

A parallel stage that allows you to read and write a 
Teradata database.

transform function A function that takes one value and computes another 
value from it.

Transformer Editor A graphical interface for editing Transformer stages.

Transformer stage A stage where data is transformed (converted) using 
transform functions.

Unicode A character set that provides unique code points for all 
characters in every standard character set (with room for 
some nonstandard characters too). Unicode forms part of 
ISO 10646.

UniData stage A stage that extracts data from or loads data into a UniData 
database. Used to represent a data source or a target data 
table. (Server jobs only)

UniData 6 stage A stage that extracts data from or loads data into a UniData 
6.x database. 

UniVerse stage A stage that extracts data from or loads data into a 
UniVerse database using SQL. Used to represent a data 
source, an aggregation step, or a target data table. (Server 
jobs only)

Write Range Map 
stage

A parallel job stage that allows you to carry out range map 
partitioning on a data set.

Term Description
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DataStage Manager Overview

This chapter describes the main features of the DataStage Manager. It 

tells you how to start the Manager and takes a quick tour of the user 

interface. 

The DataStage Manager has many uses. It manages the DataStage 

Repository, allowing you to view and edit the items held in the 

Repository. These items are the building blocks that you use when 

designing your DataStage jobs. You can also use the DataStage 

Manager to define new building blocks, such as custom transforms or 

routines. It allows you to import and export items between different 

DataStage systems, or exchange meta data with other data 

warehousing tools. You can analyze where particular items are used in 

your project and request reports on items held in the Repository. 

Before you start developing your own DataStage jobs, you must plan 

your project and set it up using the DataStage Manager. Specifically, 

you need to assess the data you will be handling and design and 

create the target data mart or data warehouse. It is advisable to 

consider the following before starting a job:

The number and type of data sources you will want to access.

The location of the data. Is your data on a networked disk or a 
tape? You may find that if your data is on a tape, you need to 
arrange for a plug-in stage to extract the data.

Whether you will need to extract data from a mainframe source. If 
this is the case, you will need Enterprise MVS Edition installed and 
you will use mainframe jobs that actually run on the mainframe.

The content of the data. What columns are in your data? Can you 
import the table definitions, or do you need to define them 
manually? Are the definitions of the data items consistent among 
different data sources?
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The data warehouse. What do you want to store in the data 
warehouse and how do you want to store it?

As well as assessing the data in your data sources, you must also 

determine the data you want to load into your data mart or data 

warehouse. The table definitions used to describe the tables you want 

to populate are used in the final stage of your DataStage job. The data 

warehouse must be configured before you can execute a DataStage 

job.

Once you have information about the data you will be handling – meta 

data – you can start entering this information into the DataStage 

Repository, ready to be used by everyone involved in the project.

Starting the Manager
To start the DataStage Manager, choose Start ➤ Programs ➤ 

Ascential DataStage ➤ DataStage Manager. The Attach to 
Project dialog box appears:

You can also start the Manager from the shortcut icon on the desktop, 

or from the DataStage Suite applications bar if you have installed it#.

You specify which project to attach to when starting the DataStage 

Manager. Once you have started the Manager you can switch to a 

different project if required.

To connect to a project:

1 Enter the name of your host in the Host system field. This is the 
name of the system where the DataStage Server components are 
installed.

2 Enter your user name in the User name field. This is your user 
name on the server system.

3 Enter your password in the Password field. 
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Note If you are connecting to the server via LAN Manager, you 

can select the Omit check box. The User name and 

Password fields gray out and you log on to the server 

using your Windows Domain account details. 

4 Choose the project to connect to from the Project drop-down list. 
This list box displays the projects installed on your DataStage 
server.

5 Click OK. The DataStage Manager window appears.

Note You can also start the DataStage Manager directly from the 

DataStage Designer or Director by choosing Tools ➤ Run 
Manager. 

If you connect to a protected project, (Protected) appears in the 

Manager title bar after the project name. You cannot edit the objects 

within a protected project.

The DataStage Manager Window
The DataStage Manager window appears after you have entered your 

project details.

The DataStage Manager operates in two modes, Host View or Project 

View. By default, the DataStage Manager opens in Project View the 

first time, showing the contents of the project that you opened. If you 

switch to Host View, the server hosting DataStage is shown at the top 

of the tree in the left pane, with all the DataStage projects currently 

defined beneath it. You can switch to the other projects in the tree as 

required. The next time you open DataStage Manager, it will reopen in 

whichever mode you left it.

You can also specify whether the Manager will show you an Extended 

Job View or not. With Extended Job View enabled, you can see the 
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individual elements of a job design (for example, links and stages) as 

stored in the Repository. 

Project View

Host View
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The DataStage Manager window has the following components.

Title Bar
The title bar displays the name of the host where the DataStage 

Server components are installed followed by the project you are 

working in. The title bar is updated if you choose to view another 

project in the Repository.

Extended Job View
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Menu Bar
There are six pull-down menus:

– File. Creates data elements, table definitions, routines, 
mainframe machine profiles, and transforms. Creates empty 
categories under existing Repository branches. Allows you to 
open a different DataStage project. Copies, renames, and 
deletes components in the project tree. Allows you to move 
items between categories and examine their properties. 

– View. Specifies whether Host View and Extended Job View are 
operational or not. Specifies how information is displayed in 
the display area. Items can be displayed as large icons, small 
icons, a list, or with details. There are also options to refresh 
the display and to show or hide the toolbar and status bar.

– Import. Imports project or job components, and table 
definitions from data sources or data targets. Also imports 
meta data using MetaBrokers, external function definitions, 
web service function definitions, and IMS definitions, or 
directly from MetaStage.

– Export. Exports projects or job components or job 
executables. Releases and packages jobs and job components 
and exports meta data using MetaBrokers or directly to 
MetaStage.
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– Tools. Gives access to DataStage reporting facilities and usage 
analysis tool and work on JCL templates (only enabled if 
Enterprise MVS Edition is installed). Allows you to release jobs 
and upload mainframe jobs to a mainframe. Starts the 
DataStage Designer or Director, and, if they are installed, 
MetaStage, QualityStage, AuditStage, or ProfileStage. Lets you 
invoke third-party applications, or add third-party applications 
to the Manager. Allows you to set Manager options. If you are 
managing parallel jobs on a UNIX server, allows you to 
manage data sets (see "Managing Data Sets" in Parallel Job 
Developer’s Guide).

– Help. Invokes the Help system.

Toolbar
The Manager toolbar contains the following buttons:

Project Tree
The project tree is in the left pane of the DataStage Manager window 

and contains a summary of project contents. In Project View, you only 

see the contents of the project to which you are currently attached. In 

host view, the DataStage Server is at the top of the tree with all the 

projects hosted there beneath it. 

The project tree has main branches, which in turn contain categories. 

Categories can contain other categories or items, or a mixture of both. 

The branches are:

Data Elements. A category exists for the built-in data elements 
and the additional ones you define. 

New

Copy

Host

Properties Large
Icons

Small
Icons

List

Details

Report

Help

Usage
Analysis

 
Delete View

Extended
Job View

Up
Manager Guide 2-7



The DataStage Manager Window DataStage Manager Overview
IMS Databases (DBDs). Each IMS database object describes the 
physical structure of an IMS database (used in mainframe jobs).

IMS Viewsets (PSBs/PCBs). Each IMS viewset object describes 
an application’s view of an IMS database (used in mainframe 
jobs).

Jobs. A category exists for each group of jobs in the project. Job 
sequences are also stored under this branch.

Machine Profiles. Mainframe machine profiles are stored under 
this branch.

Routines. Routines you create or import are stored in categories 
under this branch.

Shared Containers. Shared containers are stored in categories 
under this branch. These provide reusable portions of DataStage 
jobs and are defined in the DataStage Designer.

Stage Types. The plug-ins you create or import are stored in 
categories under this branch. 

Table Definitions. Table definitions are stored according to the 
data source. If you import a table definition, a category is created 
under the data source type. If you manually enter a table 
definition, you can create a new category anywhere under the 
main Table Definitions branch. 

Transforms. A category exists for the built-in transforms and for 
each group of custom transforms created.

Double-click a branch to expand it to category level. Double-click 

categories in turn until you reach the items. You can display the 

properties (definition) of an item by double-clicking it in the display 

area.

Note Organizing your jobs into categories is recommended 

because it gives faster operation of the DataStage Director 

when displaying job status.

Display Area
The display area is in the right pane of the DataStage Manager 

window and displays the contents of a chosen branch or category. You 

can display items in the display area in four ways:

Large icons. Items are displayed as large icons arranged across 
the display area. 

Small icons. Items are displayed as small icons in the display 
area. 

List. Items are displayed in a list going down the display area. 
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Details. Items are displayed in a table. The following information 
is displayed for each item:

– Name. The name of the item.

– Description. The description of the item. 

– Date/Time Modified. The date and time the branch or item 
was last modified.

If you double-click an item in the display area, a dialog box appears 

with the properties of the chosen item. 

Shortcut Menus
There are a number of shortcut menus available which you display by 

clicking the right mouse button. There are four types of menu:

General. Appears anywhere in the display area, other than on an 
item. Use this menu to refresh the view of the Repository or to 
create a new category, or to select all items in the display area.

Category level. Appears when you right-click a category or 
branch in the project tree. Use this menu to refresh the view of the 
Repository or to create a new category, or to delete a category. In 
some branches, allows you to create a new item of that type.

Item level. Appears when you click a highlighted item in the 
display area. Use this menu to copy, rename, delete, move, 
display the properties of the chosen item, or invoke the Usage 
Analysis tool. If the item is a job, you can open the DataStage 
Designer with the job ready to edit.

Grid level. Appears when you are editing a grid. Use this menu to 
edit a cell, find a row, or edit, insert, or delete a row.

Managing the DataStage Repository
The DataStage Manager provides a means of viewing and managing 

the contents of the Repository. You can use the DataStage Manager 

to:

Create items

Rename items

Select multiple items

View and edit item properties

Delete items
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Delete a category (including all items under that category)

Copy items

Move items between categories

Create empty categories

Creating Items in the Repository

You can create new data elements, table definitions, transforms, 

routines, categories, or mainframe machine profiles. To create a new 

item, select the top-level branch in the project tree and do one of the 

following:

Choose File ➤ New. The New command describes the selected 
item, for example, File ➤ New Transform… . 

Choose New… from the shortcut menu. 

Click the New button on the toolbar.

A dialog box appears for you to enter the properties of the new item. 

Click OK to save the new item. An icon is created for the item in the 

project tree. For details about creating a particular type of item, see 

the chapter describing that item:

Chapter 3, "Managing Table Definitions."

Chapter 4, "Managing Data Elements."

Chapter 5, "Managing Jobs and Job Sequences."

Chapter 6, "Managing Shared Containers."

Chapter 7, "Managing Stages."

Chapter 8, "Managing Programming Components."

Chapter 9, "Mainframe Machine Profiles."

Chapter 10, "Managing IMS Databases and IMS Viewsets."

Renaming Items in the Repository

You can rename any of the items in the Repository, except for the top-

level branches, released jobs, and built-in items. 

To rename an item, select it in the display area and do one of the 

following:

Click the item again. An edit box appears and you can enter a 
different name or edit the existing one. Save the new name by 
pressing Enter or by clicking outside the edit box.
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Double-click the item. A properties dialog box appears and you 
can edit the field containing the item’s name. Click OK to save the 
new name.

Choose Rename from the shortcut menu. An edit box appears 
and you can enter a different name or edit the existing one. Save 
the new name by pressing Enter or by clicking outside the edit 
box.

Selecting Multiple Items

To select all the items under a particular branch or category: 

1 Open the branch or category so that the items are displayed in the 
right pane of the DataStage Manager.

2 Do one of the following:

– Right-click to display the shortcut menu and choose Select 
All.

– Left-click while pressing Shift.

– Left-click while pressing Ctrl.

Viewing or Editing Items in the Repository

You can view or edit the properties of any item in the project tree. 

Note You cannot edit the properties of built-in items.

To view or edit the properties of an item, select the item in the display 

area and do one of the following:

Choose File ➤ Properties… .

Choose Properties… from the shortcut menu.

Double-click the item in the display area.

Click the Properties button on the toolbar.

A dialog box appears with the item’s properties. The content of the 

dialog box depends on the type of item you are viewing or editing. 

Click OK to save any changes and to close the dialog box.

Deleting Items in the Repository

You can delete any item in the project tree, except the built-in items. 

Warning You must be absolutely certain you want to remove an 

item in the Repository before you delete it. If it is used 

by another item in the project, your jobs will fail to 

compile. Use the Usage Analysis tool to check if in 

doubt.
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To delete an item, select it in the display area and do one of the 

following:

Choose File ➤ Delete. 

Choose Delete from the shortcut menu.

Press Delete.

Click the Delete button on the toolbar.

A message box appears asking you to confirm the deletion. Click Yes 

to delete the item.

Deleting a Category in the Repository

You can delete a category in the Repository and all the items and 

subcategories that the category contains. You cannot delete the top-

level branches, or categories that contain built-in items (for example 

built-in transforms).

To delete a category select it in the project tree, then do one of the 

following:

Choose File ➤ Delete. 

Choose Delete from the shortcut menu.

Press Delete.

Click the Delete button on the toolbar.

A message box appears asking you to confirm the deletion. Click Yes.

Copying Items in the Repository

You can copy items in the same branch in the project tree. To copy an 

item, select the item in the display area and do one of the following:

Choose File ➤ Copy. 

Choose Copy from the shortcut menu.

Click the Copy button on the toolbar.

The item is copied and a new item is created under the same category 

in the project tree. By default, the name of the copy is called 

CopyOfXXX, where XXX is the name of the chosen item. An edit box 

appears allowing you to rename the copy immediately. 

Copying a job only copies design time information. You cannot copy a 

released job.
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Moving Items Between Categories

You can move items between different categories under the same 

branch in the project tree. So, for example, you move a job from one 

category to another, or a data element from one category to another. 

To move an item:

1 Click the item that you want to move to select it.

2 Choose File ➤ Move To… or choose Move To… from the 
shortcut menu. The Select Category dialog box appears:

– Current category. The category currently containing the 
selected item.

– Branch categories. Shows the categories available under the 
current branch in a tree structure.

3 Select the category you want to move the selected item to and 
click OK.

Alternatively you can drag and drop items between different 

categories under the same branch.

Note Be aware that, if you move table definitions between 

categories, you may affect the operation of jobs that use 

these definitions. You may need to edit stages which refer 

to these table definitions.

Creating Empty Categories

You can create an empty category under any of the branches in the 

Repository. To create a new category:
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1 Select the branch under which you want to create a new category 
(i.e., Data Elements, IMS Databases, IMS Viewsets, Table 
Definitions, Jobs, Machine Profiles, Shared Containers, Stage 
Types, Routines, or Transforms).

2 Choose File ➤ New Category… , the Create Category dialog 
box appears.

3 Do one of the following:

– Type the new category name directly into the Current 
category field, using the \ character to denote subcategories.

– Navigate the tree in the Branch categories field, select an 
existing category, then append the new category name in the 
Current category field.

4 Click OK to create the specified category.

Customizing the Tools Menu
You can configure the DataStage Manager so that you can invoke 

third-party applications from the Tools menu. You could use this, for 

example, to add data modelling or business analysis tools to the 

menu so they can be started from DataStage. To configure the menu:

1 Choose Tools ➤ Custom ➤ Customize… . The Customize 
dialog box appears.

2 Click the Add… button to display the Add Tool dialog box. 

3 Type in, or browse for, the executable of the application that you 
are adding and click OK to return to the Customize dialog box. 
The application appears in the Menu contents list box.
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4 Type in the menu name for the application in the Menu text field, 
and specify its order in the menu using the arrow keys and the 
Menu contents field.

5 Specify any required command line arguments for the tool in the 
Arguments field. Alternatively click the > button and choose from 
a predefined list of argument tokens.

6 Click OK to add the application to the Manager’s Tools menu 
(Tools ➤ Custom).

Note Any applications that you add to the DataStage Manager’s 

Tools menu are added automatically to the Tools menu of 

other DataStage applications (e.g., Designer and Director).

DataStage Manager Options
The Options dialog box allows you to specify:

Whether the Ascential banner is shown at the top of the Manager.

What action is taken when you double-click on a job or container 
item in the right pane of the Manager window. 

Levels of warning that the Usage Analysis tool generates when 
carrying out operations on referenced items.

To specify that the banner should not be visible:

1 Choose Tools ➤ Options…, to open the Options dialog box.

2 Click on the Appearance/General node in the left pane.
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3 Clear the Show Ascential banner check box.

To specify job/container opening action:

1 Choose Tools ➤ Options…, to open the Options dialog box.

2 Click on the Default/General node in the left pane, then choose one 
of the following in the right pane:

– Edit in Designer to specify that double-clicking should cause 
the DataStage Designer to open with the selected job or shared 
container ready for editing.

– Edit Properties to specify that the Job Properties or Shared 
Container Properties dialog box should open. This is the 
default.

For details about specifying Usage Analysis warnings, see 

"Configuring Warnings" on page 12-6.

Exiting the DataStage Manager
To exit the DataStage Manager, choose File ➤ Exit from the 

DataStage Manager window.
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Managing Table Definitions

Table definitions are the key to your DataStage project and specify the 

data to be used at each stage of a DataStage job. Table definitions are 

stored in the Repository and are shared by all the jobs in a project. 

You need, as a minimum, table definitions for each data source and 

one for each data target in the data warehouse. 

You can import, create, or edit a table definition using the DataStage 

Manager.
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The Table Definition Dialog Box
When you create, edit, or view a table definition using the DataStage 

Manager, the Table Definition dialog box appears:

This dialog box has up to eight pages:

General

Columns

Format 

NLS

Relationships

Parallel

Layout

Locator

Table Definition Dialog Box - General Page

The General page contains general information about the table 

definition. The following fields are on this page:
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Data source type. The type of data source, for example, 
UniVerse. 

Data source name. If you imported the table definition, this 
contains a reference to where the original data is found. For 
UniVerse and ODBC data sources, this is the data source name. 
For hashed file data sources, this is an account name. For 
sequential file sources, this is the last component of the directory 
path where the sequential file is found.

Table definition. The name of the table definition.

Mainframe platform type. The type of mainframe platform that 
the table definition applies to. Where the table definition does not 
apply to a mainframe data source, it displays <Not applicable>. 
Where this field is filled in, the dialog box also contains an Owner 
field. 

Mainframe access type. Where the table definition has been 
imported from a mainframe or is applicable to a mainframe, this 
specifies the type of database. If it is not a mainframe-type table 
definition, the field is set to <Not applicable>.

Fully Qualified Table Name. This read-only field shows the fully 
qualified table name, as derived from the locator (see "Table 
Definition Dialog Box - Locator Page" on page 3-12).

Meta data supports Multi-valued fields. Select this check box 
if the meta data supports multivalued data. If the check box is 
selected, three extra grid columns used for multivalued data 
support will appear on the Columns page. The check box is 
disabled for ODBC, mainframe, and stored procedure table 
definitions.

ODBC quote character. Allows you to specify what character an 
ODBC data source uses as a quote character. Specify 000 to 
suppress the quote character.

Short description. A brief description of the data.

Long description. A long description of the data. 

The combination of the data source type, data source name, and table 

or file name forms a unique identifier for the table definition. No two 

table definitions can have the same identifier. 
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The Columns page contains a grid displaying the column definitions 

for each column in the table definition. The grid has the following 

columns: 

Column name. The name of the column.

Key. Indicates whether the column is part of the primary key. 

SQL type. The SQL data type. 

Length. The data precision. This is the length for CHAR data and 
the maximum length for VARCHAR data. 

Scale. The data scale factor.

Nullable. Specifies whether the column can contain null values. 
This is set to indicate whether the column is subject to a NOT 
NULL constraint. It does not itself enforce a NOT NULL constraint.

Display. The maximum number of characters required to display 
the column data.

Data element. The type of data in the column.

Description. A text description of the column.

The following columns appear if you selected the Meta data 
supports Multi-valued fields check box on the General page:

Association. The name of the association (if any) that the column 
belongs to.

Position. The field number.

Type. The nesting type, which can be S, M, MV, or MS.
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The following column may appear if NLS is enabled and the data 

source is sequential, ODBC, or a generic plug-in in a server job, or a 

sequential file stage in a parallel job:

NLS Map. This property is visible only if NLS is enabled and 
Allow per-column mapping has been selected on the NLS page 
of the Table Definition dialog box. It allows you to specify a 
separate character set map for a column (which overrides the map 
set for the project or table).

The following columns appear if the table definition is derived from a 

COBOL file definition mainframe data source:

Level number. The COBOL level number.

Mainframe table definitions also have the following columns, but due 

to space considerations, these are not displayed on the columns page. 

To view them, choose Edit Row… from the Columns page shortcut 

menu, the Edit Column Meta Data dialog appears, displaying the 

following field in the COBOL tab:

Occurs. The COBOL occurs clause.

Sign indicator. Indicates whether the column can be signed or 
not.

Sign option. If the column is signed, gives the location of the 
sign in the data.

Sync indicator. Indicates whether this is a COBOL-synchronized 
clause or not.

Usage. The COBOL usage clause.

Redefined field. The COBOL REDEFINED clause. 

Depending on. A COBOL OCCURS-DEPENDING-ON clause.

Storage length. Gives the storage length in bytes of the column 
as defined.

Picture. The COBOL PICTURE clause.

For more information about these fields, see page 3-21.

The Columns page for each link also contains a Clear All and a 

Load… button. The Clear All button deletes all the column 

definitions. The Load… button loads (copies) the column definitions 

from a table definition elsewhere in the Repository. 

A shortcut menu available in grids allows you to edit a cell, delete a 

row, or add a row. For more information about editing the columns 

grid, see Appendix A, “Editing Grids.”
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Server jobs Table Definition Dialog Box - Format Page

The Format page contains file format parameters for sequential files 

used in server jobs. These fields are automatically set when you 

import a table definition from a sequential file. 

There are three check boxes on this page:

Fixed-width columns. Specifies whether the sequential file 
contains fixed-width fields. This check box is cleared by default, 
that is, the file does not contain fixed-width fields. When this check 
box is selected, the Spaces between columns field is enabled.

First line is column names. Specifies whether the first line in 
the file contains the column names. This check box is cleared by 
default, that is, the first row in the file does not contain the column 
names. 

Omit last new-line. Specifies whether the last newline character 
in the file is ignored. By default this check box is cleared, that is, if 
a newline character exists in the file, it is used. 

The rest of this page contains five fields. The available fields depend 

on the settings for the check boxes. 

Spaces between columns. Specifies the number of spaces used 
between the columns in the file. This field appears when you 
select Fixed-width columns.

Delimiter. Contains the delimiter that separates the data fields. 
By default this field contains a comma. You can enter a single 
printable character or a decimal or hexadecimal number to 
represent the ASCII code for the character you want to use. Valid 
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ASCII codes are in the range 1 to 253. Decimal values 1 through 9 
must be preceded with a zero. Hexadecimal values must be 
prefixed with &h. Enter 000 to suppress the delimiter.

Quote character. Contains the character used to enclose strings. 
By default this field contains a double quotation mark. You can 
enter a single printable character or a decimal or hexadecimal 
number to represent the ASCII code for the character you want to 
use. Valid ASCII codes are in the range 1 to 253. Decimal values 1 
through 9 must be preceded with a zero. Hexadecimal values must 
be prefixed with &h. Enter 000 to suppress the quote character. 

NULL string. Contains characters that are written to the file when 
a column contains SQL null values. 

Padding character. Contains the character used to pad missing 
columns. This is # by default.

An additional button appears if your system supports parallel jobs:

Sync Parallel. Click this to cause the properties set on the 
Parallel tab to mirror the properties set on this page. A dialog box 
appears asking you to confirm this action, if you do, the Parallel 
tab comes to the top and lets you view the settings.

Table Definition Dialog Box - NLS Page

If NLS is enabled, this page contains the name of the map to use for 

the table definitions. The map should match the character set used in 

the definitions. Because parallel and server jobs use different 

mechanisms in their implementation of NLS, they use different maps. 

Choose Show all server maps to list all the maps that are shipped 

with DataStage for server jobs. Choose Show loaded Server maps 
only to show the maps loaded for use with server jobs (you have to 
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load a map before you can use it). Choose Show all Parallel Maps 

to show the set of maps that are available for parallel jobs.

Note You cannot use a server map unless it is loaded into 

DataStage. You can load different maps using the 

DataStage Administrator. For more information, see "NLS 

Configuration" in DataStage Administrator Guide.

Select Allow per-column mapping if you want to assign 
different character set maps to individual columns.
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Server jobs 
and
Parallel jobs

Table Definition Dialog Box - Relationships Page

The Relationships page shows you details of any relationships this 

table definition has with other tables, and allows you to define new 

relationships.

The page contains two grids:

Foreign Keys. This shows which columns in the table definition 
are foreign keys and which columns and tables they reference. 
You can define foreign keys manually by entering the information 
yourself. The table you reference does not have to exist in the 
DataStage Repository, but you will be informed if it doesn’t. 
Referencing and referenced table do have to be in the same 
category.

Tables which reference this table. This gives details of where 
other table definitions in the Repository reference this one using a 
foreign key. You cannot edit the contents of this grid.
Manager Guide 3-9



Parallel jobs Table Definition Dialog Box - Parallel Page

This page is used when table definitions are used in parallel jobs and 

gives detailed format information for the defined meta data. 

The information given here is the same as on the Format tab in one 

of the following parallel job stages:

Sequential File Stage

File Set Stage

External Source Stage

External Target Stage

Column Export Stage

Column Import Stage

See Parallel Job Developer’s Guide for details.

The Defaults button gives access to a shortcut menu offering the 

choice of:

Save current as default. Saves the settings you have made in 
this dialog box as the default ones for your table definition.

Reset defaults from factory settings. Resets to the defaults 
that DataStage came with.

Set current from default. Set the current settings to the default 
(this could be the factory default, or your own default if you have 
set one up).

Click the Show schema button to open a window showing how the 

current table definition is generated into an OSH schema. This shows 
Manager Guide 3-10



how DataStage will interpret the column definitions and format 

properties of the table definition in the context of a parallel job stage.

Table Definition Dialog Box – Layout Page

The Layout page displays the schema format of the column definitions 

in a table.

Select a button to view the data representation in one of three 

formats:

Parallel. Displays the OSH record schema. You can right-click to 
save the layout as a text file in *.osh format.

COBOL. Displays the COBOL representation, including the 
COBOL picture clause, starting and ending offsets, and column 
storage length. You can right-click to save the file view layout as 
an HTML file.

Standard. Displays the SQL representation, including SQL type, 
length, and scale.

The following diagrams show three different views of the same table.
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Table Definition Dialog Box - Locator Page

The Locator page allows you to view and edit the data resource 

locator associated with the table definition. The data resource locator 

is a property of the table definition that describes the real world 

object. 

When capturing process meta data, you define a table containing this 

information in the source/target database (see "Capturing Process 

Meta Data" in DataStage Administrator Guide). This table provides 

some of the information displayed in this tab.

Locators are filled in when table definitions are imported using meta 

data import, and are manipulated when table definitions are copied, 
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renamed, or moved. The fields can be edited, but you are advised not 

to do this unless you are well versed in MetaStage. 

The labels and contents of the fields in this dialog box varies 

according to the type of data source/target the locator originates from. 

See MetaStage documentation for details.

Importing a Table Definition
The easiest way to specify a table definition is to import it directly 

from the source or target database. A new table definition is created 

and the properties are automatically filled in with the details of your 

data source or data target. 

You can import table definitions from:

Assembler source file definitions

Assembler source file listings

COBOL file definitions

DCLGen file definitions

ODBC table definitions

Orchestrate schema definitions

Plug-in meta data definitions

PL/I file definitions

Sequential file definitions
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Stored procedure definitions

UniData file definitions

UniVerse file definitions

UniVerse table definitions

UniData 6 table definitions

Web services WSDL definitions

XML table definitions

DataStage connects to the specified data source and extracts the 

required table definition meta data. You can use the Data Browser to 

view the actual data in data sources from which you are importing 

table definitions.

Note that DataStage also enables you to import information about the 

structure of IMS databases and IMS viewsets, which can then be used 

in a mainframe job. IMS databases are hierarchical, and so this 

information is stored in a separate type of repository object, not as a 

table definition, see Chapter 10 for details.

Standard Data Sources

To import table definitions from ODBC table definitions, Sequential 

files, UniData, UniData 6, and UniVerse files and tables:

1 Choose the type of data source you want to import from by 
choosing Import ➤ Table Definitions.

For most data source types, a dialog box appears enabling you to 

connect to the data source (for plug-in data sources and 

Orchestrate schemas, a wizard appears and guides you through 

the process).

2 Fill in the required connection details and click OK. Once a 
connection to the data source has been made successfully, the 
updated dialog box gives details of the table definitions available 
for import.

3 Select the required table definitions and click OK. The table 
definition meta data is imported into the DataStage Repository.

Specific information about importing from particular types of data 

source is in DataStage Developer’s Help.

CFD and DCLGen Files

The import derives the meta data from table definition files which are 

generated on a mainframe and transferred to the DataStage client. 
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The table definitions are then derived from these files. The Data 

Browser is not available when importing meta data in this way.

To import table definitions:

1 Choose Import ➤ Table Definitions ➤ COBOL File 
Definitions to import CFD files or Import ➤ Table Definitions 
➤ DCLGen File Definitions to import DCLGen files. The Import 
Meta Data dialog box appears, allowing you to enter details of 
the file to import.

2 Enter details of the file, including name, location, and start 
position then click Refresh. A list of table definitions appears in 
the Tables list.

3 Select the table definitions you want to import, or click Select all 
to select all of them. Click OK. The table definition meta data is 
imported into the DataStage Repository.

More detailed information about importing from mainframe data 

sources is in DataStage Developer’s Help.

XML Documents

To import, choose Import ➤ Table Definitions ➤ XML Table 
Definition. The XML Meta Data Importer tool appears. This 

allows you considerable control over what types of XML source you 

can import meta data from and what meta data to import. 

To import table definitions from an XML source:

1 Open a file to scan; this can be an XML file, a schema (based on 
XML-Data or XDR), or a DTD.

2 Select the elements and attributes in the tree area that you want in 
the table definition.

3 Edit any individual columns that require fine-tuning.

4 Save as a new or existing table definition in the DataStage 
Repository.

You can set various options which affect the way that the tool 

generates the column definitions. When manually editing the table 

definitions a Find facility allows you to search for particular nodes, or 

particular text.

For more detail on the XML facilities provided by DataStage, and the 

XML Meta Data importer in particular, see XML Pack Designer Guide.

MetaBrokers

You can also import table definitions from other data warehousing 

tools via a MetaBroker. This allows you, for example, to define table 
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definitions in a data modelling tool and then import them for use in 

your DataStage job designs. For more information about 

MetaBrokers, see Chapter 16, "Using MetaBrokers."

Assembler Source Files

The import derives the meta data from Assembler Source File 

Definition files or Assembler Source File Listing files. Both type of file 

originate on a mainframe. For more information about these file type, 

see DataStage Enterprise MVS Edition: Mainframe Job Developer’s 

Guide.

To import meta data from an Assembler Source File Definition or 

Listing file:

1 Choose Import ➤ Table Definitions ➤ Assembler File 
Definitions. The Import Meta Data (ASM) dialog box appears, 
allowing you to enter details of the file to import.

2 Enter, or browse for, the location of the file, then click Refresh. A 
list of table definitions appears in the Tables list.

3 Select the table definitions you want to import, or click Select all 
to select all of them. Click OK. The table definition meta data is 
imported into the DataStage Repository.

More detailed information is given in DataStage Developer’s Help.

Web Service WSDL Definitions

The import derives meta data from a WSDL file. The file can be 

located on a disk or given as a URL. You can specify which operations 

you are interested in and convert input and output arguments to 

column definitions.

To import meta data from a WSDL file:

1 Choose Import ➤ Table Definitions ➤ Web Services WSDL 
Definitions. The Web Service Meta Data Importer appears. This 
is a browser which allows you to locate the web services you want 
to import meta data from. You can specify a URL or a disk location 
in the Address field, or you can browse from the directories you 
are offered when the browser opens.

2 Browse to the location of the required WSDL file. When you select 
a WSDL file and the web service is recognized, its description is 
shown in the upper right pane. Navigate through the tree to find 
the required operation. When you select an operation, its details 
are displayed in the bottom right pane (provided it has 
documentation). You can select individual arguments and 
parameters of those arguments if required.
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3 When you have selected the required item, click the Import 
button. The item is imported into the DataStage Repository as a 
table definition.

4 Repeat the operation to import other items if required.

5 When you have finished, click the Close button.

More detailed information is given in Web Services Developer’s 

Guide.

Stored Procedures

To import a definition for a stored procedure via an ODBC connection:

1 Choose Import ➤ Table Definitions ➤ Stored Procedure 
Definitions… . A dialog box appears enabling you to connect to 
the data source containing the stored procedures.

2 Fill in the required connection details and click OK. Once a 
connection to the data source has been made successfully, the 
updated dialog box gives details of the stored procedures 
available for import.

3 Select the required stored procedures and click OK. The stored 
procedures are imported into the DataStage Repository.

Specific information about importing stored procedures is in 

DataStage Developer’s Help. Further information about working with 

stored procedure definitions is given in "Stored Procedure 

Definitions" on page 3-42.

Manually Entering a Table Definition
If you are unable to import the table definitions for your source or 

target data, you must enter this information manually. 

To manually enter table definition properties, you must first create a 

new table definition. You can then enter suitable settings for the 

general properties before specifying the column definitions. You only 

need to specify file format settings for a sequential file table definition.

Creating a Table Definition

To create a table definition:

1 From the DataStage Manager, select the Table Definitions 
branch and do one of the following:

– Choose File ➤ New Table Definition… . 

– Choose New Table Definition… from the shortcut menu.

– Click the New button on the toolbar.
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The Table Definition dialog box appears. You must enter 

suitable values in the fields on the General page.

2 Enter the type of data source in the Data source type field. The 
name entered here determines how the definition appears under 
the Table Definitions branch. 

3 Enter the name of the data source in the Data source name field. 
This forms the second part of the table definition identifier and is 
the name of the branch created under the data source type branch. 

4 Enter the name of the table or file containing the data in the 
Table/file name field. This is the last part of the table definition 
identifier and is the name of the leaf created under the data source 
branch. 

5 Where the Data source type specifies a relational database, type 
the name of the database owner in Owner.

6 If you are entering a mainframe table definition, choose the 
platform type from the Mainframe platform type drop-down 
list, and the access type from the Mainframe access type drop-
down list. Otherwise leave both of these items set to <Not 
applicable>.

7 Select the Meta data supports Multi-valued fields check box if 
the meta data supports multivalued data. 

8 If required, specify what character an ODBC data source uses as a 
quote character in ODBC quote character.

9 Enter a brief description of the data in the Short description 
field. This is an optional field. The text entered here is displayed 
when you choose View ➤ Details from the DataStage Manager 
window. 

10 Enter a more detailed description of the data in the Long 
description field. This is an optional field.

11 Click the Columns tab. The Columns page appears at the front of 
the Table Definition dialog box. You can now enter or load 
column definitions for your data. 

Entering Column Definitions

You can enter column definitions directly in the Columns grid using 

the standard controls described in Appendix A or you can use the 

Edit Column Meta Data dialog box to add one row at a time. To use 

the dialog box:

1 Do one of the following:

– Right-click in the column area and choose Edit row… from the 
shortcut menu.

– Press Ctrl-E.
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– Double-click on the row number cell at the left of the grid.

The Edit Column Meta Data dialog box appears. It has a 

general area containing fields that are common to all data source 

types, plus two tabs containing fields specific to meta data used in 

server jobs or parallel jobs and information specific to COBOL 

data sources.

The exact fields that appear in this dialog box depend on the type 

of table definition as set on the General page of the Table 
Definition dialog box.

2 Enter the general information for each column you want to define 
as follows:

– Column name. Type in the name of the column. This is the 
only mandatory field in the definition.

– Key. Select Yes or No from the drop-down list.

– Native type. For data sources with a platform type of OS390, 
choose the native data type from the drop-down list. The 
contents of the list are determined by the Access Type you 
specified on the General page of the Table Definition dialog 
box. (The list is blank for non-mainframe data sources.)

– SQL type. Choose from the drop-down list of supported SQL 
types. If you are a adding a table definition for platform type 
OS390, you cannot manually enter an SQL type, it is 
automatically derived from the Native type.

– Length. Type a number representing the length or precision of 
the column.
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– Scale. If the column is numeric, type a number to define the 
number of decimal places.

– Nullable. Select Yes or No from the drop-down list. This is set 
to indicate whether the column is subject to a NOT NULL 
constraint. It does not itself enforce a NOT NULL constraint.

– Date format. Choose the date format that the column uses 
from the drop-down list of available formats.

– Description. Type in a description of the column.

Server Jobs

If you are specifying meta data for a server job type data source or 

target, then click the Server tab on top. Enter any required 

information that is specific to server jobs: 

Data element. Choose from the drop-down list of available data 
elements.

Display. Type a number representing the display length for the 
column.

Position. Visible only if you have specified Meta data supports 
Multi-valued fields on the General page of the Table 
Definition dialog box. Enter a number representing the field 
number.

Type. Visible only if you have specified Meta data supports 
Multi-valued fields on the General page of the Table 
Definition dialog box. Choose S, M, MV, MS, or blank from the 
drop-down list.

Association. Visible only if you have specified Meta data 
supports Multi-valued fields on the General page of the Table 
Definition dialog box. Type in the name of the association that 
the column belongs to (if any). 

NLS Map. Visible only if NLS is enabled and Allow per-column 
mapping has been selected on the NLS page of the Table 
Definition dialog box. Choose a separate character set map for a 
column, which overrides the map set for the project or table. (The 
per-column mapping feature is available only for sequential, 
ODBC, or generic plug-in data source types.)

Null String. This is the character that represents null in the data.

Padding. This is the character used to pad missing columns. Set 
to # by default.
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Mainframe Jobs

If you are specifying meta data for a mainframe job type data source, 

then click the COBOL tab. Enter any required information that is 

specific to mainframe jobs:

Level number. Type in a number giving the COBOL level number 
in the range 02 – 49. The default value is 05.

Occurs. Type in a number giving the COBOL occurs clause. If the 
column defines a group, gives the number of elements in the 
group.

Usage. Choose the COBOL usage clause from the drop-down list. 
This specifies which COBOL format the column will be read in. 
These formats map to the formats in the Native type field, and 
changing one will normally change the other. Possible values are:

– COMP – Binary

– COMP-1 – single-precision Float

– COMP-2 – packed decimal Float

– COMP-3 – packed decimal

– COMP-5 – used with NATIVE BINARY native types

– DISPLAY – zone decimal, used with Display_numeric or 
Character native types

– DISPLAY-1 – double-byte zone decimal, used with Graphic_G 
or Graphic_N

Sign indicator. Choose Signed or blank from the drop-down list 
to specify whether the column can be signed or not. The default is 
blank.

Sign option. If the column is signed, choose the location of the 
sign in the data from the drop-down list. Choose from the 
following:

– LEADING – the sign is the first byte of storage

– TRAILING – the sign is the last byte of storage

– LEADING SEPARATE – the sign is in a separate byte that has 
been added to the beginning of storage

– TRAILING SEPARATE – the sign is in a separate byte that has 
been added to the end of storage

Selecting either LEADING SEPARATE or TRAILING SEPARATE 

will increase the storage length of the column by one byte.

Sync indicator. Choose SYNC or blank from the drop-down list 
to indicate whether this is a COBOL-synchronized clause or not.
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Redefined field. Optionally specify a COBOL REDEFINES clause. 
This allows you to describe data in the same storage area using a 
different data description. The redefining column must be the 
same length, or smaller, than the column it redefines. Both 
columns must have the same level, and a column can only 
redefine the immediately preceding column with that level.

Depending on. Optionally choose a COBOL OCCURS-
DEPENDING ON clause from the drop-down list.

Storage length. Gives the storage length in bytes of the column 
as defined. The field cannot be edited.

Picture. Gives the COBOL PICTURE clause, which is derived from 
the column definition. The field cannot be edited.

The Server tab is still accessible, but the Server page only 

contains the Data Element and Display fields.

The following table shows the relationships between native 

COBOL types and SQL types:

Native 
Data
Type

Native 
Length 
(bytes)

COBOL Usage
Representation

SQL 
Type

Precision (p) Scale (s) Storage 
Length 
(bytes)

BINARY 2
4
8

PIC S9 to S9(4) 
COMP
PIC S9(5) to S9(9) 
COMP
PIC S9(10) to S9(18) 
COMP

SmallInt
Integer
Decimal

1 to 4
5 to 9
10 to 18

n/a
n/a
n/a

2
4
8

CHARACTE
R

n n PIC X(n) Char n n/a n

DECIMAL (p+s)/2+1 PIC S9(p)V9(s) 
COMP-3

Decimal p+s s (p+s)/2+1

DISPLAY_
NUMERIC

p+s PIC S9(p)V9(s) Decimal p+s s (p+s)/2+1

FLOAT
(single)
(double)

4

8

PIC COMP-1
PIC COMP-2

Decimal
Decimal

p+s (default 18)
p+s (default 18)

s (default 4)
s (default 4)

4

8

GRAPHIC_G n*2 PIC G(n) DISPLAY-1 NChar n n/a n*2

GRAPHIC_N n*2 PIC N(n) NChar n n/a n*2

GROUP n (sum of all 
the column 
lengths that 
make up the 
group)

Char n n/a n
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Parallel Jobs

If you are specifying meta data for a parallel job click the Parallel tab. 

This allows you to enter detailed information about the format of the 

meta data. 

Field Level. This has the following properties:

Bytes to Skip. Skip the specified number of bytes from the end 
of the previous column to the beginning of this column.

Delimiter. Specifies the trailing delimiter of the column. Type an 
ASCII character or select one of whitespace, end, none, null, 
comma, or tab. 

whitespace. The last column of each record will not include any 
trailing white spaces found at the end of the record.

end. The end of a field is taken as the delimiter, i.e., there is no 
separate delimiter. This is not the same as a setting of ‘None’ 
which is used for fields with fixed-width columns.

none. No delimiter (used for fixed-width).

null. ASCII Null character is used.

comma. ASCII comma character used.

tab. ASCII tab character used.

Delimiter string. Specify a string to be written at the end of the 
column. Enter one or more characters. This is mutually exclusive 
with Delimiter, which is the default. For example, specifying ‘, ‘ 
(comma space – you do not need to enter the inverted commas) 
would have the column delimited by ‘, ‘.

NATIVE 
BINARY 

2
4
8

PIC S9 to S9(4) 
COMP-5
PIC S9(5) to S9(9) 
COMP-5
PIC S9(10) to S9(18) 
COMP-5

SmallInt
Integer
Decimal

1 to 4
5 to 9
10 to 18

n/a
n/a
n/a

2
4
8

VARCHAR n+2 PIC S9(4) COMP
PIC X(n)

VarChar n+2 n/a n+2

VARGRAPHI
C _G

(n*2)+2 PIC S9(4) COMP
PIC G(n) DISPLAY-1

NVarCh
ar

n+2 n/a (n*2)+2

VARGRAPHI
C _N

(n*2)+2 PIC S9(4) COMP 
PIC N(n)

NVarCh
ar

n+2 n/a (n*2)+2

Native 
Data
Type

Native 
Length 
(bytes)

COBOL Usage
Representation

SQL 
Type

Precision (p) Scale (s) Storage 
Length 
(bytes)
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Drop on input. Select this property when you must fully define 
the meta data for a data set, but do not want the column actually 
read into the data set.

Prefix bytes. Specifies that this column is prefixed by 1, 2, or 4 
bytes containing, as a binary value, either the column’s length or 
the tag value for a tagged column. You can use this option with 
variable-length fields. Variable-length fields can be either 
delimited by a character or preceded by a 1-, 2-, or 4-byte prefix 
containing the field length. DataStage inserts the prefix before 
each field.

This property is mutually exclusive with the Delimiter, Quote, and 

Final Delimiter properties, which are used by default.

Print field. This property is intended for use when debugging 
jobs. Set it to have DataStage produce a message for each of the 
columns it reads. The message has the format:

Importing N: D

where:

– N is the column name.

– D is the imported data of the column. Non-printable characters 
contained in D are prefixed with an escape character and written 
as C string literals; if the column contains binary data, it is 
output in octal format.

Quote. Specifies that variable length columns are enclosed in 
single quotes, double quotes, or another ASCII character or pair of 
ASCII characters. Choose Single or Double, or enter a character.

Start position. Specifies the starting position of a column in the 
record. The starting position can be either an absolute byte offset 
from the first record position (0) or the starting position of another 
column.

Tag case value. Explicitly specifies the tag value corresponding 
to a subfield in a tagged subrecord. By default the fields are 
numbered 0 to N-1, where N is the number of fields. (A tagged 
subrecord is a column whose type can vary. The subfields of the 
tagged subrecord are the possible types. The tag case value of the 
tagged subrecord selects which of those types is used to interpret 
the column’s value for the record.)
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String Type. This has the following properties:

Character Set. Choose from ASCII or EBCDIC (not available for 
ustring type (Unicode)).

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Export EBCDIC as ASCII. Select this to specify that EBCDIC 
characters are written as ASCII characters (not available for ustring 
type (Unicode)).

Is link field. Selected to indicate that a column holds the length 
of another, variable-length column of the record or of the tag 
value of a tagged record field.

Import ASCII as EBCDIC. Select this to specify that ASCII 
characters are read as EBCDIC characters (not available for ustring 
type (Unicode)).

Field max width. The maximum number of bytes in a column 
represented as a string. Enter a number. This is useful where you 
are storing numbers as text. If you are using a fixed-width 
character set, you can calculate the length exactly. If you are using 
variable-length character set, calculate an adequate maximum 
width for your fields. Applies to fields of all data types except date, 
time, timestamp, and raw; and record, subrec, or tagged if they 
contain at least one field of this type.

Field width. The number of bytes in a column represented as a 
string. Enter a number. This is useful where you are storing 
numbers as text. If you are using a fixed-width charset, you can 
calculate the number of bytes exactly. If it’s a variable length 
encoding, base your calculation on the width and frequency of 
your variable-width characters. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

Pad char. Specifies the pad character used when strings or 
numeric values are written to an external string representation. 
Enter a character (single-byte for strings, can be multi-byte for 
ustrings) or choose null or space. The pad character is used when 
the external string representation is larger than required to hold 
the written field. In this case, the external string is filled with the 
pad character to its full length. Space is the default. Applies to 
string, ustring, and numeric data types and record, subrec, or 
tagged types if they contain at least one field of this type.

Date Type. This has the following properties:

Byte order. Specifies how multiple byte data types are ordered. 
Choose from:
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– little-endian. The high byte is on the right.

– big-endian. The high byte is on the left.

– native-endian. As defined by the native format of the machine.

– Character Set. Choose from ASCII or EBCDIC.

Days since. Dates are written as a signed integer containing the 
number of days since the specified date. Enter a date in the form 
%yyyy-%mm-%dd or in the default date format if you have defined 
a new one on an NLS system (see DataStage NLS Guide).

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text

For dates, binary is equivalent to specifying the julian property for 

the date field, text specifies that the data to be written contains a 

text-based date in the form %yyyy-%mm-%dd or in the default 

date format if you have defined a new one on an NLS system (see 

DataStage NLS Guide).

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Format string. The string format of a date. By default this is 
%yyyy-%mm-%dd. The Format string can contain one or a 
combination of the following elements:

– %dd: A two-digit day.

– %mm: A two-digit month.

– %year_cutoffyy: A two-digit year derived from yy and the 
specified four-digit year cutoff, for example %1970yy.

– %yy: A two-digit year derived from a year cutoff of 1900.

– %yyyy: A four-digit year.

– %ddd: Day of year in three-digit form (range of 1– 366).

– %mmm: Three-character month abbreviation.

The format_string is subject to the following restrictions:

– It cannot have more than one element of the same type, for 
example it cannot contain two %dd elements.

– It cannot have both %dd and %ddd.

– It cannot have both %yy and %yyyy.

– It cannot have both %mm and %ddd.
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– It cannot have both %mmm and %ddd.

– It cannot have both %mm and %mmm.

– If it has %dd, it must have %mm or %mmm.

– It must have exactly one of %yy or %yyyy.

When you specify a date format string, prefix each component 

with the percent symbol (%). Separate the string’s components 

with any character except the percent sign (%).

If this format string does not include a day, it is set to the first of 

the month in the destination field. If the format string does not 

include the month and day, they default to January 1. Note that 

the format string must contain a month if it also contains a day; 

that is, you cannot omit only the month.

The year_cutoff is the year defining the beginning of the century in 

which all two digit years fall. By default, the year cutoff is 1900; 

therefore, a two-digit year of 97 represents 1997. 

You can specify any four-digit year as the year cutoff. All two-digit 

years then specify the next possible year ending in the specified 

two digits that is the same or greater than the cutoff. For example, 

if you set the year cutoff to 1930, the two-digit year 30 corresponds 

to 1930, and the two-digit year 29 corresponds to 2029.

Is Julian. Select this to specify that dates are written as a numeric 
value containing the Julian day. A Julian day specifies the date as 
the number of days from 4713 BCE January 1, 12:00 hours (noon) 
GMT.

Time Type. This has the following properties:

Byte order. Specifies how multiple byte data types are ordered. 
Choose from:

– little-endian. The high byte is on the right.

– big-endian. The high byte is on the left.

– native-endian. As defined by the native format of the machine.

Character Set. Choose from ASCII or EBCDIC.

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text
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For time, binary is equivalent to midnight_seconds, text specifies 

that the field represents time in the text-based form %hh:%nn:%ss 

or in the default date format if you have defined a new one on an 

NLS system (see DataStage NLS Guide).

Format string. Specifies the format of columns representing 
time as a string. By default this is %hh-%mm-%ss. The possible 
components of the time format string are:

– %hh: A two-digit hours component.

– %nn: A two-digit minute component (nn represents minutes 
because mm is used for the month of a date).

– %ss: A two-digit seconds component.

– %ss.n: A two-digit seconds plus fractional part, where n is the 
number of fractional digits with a maximum value of 6. If n is 0, 
no decimal point is printed as part of the seconds component. 
Trailing zeros are not suppressed.

You must prefix each component of the format string with the 

percent symbol. Separate the string’s components with any 

character except the percent sign (%).

Is midnight seconds. Select this to specify that times are written 
as a binary 32-bit integer containing the number of seconds 
elapsed from the previous midnight.

Timestamp Type. This has the following properties:

Byte order. Specifies how multiple byte data types are ordered. 
Choose from:

– little-endian. The high byte is on the right.

– big-endian. The high byte is on the left.

– native-endian. As defined by the native format of the machine.

Character Set. Choose from ASCII or EBCDIC.

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text

For timestamp, binary specifies that the first integer contains a 

Julian day count for the date portion of the timestamp and the 

second integer specifies the time portion of the timestamp as the 

number of seconds from midnight. A binary timestamp specifies 

that two 32-but integers are written. Text specifies a text-based 

timestamp in the form %yyyy-%mm-%dd %hh:%nn:%ss or in the 
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default date format if you have defined a new one on an NLS 

system (see DataStage NLS Guide).

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Format string. Specifies the format of a column representing a 
timestamp as a string. Defaults to %yyyy-%mm-%dd 
%hh:%nn:%ss. Specify the format as follows:

For the date:

– %dd: A two-digit day.

– %mm: A two-digit month.

– %year_cutoffyy: A two-digit year derived from yy and the 
specified four-digit year cutoff.

– %yy: A two-digit year derived from a year cutoff of 1900.

– %yyyy: A four-digit year.

– %ddd: Day of year in three-digit form (range of 1 - 366)

For the time:

– %hh: A two-digit hours component.

– %nn: A two-digit minute component (nn represents minutes 
because mm is used for the month of a date).

– %ss: A two-digit seconds component.

– %ss.n: A two-digit seconds plus fractional part, where n is the 
number of fractional digits with a maximum value of 6. If n is 0, 
no decimal point is printed as part of the seconds component. 
Trailing zeros are not suppressed. 

You must prefix each component of the format string with the 

percent symbol (%). Separate the string’s components with any 

character except the percent sign (%).

Integer Type. This has the following properties:

Byte order. Specifies how multiple byte data types are ordered. 
Choose from:

– little-endian. The high byte is on the right.

– big-endian. The high byte is on the left.

– native-endian. As defined by the native format of the machine.

Character Set. Choose from ASCII or EBCDIC.
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C_format. Perform non-default conversion of data from a string 
to integer data. This property specifies a C-language format string 
used for reading/writing integer strings. This is passed to sscanf() 
or sprintf().

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text

Field max width. The maximum number of bytes in a column 
represented as a string. Enter a number. Enter a number. This is 
useful where you are storing numbers as text. If you are using a 
fixed-width character set, you can calculate the length exactly. If 
you are using variable-length character set, calculate an adequate 
maximum width for your fields. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

Field width. The number of bytes in a column represented as a 
string. Enter a number. This is useful where you are storing 
numbers as text. If you are using a fixed-width charset, you can 
calculate the number of bytes exactly. If it’s a variable length 
encoding, base your calculation on the width and frequency of 
your variable-width characters. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

In_format. Format string used for conversion of data from string 
to integer. This is passed to sscanf(). By default, DataStage 
invokes the C sscanf() function to convert a numeric field 
formatted as a string to either integer or floating point data. If this 
function does not output data in a satisfactory format, you can 
specify the in_format property to pass formatting arguments to 
sscanf().

Is link field. Selected to indicate that a column holds the length 
of another, variable-length column of the record or of the tag 
value of a tagged record field.

Out_format. Format string used for conversion of data from 
integer to a string. This is passed to sprintf(). By default, 
DataStage invokes the C sprintf() function to convert a numeric 
field formatted as integer data to a string. If this function does not 
output data in a satisfactory format, you can specify the 
out_format property to pass formatting arguments to sprintf().
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Pad char. Specifies the pad character used when the integer is 
written to an external string representation. Enter a character 
(single-bye for strings, can be multi-byte for ustrings) or choose 
null or space. The pad character is used when the external string 
representation is larger than required to hold the written field. In 
this case, the external string is filled with the pad character to its 
full length. Space is the default. 

Decimal Type. This has the following properties:

Allow all zeros. Specifies whether to treat a packed decimal 
column containing all zeros (which is normally illegal) as a valid 
representation of zero. Select Yes or No.

Character Set. Choose from ASCII or EBCDIC.

Decimal separator. Specify the character that acts as the 
decimal separator (period by default).

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text

For decimals, binary means packed. Text represents a decimal in a 

string format with a leading space or '-' followed by decimal digits 

with an embedded decimal point if the scale is not zero. The 

destination string format is: [+ | -]ddd.[ddd] and any precision and 

scale arguments are ignored.

Field max width. The maximum number of bytes in a column 
represented as a string. Enter a number. Enter a number. This is 
useful where you are storing numbers as text. If you are using a 
fixed-width character set, you can calculate the length exactly. If 
you are using variable-length character set, calculate an adequate 
maximum width for your fields. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

Field width. The number of bytes in a column represented as a 
string. Enter a number. This is useful where you are storing 
numbers as text. If you are using a fixed-width charset, you can 
calculate the number of bytes exactly. If it’s a variable length 
encoding, base your calculation on the width and frequency of 
your variable-width characters. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.
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Packed. Select an option to specify what the decimal columns 
contain, choose from:

– Yes to specify that the decimal columns contain data in packed 
decimal format (the default). This has the following sub-
properties:

Check. Select Yes to verify that data is packed, or No to not 

verify.

Signed. Select Yes to use the existing sign when writing 

decimal columns. Select No to write a positive sign (0xf) 

regardless of the columns’ actual sign value.

– No (separate) to specify that they contain unpacked decimal 
with a separate sign byte. This has the following sub-property:

Sign Position. Choose leading or trailing as appropriate.

– No (zoned) to specify that they contain an unpacked decimal 
in either ASCII or EBCDIC text. This has the following sub-
property:

Sign Position. Choose leading or trailing as appropriate.

– No (overpunch) to specify that the field has a leading or end 
byte that contains a character which specifies both the numeric 
value of that byte and whether the number as a whole is 
negatively or positively signed. This has the following sub-
property:

Sign Position. Choose leading or trailing as appropriate.

Precision. Specifies the precision where a decimal column is 
represented in text format. Enter a number. When a decimal is 
written to a string representation, DataStage uses the precision 
and scale defined for the source decimal field to determine the 
length of the destination string. The precision and scale properties 
override this default. When they are defined, DataStage truncates 
or pads the source decimal to fit the size of the destination string. 
If you have also specified the field width property, DataStage 
truncates or pads the source decimal to fit the size specified by 
field width.

Rounding. Specifies how to round the source field to fit into the 
destination decimal when reading a source field to a decimal. 
Choose from:

– up (ceiling). Truncate source column towards positive infinity. 
This mode corresponds to the IEEE 754 Round Up mode. For 
example, 1.4 becomes 2, -1.6 becomes -1.
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– down (floor). Truncate source column towards negative 
infinity. This mode corresponds to the IEEE 754 Round Down 
mode. For example, 1.6 becomes 1, -1.4 becomes -2.

– nearest value. Round the source column towards the nearest 
representable value. This mode corresponds to the COBOL 
ROUNDED mode. For example, 1.4 becomes 1, 1.5 becomes 2, -
1.4 becomes -1, -1.5 becomes -2.

– truncate towards zero. This is the default. Discard fractional 
digits to the right of the right-most fractional digit supported by 
the destination, regardless of sign. For example, if the 
destination is an integer, all fractional digits are truncated. If 
the destination is another decimal with a smaller scale, 
truncate to the scale size of the destination decimal. This mode 
corresponds to the COBOL INTEGER-PART function. Using this 
method 1.6 becomes 1, -1.6 becomes -1.

Scale. Specifies how to round a source decimal when its 
precision and scale are greater than those of the destination. By 
default, when the DataStage writes a source decimal to a string 
representation, it uses the precision and scale defined for the 
source decimal field to determine the length of the destination 
string. You can override the default by means of the precision and 
scale properties. When you do, DataStage truncates or pads the 
source decimal to fit the size of the destination string. If you have 
also specified the field width property, DataStage truncates or 
pads the source decimal to fit the size specified by field width. 
Specifies how to round a source decimal when its precision and 
scale are greater than those of the destination.

Float Type. This has the following properties:

C_format. Perform non-default conversion of data from a string 
to floating-point data. This property specifies a C-language format 
string used for reading floating point strings. This is passed to 
sscanf().

Character Set. Choose from ASCII or EBCDIC.

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text

Field max width. The maximum number of bytes in a column 
represented as a string. Enter a number. Enter a number. This is 
useful where you are storing numbers as text. If you are using a 
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fixed-width character set, you can calculate the length exactly. If 
you are using variable-length character set, calculate an adequate 
maximum width for your fields. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

Field width. The number of bytes in a column represented as a 
string. Enter a number. This is useful where you are storing 
numbers as text. If you are using a fixed-width charset, you can 
calculate the number of bytes exactly. If it’s a variable length 
encoding, base your calculation on the width and frequency of 
your variable-width characters. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

In_format. Format string used for conversion of data from string 
to floating point. This is passed to sscanf(). By default, DataStage 
invokes the C sscanf() function to convert a numeric field 
formatted as a string to floating point data. If this function does 
not output data in a satisfactory format, you can specify the 
in_format property to pass formatting arguments to sscanf().

Is link field. Selected to indicate that a column holds the length 
of a another, variable-length column of the record or of the tag 
value of a tagged record field.

Out_format. Format string used for conversion of data from 
floating point to a string. This is passed to sprintf(). By default, 
DataStage invokes the C sprintf() function to convert a numeric 
field formatted as floating point data to a string. If this function 
does not output data in a satisfactory format, you can specify the 
out_format property to pass formatting arguments to sprintf().

Pad char. Specifies the pad character used when the floating 
point number is written to an external string representation. Enter 
a character (single-bye for strings, can be multi-byte for ustrings) 
or choose null or space. The pad character is used when the 
external string representation is larger than required to hold the 
written field. In this case, the external string is filled with the pad 
character to its full length. Space is the default.

Nullable. This appears for nullable fields.

Actual field length. Specifies the number of bytes to fill with the 
Fill character when a field is identified as null. When DataStage 
identifies a null field, it will write a field of this length full of Fill 
characters. This is mutually exclusive with Null field value.

Null field length. The length in bytes of a variable-length field 
that contains a null. When a variable-length field is read, a length 
of null field length in the source field indicates that it contains a 
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null. When a variable-length field is written, DataStage writes a 
length value of null field length if the field contains a null. This 
property is mutually exclusive with null field value.

Null field value. Specifies the value given to a null field if the 
source is set to null. Can be a number, string, or C-type literal 
escape character. For example, you can represent a byte value by 
\ooo, where each o is an octal digit 0 - 7 and the first o is < 4, or by 
\xhh, where each h is a hexadecimal digit 0 - F. You must use this 
form to encode non-printable byte values. 

This property is mutually exclusive with Null field length and 

Actual length. For a fixed width data representation, you can use 

Pad char (from the general section of Type defaults) to specify a 

repeated trailing character if the value you specify is shorter than 

the fixed width of the field. On reading, specifies the value given 

to a field containing a null. On writing, specifies the value given to 

a field if the source is set to null. Can be a number, string, or C-

type literal escape character.

Generator. If the column is being used in a Row Generator or 

Column Generator stage, this allows you to specify extra details about 

the mock data being generated. The exact fields that appear depend 

on the data type of the column being generated. They allow you to 

specify features of the data being generated, for example, for integers 

they allow you to specify if values are random or whether they cycle. 

If they cycle you can specify an initial value, an increment, and a limit. 

If they are random, you can specify a seed value for the random 

number generator, whether to include negative numbers, and a limit. 

See "Generator" in Parallel Job Developer’s Guide for more details.

Vectors. If the row you are editing represents a column which is a 

variable length vector, tick the Variable check box. The Vector 

properties appear, these give the size of the vector in one of two ways:

Link Field Reference. The name of a column containing the 
number of elements in the variable length vector. This should 
have an integer or float type, and have its Is Link field property set.

Vector prefix. Specifies 1-, 2-, or 4-byte prefix containing the 
number of elements in the vector.

If the row you are editing represents a column which is a vector of 

known length, enter the number of elements in the Vector Occurs 

box.

Subrecords. If the row you are editing represents a column which is 

part of a subrecord the Level Number column indicates the level of the 

column within the subrecord structure.
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If you specify Level numbers for columns, the column immediately 

preceding will be identified as a subrecord. Subrecords can be nested, 

so can contain further subrecords with higher level numbers (i.e., 

level 06 is nested within level 05). Subrecord fields have a Tagged 

check box to indicate that this is a tagged subrecord.

Extended. For certain data types the Extended check box appears to 

allow you to modify the data type as follows:

Char, VarChar, LongVarChar. Select to specify that the 
underlying data type is a ustring.

Time. Select to indicate that the time field includes microseconds.

Timestamp. Select to indicate that the timestamp field includes 
microseconds.

TinyInt, SmallInt, Integer, BigInt types. Select to indicate that 
the underlying data type is the equivalent uint field.

Use the buttons at the bottom of the Edit Column Meta Data dialog 

box to continue adding or editing columns, or to save and close. The 

buttons are:

Previous and Next. View the meta data in the previous or next 
row. These buttons are enabled only where there is a previous or 
next row enabled. If there are outstanding changes to the current 
row, you are asked whether you want to save them before moving 
on.

Close. Close the Edit Column Meta Data dialog box. If there are 
outstanding changes to the current row, you are asked whether 
you want to save them before closing.

Apply. Save changes to the current row.

Reset. Remove all changes made to the row since the last time 
you applied changes.

Click OK to save the column definitions and close the Edit Column 
Meta Data dialog box. 

Remember, you can also edit a columns definition grid using the 

general grid editing controls, described in "Editing the Grid Directly" 

on page A-5.

Loading Column Definitions

Instead of entering column definitions, you can load (copy) the 

column definitions from an existing table definition. To load column 

definitions:
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1 Click Load… . The Table Definitions dialog box appears: 

This dialog box displays all the table definitions in the project in 

the form of a table definition tree.

2 Double-click the appropriate branch to display the table definitions 
available. 

3 Select the table definition you want to use.

Note You can use the Find… button to enter the name of the 

table definition you want. The table definition is 

automatically highlighted in the tree when you click OK. 

You can use the Import button to import a table definition 

from a data source.

4 Click OK. The Select Columns dialog box appears. It allows you 
to specify which column definitions from the table definition you 
want to load.

Use the arrow keys to move columns back and forth between the 

Available columns list and the Selected columns list. The 

single arrow buttons move highlighted columns, the double arrow 
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buttons move all items. By default all columns are selected for 

loading. Click Find… to open a dialog box which lets you search 

for a particular column. The shortcut menu also gives access to 

Find… and Find Next. Click OK when you are happy with your 

selection. This closes the Select Columns dialog box and loads 

the selected columns into the stage.

For mainframe stages and certain parallel stages where the 

column definitions derive from a CFD file, the Select Columns 

dialog box may also contain a Create Filler check box. This 

happens when the table definition the columns are being loaded 

from represents a fixed-width table. Select this to cause 

sequences of unselected columns to be collapsed into filler items. 

Filler columns are sized appropriately, their datatype set to 

character, and name set to FILLER_XX_YY where XX is the start 

offset and YY the end offset. Using fillers results in a smaller set of 

columns, saving space and processing time and making the 

column set easier to understand.

If you are importing column definitions that have been derived 

from a CFD file into server or parallel job stages, you are warned if 

any of the selected columns redefine other selected columns. You 

can choose to carry on with the load or go back and select 

columns again.

5 Save the table definition by clicking OK. 

You can edit the table definition to remove unwanted column 

definitions, assign data elements, or change branch names.

Naming Columns and Table Definitions
The rules for naming columns depend on the type of job the table 

definition will be used in:

Server and Parallel Jobs. Column names can be any length. 
They must begin with an alphabetic character or $ and contain 
alphanumeric, underscore, period, and $ characters.

Mainframe Jobs. Column names can be any length. They must 
begin with an alphabetic character and contain alphanumeric, 
underscore, #, @, and $ characters.

The rules for naming table definitions are as follows:

Table names can be any length.

They must begin with an alphabetic character.

They can contain alphanumeric, period, and underscore 
characters. 
Manager Guide 3-38



Table definition category names can be any length and consist of any 

characters, including spaces.

Viewing or Modifying a Table Definition
You can view or modify any table definition in your project. To view a 

table definition, select it in the display area and do one of the 

following:

Choose File ➤ Properties… .

Choose Properties… from the shortcut menu.

Double-click the table definition in the display area.

Click the Properties button on the toolbar.

The Table Definition dialog box appears. You can edit any of the 

column definition properties or delete unwanted definitions. 

Editing Column Definitions

To edit a column definition in the grid, click the cell you want to 

change then choose Edit cell… from the shortcut menu or press Ctrl-
E to open the Edit Column Meta Data dialog box. 

For more information about adding and deleting rows, or moving 

between the cells of a grid, see Appendix A, “Editing Grids.” 

Deleting Column Definitions

If, after importing or defining a table definition, you subsequently 

decide that you do not want to read or write the data in a particular 

column you must delete the corresponding column definition. 

Unwanted column definitions can be easily removed from the 

Columns grid. To delete a column definition, click any cell in the row 

you want to remove and press the Delete key or choose Delete row 
from the shortcut menu. Click OK to save any changes and to close 

the Table Definition dialog box.

To delete several column definitions at once, hold down the Ctrl key 

and click in the row selector column for the rows you want to remove. 

Press the Delete key or choose Delete row from the shortcut menu 

to remove the selected rows. 

Finding Column Definitions

The Find facility allows you to locate a particular column definition in 

a table definition. To find a particular column definition, choose Find 
row… from the shortcut menu. The Find dialog box appears, 
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allowing you to enter a string to be searched for in the specified 

column.

Propagating Values

You can propagate the values for the properties set in a column to 

several columns. Select the column whose values you want to 

propagate, then hold down shift and select the columns you want to 

propagate to. Chose Propagate values... from the shortcut menu to 

open the dialog box.

In the Property column, click the check box for the property or 

properties whose values you want to propagate. The Usage field tells 

you if a particular property is applicable to certain types of job only 

(e.g. server, mainframe, or parallel) or certain types of table definition 

(e.g. COBOL). The Value field shows the value that will be propagated 

for a particular property.

Using the Data Browser
Non-mainframe data 
sources 

When importing table definitions from a data source, you can view the 

actual data in the tables using the Data Browser. The Data Browser 

can be used when importing table definitions from the following 

sources:
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ODBC table

UniVerse table

Hashed (UniVerse) file

UniData file

Sequential file

Some types of plug-in

The Data Browser is opened by clicking the View Data… button on 

the Import Meta Data dialog box. The Data Browser window 

appears:

The Data Browser uses the meta data defined in the data source. If 

there is no data, a Data source is empty message appears instead 

of the Data Browser.

The Data Browser grid has the following controls:

You can select any row or column, or any cell with a row or 
column, and press CTRL-C to copy it.

You can select the whole of a very wide row by selecting the first 
cell and then pressing SHIFT+END.

If a cell contains multiple lines, you can double-click the cell to 
expand it. Single-click to shrink it again.

You can view a row containing a specific data item using the Find… 

button. The Find dialog box repositions the view to the row 
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containing the data you are interested in. The search is started from 

the current row.

The Display… button opens the Column Display dialog box. It 

allows you to simplify the data displayed by the Data Browser by 

choosing to hide some of the columns. It also allows you to normalize 

multivalued data to provide a 1NF view in the Data Browser.

This dialog box lists all the columns in the display, and initially these 

are all selected. To hide a column, clear it.

The Normalize on drop-down list box allows you to select an 

association or an unassociated multivalued column on which to 

normalize the data. The default is Un-Normalized, and choosing Un-
Normalized will display the data in NF2 form with each row shown 

on a single line. Alternatively you can select Un-Normalize 
(formatted), which displays multivalued rows split over several lines.

In the example, the Data Browser would display all columns except 

STARTDATE. The view would be normalized on the association 

PRICES.

Stored Procedure Definitions
You can access data in a database using a stored procedure, if 

required. To do so, you use an ODBC stage in a server job, or the STP 

plugin stage in a server or parallel job (the plugin stage has its own 

documentation, which is available when you install the plugin). 
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A stored procedure can:

Have associated parameters, which may be input or output

Return a value (like a function call)

Create a result set in the same way as an SQL SELECT statement 

Note ODBC stages support the use of stored procedures with or 

without input arguments and the creation of a result set, but 

do not support output arguments or return values. In this 

case a stored procedure may have a return value defined, 

but it is ignored at run time. A stored procedure may not 

have output parameters.

The definition for a stored procedure (including the associated 

parameters and meta data) can be stored in the Repository. These 

stored procedure definitions can be used when you edit an ODBC 

stage or STP plugin stage in your job design. For more information 

about the use of stored procedures in ODBC stages, see "ODBC 

Stages" in Server Job Developer’s Guide. For more information about 

the use of stored procedures with STP stages, see the documentation 

supplied with the plugin.

You can import, create, or edit a stored procedure definition using the 

DataStage Manager. 

Importing a Stored Procedure Definition
The easiest way to specify a definition for a stored procedure is to 

import it directly from the stored procedure on the source or target 

database using an ODBC connection. A new definition for the stored 

procedure is created and stored in the Repository. 

To import a definition for a stored procedure via an ODBC connection:

1 Choose Import ➤ Table Definitions ➤ Stored Procedure 
Definitions… . A dialog box appears enabling you to connect to 
the data source containing the stored procedures.

2 Fill in the required connection details and click OK. Once a 
connection to the data source has been made successfully, the 
updated dialog box gives details of the stored procedures 
available for import.

3 Select the required stored procedures and click OK. The stored 
procedures are imported into the DataStage Repository.

Specific information about importing stored procedures is in 

DataStage Developer’s Help.
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The Table Definition Dialog Box for Stored Procedures
When you create, edit, or view a stored procedure definition, the 

Table Definition dialog box appears. This dialog box is described in 

"The Table Definition Dialog Box" on page 3-2. 

The dialog box for stored procedures has additional pages, having up 

to six pages in all:

General. Contains general information about the stored 
procedure. The Data source type field on this page must contain 
StoredProcedures to display the additional Parameters page. 

Columns. Contains a grid displaying the column definitions for 
each column in the stored procedure result set. You can add new 
column definitions, delete unwanted definitions, or edit existing 
ones. For more information about editing a grid, see "Editing 
Column Definitions" on page 3-39.

Parameters. Contains a grid displaying the properties of each 
input parameter.

Note If you cannot see the Parameters page, you must enter 

StoredProcedures in the Data source type field on 

the General page.

The grid has the following columns: 

– Column name. The name of the parameter column.

– Key. Indicates whether the column is part of the primary key. 

– SQL type. The SQL data type. 

– Extended. This column gives you further control over data 
types used in parallel jobs when NLS is enabled. Selecting a 
value from the extended drop-down list is the equivalent to 
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selecting the Extended option in the Edit Column Meta 
Data dialog box Parallel tab. The available values depend on 
the base data type

– I/O Type. Specifies the type of parameter. Can be one of IN, 
INOUT, OUT, or RETURN. Note that the ODBC stage only 
supports IN and INOUT parameters. The STP stage supports all 
parameter types.

– Length. The data precision. This is the length for CHAR data 
and the maximum length for VARCHAR data. 

– Scale. The data scale factor.

– Nullable. Specifies whether the column can contain null 
values. This is set to indicate whether the column is subject to 
a NOT NULL constraint. It does not itself enforce a NOT NULL 
constraint.

– Display. The maximum number of characters required to 
display the column data.

– Data element. The type of data in the column.

– Description. A text description of the column.

Format. Contains file format parameters for sequential files. This 
page is not used for a stored procedure definition.

NLS. Contains the name of the character set map to use with the 
table definitions.

Error codes. The Error Codes page allows you to specify which 
raiserror calls within the stored procedure produce a fatal error 
and which produce a warning. 

This page has the following fields:
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– Fatal errors. Enter the raiserror values that you want to be 
regarded as a fatal error. The values should be separated by a 
space.

– Warnings. Enter the raiserror values that you want to be 
regarded as a warning. The values should be separated by a 
space.

Manually Entering a Stored Procedure Definition
If you are unable to import the definition for your stored procedure, 

you must enter this information manually. 

To manually enter a stored procedure definition, first create the 

definition using the DataStage Manager. You can then enter suitable 

settings for the general properties, before specifying definitions for 

the columns in the result set and the input parameters. 

Note You do not need to edit the Format page for a stored 

procedure definition. 

Creating a Stored Procedure Definition

To create a stored procedure definition:

1 From the DataStage Manager, select the Table Definitions 
branch and do one of the following:

– Choose File ➤ New Table Definition… . 

– Choose New Table Definition… from the shortcut menu.

– Click the New button on the toolbar.

The Table Definition dialog box appears. You must enter 

suitable values in the fields on the General page.

2 Enter StoredProcedures in the Data source type field. This 
specifies that the new definition will be stored under the Table 
Definitions ➤ StoredProcedures branch in the Repository. The 
Parameters page appears in the Table Definition dialog box. 

3 Enter the name of the data source in the Data source name field. 
This forms the second part of the table definition identifier and is 
the name of the branch created under the data source type branch. 

4 Enter the name of the procedure in the Procedure name field. 
This is the last part of the table definition identifier and is the 
name of the leaf created under the data source branch. 

5 Optionally enter a brief description of the data in the Short 
description field. The text entered here is displayed when you 
choose View ➤ Details from the DataStage Manager window. 
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6 Optionally enter a detailed description of the data in the Long 
description field. 

7 Specify the column definitions for the result set on the Columns 
page and the input parameters (if any) for the stored procedure on 
the Parameters page. 

8 If NLS is enabled and you do not want to use the default project 
NLS map, select the required map from the NLS page.

Specifying Column Definitions for the Result Set

To specify the column definitions for the result set, click the Columns 

tab in the Table Definition dialog box. The Columns page appears 

at the front of the Table Definition dialog box. You can now enter or 

load column definitions. For more information, see "Entering Column 

Definitions" on page 3-18 and "Loading Column Definitions" on 

page 3-36.

Note You do not need a result set if the stored procedure is used 

for input (writing to a database). However, in this case, you 

must have input parameters.

Specifying Parameters

To specify parameters for the stored procedure, click the Parameters 

tab in the Table Definition dialog box. The Parameters page 

appears at the front of the Table Definition dialog box. 

You can enter parameter definitions are entered directly in the 

Parameters grid using the general grid controls described in 

Appendix A, “Editing Grids.”, or you can use the Edit Column Meta 
Data dialog box. To use the dialog box:. 

1 Do one of the following:

– Right-click in the column area and choose Edit row… from the 
shortcut menu.

– Press Ctrl-E.

The Edit Column Meta Data dialog box appears. 

In the main page, specify the SQL data type by choosing an 

appropriate type from the drop-down list in the SQL type cell. 

2 Enter an appropriate value for the data precision in the Length 
cell. 

3 Enter an appropriate data scale factor in the Scale cell. 

4 Specify whether the parameter can contain null values by 
choosing an appropriate option from the drop-down list in the 
Nullable cell. 
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5 Enter text to describe the column in the Description cell. This cell 
expands to a drop-down text entry box if you enter more 
characters than the display width of the column. You can increase 
the display width of the column if you want to see the full text 
description. 

6 Fill in further information in the Server and/or Parallel tab, 
depending on whether the stage that will be using the meta data 
will be part of a server or parallel job.

7 Click APPLY and CLOSE to save and close the Edit Column 
Meta Data dialog box. 

8 You can continue to add more parameter definitions by editing the 
last row in the grid. New parameters are always added to the 
bottom of the grid, but you can select and drag the row to a new 
position in the grid. 

When you have defined the parameters, use the I/O Type field in the 

parameters grid to specify whether the parameter is IN, INOUT, OUT, 

or RETURN. (Note that ODBC stages only support parameters of type 

IN and INOUT).

Specifying NLS Mapping

If NLS is enabled and you want to use a different character set map 

than that defined as the project default, click the NLS tab in the Table 
Definition dialog box. The NLS page appears at the front of the 

Table Definition dialog box. 

Choose the name of the map to use from the list box. By default, the 

list box shows all the server job maps that are loaded and ready to 

use. Show all maps lists all the maps that are shipped with 

DataStage. 

If you intend to use the stored procedure in a parallel job, ensure that 

the Show all Parallel maps option is selected.

Click Allow per-column mapping if you want to assign different 

character set maps to individual columns.

Note You cannot use a map unless it is loaded into DataStage. 

You can load different maps using the DataStage 

Administrator. For more information, see "NLS 

Configuration" in DataStage Administrator Guide.

Viewing or Modifying a Stored Procedure Definition
You can view or modify any stored procedure definition in your 

project. To view a stored procedure definition, select it in the display 

area and do one of the following:
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Choose File ➤ Properties… .

Choose Properties… from the shortcut menu.

Double-click the stored procedure definition in the display area.

Click the Properties button on the toolbar.

The Table Definition dialog box appears. You can edit or delete any 

of the column or parameter definitions. 

Editing Column or Parameter Definitions

You can edit the settings for a column or parameter definition by 

editing directly in the Columns or Parameters grid. To edit a definition, 

click the cell you want to change. The way you edit the cell depends on 

the cell contents. If the cell contains a drop-down list, choose an 

alternative option from the drop-down list. If the cell contains text, 

you can start typing to change the value, or press F2 or choose Edit 
cell… from the shortcut menu to put the cell into edit mode. 

Alternatively you can edit rows using the Edit Column Meta Data 

dialog box. 

For more information about adding and deleting rows, or moving 

between the cells of a grid, see Appendix A, “Editing Grids.” 

Deleting Column or Parameter Definitions

If, after importing or defining stored procedure columns, you 

subsequently decide that you do not want to read or write the data in 

a particular column you must delete the corresponding column 

definition.

Unwanted column or parameter definitions can be easily removed 

from the Columns or Parameters grid. To delete a column or 

parameter definition, click any cell in the row you want to remove and 

press the Delete key or choose Delete row from the shortcut menu. 

(You can delete all the rows by clicking Clear All). Click OK to save 

any changes and to close the Table Definition dialog box.

To delete several column or parameter definitions at once, hold down 

the Ctrl key and click in the row selector column for the rows you want 

to remove. Press the Delete key or choose Delete row from the 

shortcut menu to remove the selected rows.
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4
Managing Data Elements

data sources for 
server jobs

Each column within a table definition may have a data element 

assigned to it. A data element specifies the type of data a column 

contains, which in turn determines the transforms that can be applied 

in a Transformer stage.

The use of data elements is optional. You do not have to assign a data 

element to a column, but it enables you to apply stricter data typing in 

the design of server jobs. The extra effort of defining and applying 

data elements can pay dividends in effort saved later on when you are 

debugging your design.

You can choose to use any of the data elements supplied with 

DataStage, or you can create and use data elements specific to your 

application. For a list of the built-in data elements, see "Built-In Data 

Elements" on page 4-5. You can also import data elements from 

another data warehousing tool using a MetaBroker. For more 

information, see Chapter 16, "Using MetaBrokers."

Application-specific data elements allow you to describe the data in a 

particular column in more detail. The more information you supply to 

DataStage about your data, the more DataStage can help to define the 

processing needed in each Transformer stage. 

For example, if you have a column containing a numeric product 

code, you might assign it the built-in data element Number. There is a 

range of built-in transforms associated with this data element. 

However, all of these would be unsuitable, as it is unlikely that you 

would want to perform a calculation on a product code. In this case, 

you could create a new data element called PCode.

Each data element has its own specific set of transforms which relate 

it to other data elements. When the data elements associated with the 

columns of a target table are not the same as the data elements of the 

source data, you must ensure that you have the transforms needed to 
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Creating Data Elements Managing Data Elements
convert the data as required. For each target column, you should have 

either a source column with the same data element, or a source 

column that you can convert to the required data element. 

For example, suppose that the target table requires a product code 

using the data element PCode, but the source table holds product 

data using an older product numbering scheme. In this case, you 

could create a separate data element for old-format product codes 

called Old_PCode, and you then create a custom transform to link the 

two data elements; that is, its source data element is Old_PCode, 

while its target data element is PCode. This transform, which you 

could call Convert_PCode, would convert an old product code to a 

new product code. See"Defining Custom Transforms" in Server Job 

Developer’s Guide for details on how to use and create custom 

transforms.

A data element can also be used to “stamp” a column with SQL 

properties when you manually create a table definition or define a 

column definition for a link in a job. 

Creating Data Elements
data sources for 
server jobs 

To create a data element:

1 From the DataStage Manager, select the Data Elements branch 
in the project tree and do one of the following:

– Choose File ➤ New Data Element… . 

– Choose New Data Element… from the shortcut menu.

– Click the New button on the toolbar.

The Data Element dialog box appears:

This dialog box has four pages:
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– General. Displayed by default. Contains general information 
about the data element. 

– SQL Properties. Contains fields that describe the properties 
of the associated SQL data type. This page is used when this 
data element is used to manually create a new column 
definition for use with an SQL data source. If you import the 
column definition from an SQL data source, the SQL properties 
are already defined. 

– Generated From. Lists the transforms that result in this data 
element. You cannot edit the field in this page, it is populated 
when you define the transforms that use the data element.

– Converts To. Lists the transforms that can be used to convert 
this data element into another data element. You cannot edit 
the field in this page, it is populated when you define the 
transforms that use the data element.

2 Enter the name of the data element in the Data element name 
field. This name is used to create an icon under the category 
branch. The name entered here must be unique as no two data 
elements can have the same name.

3 Enter a category name in the Category field. This name is used to 
create a branch under the main Data Elements branch. If you do 
not enter a name in this field, the data type is created under the 
main Data Elements branch. 

You can create more than one branch level for the category by 

including \ in the name. For example, if you enter 

Custom\Elements, the following branches are created:
Data Elements ➤ Custom ➤ Elements

The new data element is stored under the Elements branch.

4 Choose the most appropriate base data type from the Base type 
drop-down list box. The base types are the fundamental data 
types used internally by DataStage for processing. 

There are five base types:

– Date. The column contains a date, represented in DataStage 
internal format. There are many built-in transforms available to 
convert dates to character strings. See DataStage Developer’s 
Help or "Built-In Transforms and Routines" in Server Job 
Developer’s Guide for a list of the built-in transforms available.

– Number. The column contains a numeric value.

– String. The column contains data as a string of characters. 
DataStage interprets the string as a number if needed.

– Time. The column contains data as a time. 
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– Default. The data has an SQL data type already assigned and 
the most appropriate base type is used. 

5 Optionally enter a brief description of the data in the Short 
description field. The text entered here is displayed when you 
choose View ➤ Details from the DataStage Manager window or 
print a data elements report. 

6 Optionally enter a detailed description of the data in the Long 
description field. This description is displayed only when you 
view the properties of a data element.

7 Click OK to save the data element and to close the Data Element 
dialog box. You must edit your table definition to assign this new 
data element. 

Naming Data Elements
The rules for naming data elements are as follows:

Data element names can be any length.

They must begin with an alphabetic character.

They can contain alphanumeric, period, and underscore 
characters. 

Data element category names can be any length and consist of any 

characters, including spaces.

Assigning Data Elements in Table Definitions
data sources for 
server jobs 

If you created a new data element or you want to use one of the data 

elements supplied with DataStage, you need to assign it. Data 

elements are assigned by editing the column definitions which are 

then used in your DataStage job, or you can assign them in individual 

stages as you design your job. If you want to set up the data elements 

before you develop your job, you can edit the column definitions in 

the table definition. 

To assign a data element in a table definition:

1 Expand the Table Definitions branch until you can see the table 
definition you want to edit in the display area. 

2 Select the table definition and do one of the following:

– Choose File ➤ Properties… .

– Choose Properties… from the shortcut menu.

– Double-click the table definition in the display area.
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– Click the Properties button on the toolbar.

The Table Definition dialog box appears.

3 Click the Columns tab. The Columns page appears at the front of 
the Table Definition dialog box. 

4 Click the Data element cell for the column definition you want to 
edit.

5 Choose the data element you want to use from the drop-down list. 
This list contains all the built-in data elements supplied with 
DataStage and any data elements you created. For a description of 
the built-in data elements supplied with DataStage, see "Built-In 
Data Elements" on page 4-5.

6 Click OK to save the column definition and to close the Table 
Definition dialog box.

Viewing or Editing Data Elements
data sources for 
server jobs 

You can view the properties of any data element in your project. To 

view the properties of a data element, select it in the display area and 

do one of the following:

Choose File ➤ Properties… .

Choose Properties… from the shortcut menu.

Double-click the data element in the display area.

Click the Properties button on the toolbar.

The Data Element dialog box appears. Click OK to close the dialog 

box.

If you are viewing the properties of a data element that you created, 

you can edit any of the fields on the General or SQL Properties 
page. The changes are saved when you click OK. 

If you are viewing the properties of a built-in data element, you cannot 

edit any of the settings on the General or SQL Properties page. 

Built-In Data Elements
data sources for 
server jobs

DataStage has a number of built-in data elements. There are six data 

elements that represent each of the base types used internally by 

DataStage:
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Date. The column contains a date, represented in DataStage 
internal format. There are many built-in transforms available to 
convert dates to character strings. 

Number. The column contains a numeric value.

String. The column contains data as a string of characters. 
DataStage interprets the string as a number if needed.

Time. The column contains data as a time. 

Default. The data has an SQL data type already assigned and the 
most appropriate base type is used. 

Timestamp. The column contains a string that represents a 
combined date/time: 

YYYY-MM-DD HH:MM:SS

In addition, there are some data elements that are used to express 

dates in alternative ways:

DATE.TAG. The data specifies a date and is stored in the 
following format:

1993-02-14 (February 14, 1993)

WEEK.TAG. The data specifies a week and is stored in the 
following format:

1993W06 (week 6 of 1993)

MONTH.TAG. The data specifies a month and is stored in the 
following format: 

1993-02 (February 1993)

QUARTER.TAG. The data specifies a quarter and is stored in the 
following format: 

1993Q1 (quarter 1, 1993)

YEAR.TAG. The data specifies a year and is stored in the 
following format: 

1993

Each of these data elements has a base type of String. The format of 

the date complies with various ISO 8601 date formats. 

You can view the properties of these data elements. You cannot edit 

them.
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5
Managing Jobs and

Job Sequences

DataStage jobs are defined in the DataStage Designer and run from 

the DataStage Director or from a mainframe. Jobs perform the actual 

extraction and translation of data and the writing to the target data 

warehouse or data mart. There are certain basic management tasks 

that you can perform on jobs in the DataStage Manager, by editing the 

job’s properties. Each job in a project has properties, including 

optional descriptions and job parameters. You can view and edit the 

job properties from the DataStage Designer or the DataStage 

Manager.

Job sequences are control jobs defined in the DataStage Designer 

using the graphical job sequence editor. Job sequences specify a 

sequence of server or parallel jobs to run, together with different 

activities to perform depending on success or failure of each step. Like 

jobs, job sequences have properties which you can edit from the 

DataStage Manager.

You can also use the Extended Job View feature of the DataStage 

Manager to view the various components of a job or job sequence 

held in the DataStage Repository. Note that you cannot actually edit 

any job components from within the Manager, however.

Editing Job Properties
To edit job properties in the DataStage Manager, double-click a job in 

the project tree in the DataStage Manager window or, alternatively, 

select the job and choose File ➤ Properties… .
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The Job Properties dialog box appears. The dialog box differs 

depending on whether it is a server job, parallel job, or a mainframe 

job. A server job has up to five pages: General, Parameters, Job 

control, Dependencies, and Performance. Parallel job properties 

are the same as server job properties except they have an Execution 

page rather than a Performance page, and also have a Generated 
OSH and Defaults page. A mainframe job has five pages: General, 
Parameters, Environment, Extensions, and Operational meta 
data.

Server Job and Parallel Job Properties
Server jobs
and
Parallel jobs

The General page is as follows:

It has the following fields:

Category. The category to which the job belongs.

Job version number. The version number of the job. A job 
version number has several components:

– The version number N.n.n. This number checks the 
compatibility of the job with the version of DataStage installed. 
This number is automatically set when DataStage is installed 
and cannot be edited.

– The release number n.N.n. This number is automatically 
incremented every time you release a job. For more 
information about releasing jobs, see "Debugging, Compiling, 
and Releasing a Job" in Server Job Developer’s Guide.
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– The bug fix number n.n.N. This number reflects minor changes 
to the job design or properties. To change this number, select it 
and enter a new value directly or use the arrow buttons to 
increase the number. 

Before-job subroutine and Input value. Optionally contain the 
name (and input parameter value) of a subroutine that is executed 
before the job runs. For example, you can specify a routine that 
prepares the data before processing starts. 

Choose a routine from the drop-down list box. This list box 

contains all the built routines defined as a Before/After 
Subroutine under the Routines branch in the Repository. Enter 

an appropriate value for the routine’s input argument in the Input 

value field. 

If you use a routine that is defined in the Repository, but which 

was edited and not compiled, a warning message reminds you to 

compile the routine when you close the Job Properties dialog 

box. 

If you installed or imported a job, the Before-job subroutine 

field may reference a routine which does not exist on your system. 

In this case, a warning message appears when you close the Job 
Properties dialog box. You must install or import the “missing” 

routine or choose an alternative one to use.

A return code of 0 from the routine indicates success. Any other 

code indicates failure and causes a fatal error when the job is run.

After-job subroutine and Input value. Optionally contains the 
name (and input parameter value) of a subroutine that is executed 
after the job has finished. For example, you can specify a routine 
that sends an electronic message when the job finishes. 

Choose a routine from the drop-down list box. This list box 

contains all the built routines defined as a Before/After 
Subroutine under the Routines branch in the Repository. Enter 

an appropriate value for the routine’s input argument in the Input 

value field. 

If you use a routine that is defined in the Repository, but which 

was edited but not compiled, a warning message reminds you to 

compile the routine when you close the Job Properties dialog 

box. 

A return code of 0 from the routine indicates success. Any other 

code indicates failure and causes a fatal error when the job is run.
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Only run after-job subroutine on successful job 
completion. This option is enabled if you have selected an After-
job subroutine. If you select the option, then the After-job 
subroutine will only be run if the job has successfully completed 
running all its stages.

Web Service Enabled. This checkbox only appears only appears 
for server jobs. It is only enabled if you have Web Services 
installed.

Allow Multiple Instance. Select this to enable the DataStage 
Director to run multiple instances of this job.

Enable hashed file cache sharing. Check this to enable 
multiple processes to access the same hash file in cache (the 
system checks if this is appropriate). This can save memory 
resources and speed execution where you are, for example, 
running multiple instances of the same job. This applies to server 
jobs and to parallel jobs that used server functionality in container 
stages.

Collation sequence file. Parallel jobs only. Allows you to specify 
a file which contains collation specification sequences. This allows 
you to sort data using the sequences that apply to different 
locales. 

Short job description. An optional brief description of the job.

Full job description. An optional detailed description of the job.

Parallel job properties have an additional check box:

Enable Runtime Column Propagation for new links. This checkbox 
appears if you have selected Enable Runtime Column propagation 
for Parallel jobs for this project in the DataStage Administrator. 
Check it to enable runtime column propagation by default for all 
new links on this job (see "Runtime Column Propagation" in 
Parallel Job Developer’s Guide for a description).

If you installed or imported a job, the After-job subroutine field may 

reference a routine that does not exist on your system. In this case, a 

warning message appears when you close the Job Properties dialog 

box. You must install or import the “missing” routine or choose an 

alternative one to use.

Specifying Job Parameters
Server jobs 
and
Parallel jobs

Job parameters allow you to design flexible, reusable jobs. If you 

want to process data based on the results for a particular week, 

location, or product you can include these settings as part of your job 

design. However, when you want to use the job again for a different 

week or product, you must edit the design and recompile the job. 
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Instead of entering inherently variable factors as part of the job 

design, you can set up parameters which represent processing 

variables. 

For server and parallel jobs, you are prompted for values when you 

run or schedule the job. 

Job parameters are defined, edited, and deleted in the Parameters p

age of the Job Properties dialog box. 

All job parameters are defined by editing the empty row in the Job 

Parameters grid. For more information about adding and deleting 

rows, or moving between the cells of a grid, see Appendix A, “Editing 

Grids.” 

Warning Before you remove a job parameter definition, you 

must make sure that you remove the references to this 

parameter in your job design. If you do not do this, 

your job may fail to run. 

You can also use the Parameters page to set different values for 

environment variables while the job runs. The settings only take effect 

at run-time, they do not affect the permanent settings of environment 

variables.

The server job Parameters page is as follows:

The Job Parameters grid has the following columns:

Parameter name. The name of the parameter.

Prompt. Text used as the field name in the run-time dialog box.
Manager Guide 5-5



Editing Job Properties Managing Jobs and Job Sequences
Type. The type of the parameter (to enable validation).

Default Value. The default setting for the parameter.

Help text. The text that appears if a user clicks Property Help in 
the Job Run Options dialog box when running the job.

Job Parameters

Specify the type of the parameter by choosing one of the following 

from the drop-down list in the Type column:

String. The default type.

Encrypted. Used to specify a password. The default value is set 
by double-clicking the Default Value cell to open the Setup 
Password dialog box. Type the password in the Encrypted 
String field and retype it in the Confirm Encrypted String field. 
It is displayed as asterisks.

Integer. Long int (–2147483648 to +2147483647).

Float. Double (1.79769313486232E308 to –4.94065645841247E–
324 and 4.94065645841247E–324 to –1.79769313486232E308).

Pathname. Enter a default pathname or file name by typing it into 
Default Value or double-click the Default Value cell to open the 
Browse dialog box.

List. A list of valid string variables. To set up a list, double-click the 
Default Value cell to open the Setup List and Default dialog 
box. Build a list by typing in each item into the Value field, then 
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clicking Add. The item then appears in the List box. To remove an 
item, select it in the List box and click Remove. Select one of the 
items from the Set Default drop-down list box to be the default.

Date. Date in the ISO format yyyy-mm-dd.

Time. Time in the format hh:mm:ss.

DataStage uses the parameter type to validate any values that are 

subsequently supplied for that parameter, be it in the Director or the 

Designer.

Job Parameter Defaults

You can supply default values for parameters, which are used unless 

another value is specified when the job is run. For most parameter 

types, you simply type an appropriate default value into the Default 
Value cell. When specifying a password or a list variable, double-click 

the Default Value cell to open further dialog boxes which allow you 

to supply defaults.

Using Job Parameters in Server Jobs

To use the defined job parameters, you must specify them when you 

edit a stage. When you edit a field that you wish to use a parameter 

for, enter #Param#, where Param is the name of the job parameter. 

The string #Param# is replaced by the value for the job parameter 

when the job is run. (For more details about editing stages, see 

DataStage Designer Guide). 

A job parameter can be used in any stage or link property, for 

example:

In Transformer stages. You can use job parameters in the 
following fields when you edit a Transformer stage:
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– Key Expression cell of a reference input link

– Constraint on an output link

– Derivation cell of an output link

You can use the Expression Editor to insert a job parameter in 

these fields. For information about the Expression Editor, see "The 

DataStage Expression Editor" in Server Job Developer’s Guide.

In Sequential File stages. You can use job parameters in the 
following fields in the Sequential File Stage dialog box:

– File name field on the Inputs or Outputs page

In ODBC, UniVerse, or UniData 6 stages. You can use job 
parameters in the following fields in the stage dialog box:

– Data source name field on the General tab on the Stage 
page

– User name and Password fields on the General tab on the 
Stage page

– Account name or Use directory path fields on the Details 
tab on the Stage page (UniVerse and UniData 6 stages only)

– Table name field on the General tab on the Inputs or 
Outputs page

– WHERE clause field on the Selection tab on the Outputs 
page

– Value cell on the Parameters tab, which appears in the 
Outputs page when you use a stored procedure (ODBC stage 
only)

– Expression field on the Derivation dialog box, opened from 
the Derivation column in the Outputs page of a UniVerse or 
ODBC Stage dialog box

In Hashed File stages. You can use job parameters in the following 
fields in the Hashed File Stage dialog box:

– Use account name or Use directory path fields on the 
Stage page

– File name field on the General tab on the Inputs or Outputs 
page

In UniData stages. You can use job parameters in the following 
fields in the UniData Stage dialog box:

– Server, Database, User name, and Password fields on the 
Stage page

– File name field on the General tab on the Inputs or Outputs 
page
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In Folder stages. You can use job parameters in the following 
fields in the Folder stage dialog box:

– Properties in the Properties tab of the Stage page

– Properties in the Properties tab of the Outputs page

Before and after subroutines. You can use job parameters to 
specify argument values for before and after subroutines.

Note You can also use job parameters in the Property name 

field on the Properties tab in the stage type dialog box 

when you create a plug-in. For more information, see 

Server Job Developer’s Guide.

Using Job Parameters in Parallel Jobs

You can use the defined parameters by specifying them in place of 

properties in a parallel job stage editor. Properties that you can 

substitute a job parameter for have a right arrow next to the property 

value field. Click on this to open a menu and click on the Job 

Parameter item. This allows you to choose from the list of defined job 

parameters.
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Environment Variables

To set a runtime value for an environment variable:

1 Click Add Environment Variable… . The Choose environment 
variable list appears.

This shows a list of the available environment variables (the 

example shows parallel job environment variables).
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2 Click on the environment variable you want to set at runtime. It 
appears in the parameter grid, distinguished from job parameters 
by being preceded by a $. 

You can also click New… to define a new environment variable. A 

dialog box appears allowing you to specify name and prompt. The 

new variable is added to the Choose environment variable list 

and you can click on it to add it to the parameters grid.

3 Set the required value in the Default Value column. This is the 
only field you can edit for an environment variable. Depending on 
the type of variable a further dialog box may appear to help you 
enter a value.

Environment variables are set up using the DataStage Administrator, 

see "Setting Environment Variables" in DataStage Administrator 

Guide.

Job Control Routines
Server jobs
and
Parallel jobs

A job control routine provides the means of controlling other jobs 

from the current job. A set of one or more jobs can be validated, run, 

reset, stopped, and scheduled in much the same way as the current 

job can be. You can, if required, set up a job whose only function is to 

control a set of other jobs. The graphical job sequence editor (see 

Chapter 6) produces a job control routine when you compile a job 

sequence (you can view this in the job Sequence properties), but you 

can set up you own control job by entering your own routine on the 

Job control page of the Job Properties dialog box. The routine 

uses a set of BASIC functions provided for the purpose. For more 

information about these routines, see DataStage Developer’s Help or 
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"DataStage Development Kit (Job Control Interfaces)" in Server Job 

Developer’s Guide. You can use this same code for running parallel 

jobs. The Job control page provides a basic editor to let you 

construct a job control routine using the functions.

The toolbar contains buttons for cutting, copying, pasting, and 

formatting code, and for activating Find (and Replace). The main part 

of this page consists of a multiline text box with scroll bars. The Add 
Job button provides a drop-down list box of all the server and parallel 

jobs in the current project. When you select a compiled job from the 

list and click Add, the Job Run Options dialog box appears, allowing 

you to specify any parameters or run-time limits to apply when the 

selected job is run. The job will also be added to the list of 

dependencies (see "Specifying Job Dependencies" on page 5-14). 

When you click OK in the Job Run Options dialog box, you return to 

the Job control page, where you will find that DataStage has added 

job control code for the selected job. The code sets any required job 

parameters and/or limits, runs the job, waits for it to finish, then tests 

for success.

Alternatively, you can type your routine directly into the text box on 

the Job control page, specifying jobs, parameters, and any run-time 

limits directly in the code.

The following is an example of a job control routine. It schedules two 

jobs, waits for them to finish running, tests their status, and then 

schedules another one. After the third job has finished, the routine 

gets its finishing status.

* get a handle for the first job
Hjob1 = DSAttachJob("DailyJob1",DSJ.ERRFATAL)
* set the job's parameters
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Dummy = DSSetParam(Hjob1,"Param1","Value1")
* run the first job
Dummy = DSRunJob(Hjob1,DSJ.RUNNORMAL)

* get a handle for the second job
Hjob2 = DSAttachJob("DailyJob2",DSJ.ERRFATAL)
* set the job's parameters
Dummy = DSSetParam(Hjob2,"Param2","Value2")
* run the second job
Dummy = DSRunJob(Hjob2,DSJ.RUNNORMAL)

* Now wait for both jobs to finish before scheduling the third job
Dummy = DSWaitForJob(Hjob1)
Dummy = DSWaitForJob(Hjob2)

* Test the status of the first job (failure causes routine to exit)
J1stat = DSGetJobInfo(Hjob1, DSJ.JOBSTATUS)
If J1stat = DSJS.RUNFAILED 

Then Call DSLogFatal("Job DailyJob1 failed","JobControl")
End

* Test the status of the second job (failure causes routine to 
* exit)
J2stat = DSGetJobInfo(Hjob2, DSJ.JOBSTATUS)
If J2stat = DSJS.RUNFAILED 

Then Call DSLogFatal("Job DailyJob2 failed","JobControl")
End

* Now get a handle for the third job
Hjob3 = DSAttachJob("DailyJob3",DSJ.ERRFATAL)
* and run it
Dummy = DSRunJob(Hjob3,DSJ.RUNNORMAL)
* then wait for it to finish
Dummy = DSWaitForJob(Hjob3)

* Finally, get the finishing status for the third job and test it
J3stat = DSGetJobInfo(Hjob3, DSJ.JOBSTATUS)
If J3stat = DSJS.RUNFAILED 

Then Call DSLogFatal("Job DailyJob3 failed","JobControl")
End

Possible status conditions returned for a job are as follows.

A job that is in progress is identified by:

DSJS.RUNNING – Job running; this is the only status that means 
the job is actually running.

Jobs that are not running may have the following statuses:

DSJS.RUNOK –  Job finished a normal run with no warnings.

DSJS.RUNWARN – Job finished a normal run with warnings.

DSJS.RUNFAILED – Job finished a normal run with a fatal error.

DSJS.VALOK – Job finished a validation run with no warnings.

DSJS.VALWARN – Job finished a validation run with warnings.

DSJS.VALFAILED –  Job failed a validation run.
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DSJS.RESET –  Job finished a reset run.

DSJS.STOPPED – Job was stopped by operator intervention 
(cannot tell run type).

Specifying Job Dependencies
Server jobs
and
Parallel jobs

The Dependencies page of the Job Properties dialog box allows 

you to specify any dependencies a server or parallel job has. These 

may be functions, routines, or other jobs that the job requires in order 

to run successfully. This is to ensure that, if the job is packaged for use 

on another system, all the required components will be included in 

the package.

Enter details as follows:

Type. The type of item upon which the job depends. Choose from 
the following:

– Job. Released or unreleased job. If you have added a job on 
the Job control page (see page 5-11), this will automatically 
be included in the dependencies. If you subsequently delete 
the job from the job control routine, you must remove it from 
the dependencies list manually.

– Local. Locally cataloged BASIC functions and subroutines (i.e., 
Transforms and Before/After routines).

– Global. Globally cataloged BASIC functions and subroutines 
(i.e., Custom UniVerse functions).

– File. A standard file.
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– ActiveX. An ActiveX (OLE) object (not available on UNIX-
based systems).

Name. The name of the function or routine. The name required 
varies according to the Type of the dependency:

– Job. The name of a released, or unreleased, job. 

– Local. The catalog name. 

– Global. The catalog name.

– File. The file name.

– ActiveX. Server jobs only. The Name entry is actually 
irrelevant for ActiveX objects. Enter something meaningful to 
you (ActiveX objects are identified by the Location field).

Location. The location of the dependency. A browse dialog box is 
available to help with this. This location can be an absolute path, 
but it is recommended you specify a relative path using the 
following environment variables:

– %SERVERENGINE% – DataStage engine account directory 
(normally C:\Ascential\DataStage\ServerEngine).

– %PROJECT% – Current project directory.

– %SYSTEM% – System directory on Windows or /usr/lib on 
UNIX.

The Browse Files dialog box is shown below. You cannot navigate to 

the parent directory of an environment variable.

Specifying Performance Enhancements
Server Jobs The Performance page allows you to improve the performance of 

the job by specifying the way the system divides jobs into processes. 
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For a full explanation of this, see "Optimizing Performance in Server 

Jobs" in Server Job Developer’s Guide.

These settings can also be made on a project-wide basis using the 

DataStage Administrator (see "Tunables Page" in DataStage 

Administrator Guide).

The settings are: 

Use Project Defaults. Select this to use whatever settings have 
been made in the DataStage Administrator for the project to which 
this job belongs.

Enable Row Buffering. There are two types of mutually 
exclusive row buffering:

– In process. You can improve the performance of most 
DataStage Server jobs by turning in-process row buffering on 
and recompiling the job. This allows connected active stages 
to pass data via buffers rather than row by row.

– Inter process. Use this if you are running server jobs on an 
SMP parallel system. This enables the job to run using a 
separate process for each active stage, that will run 
simultaneously on a separate processor. 

Note You cannot use row-buffering of either sort if your job 

uses COMMON blocks in transform functions to pass 

data between stages. This is not recommended 

practice, and it is advisable to redesign your job to use 

row buffering rather than COMMON blocks.
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Buffer size. Specifies the size of the buffer used by in-process or 
inter-process row buffering. defaults to 128 Kb.

Timeout. Only applies when inter-process row buffering is used. 
Specifies the time one process will wait to communicate with 
another via the buffer before timing out. Defaults to 10 seconds.

Specifying Execution Page Options 
Parallel jobs You can switch tracing on for parallel jobs to help you debug them. 

The page has the following options:

Compile in trace mode. Select this so that you can use the 
tracing facilities after you have compiled this job.

Force Sequential Mode. Select this to force the job to run 
sequentially on the conductor node. 

Limits per partition. These options enable you to limit data in 
each partition to make problems easier to diagnose:

– Number of Records per Link. This limits the number of 
records that will be included in each partition.

Log Options Per Partition. These options enable you to specify 
how log data is handled for partitions. This can cut down the data 
in the log to make problems easier to diagnose.

– Skip count. Set this to N to skip the first N records in each 
partition.

– Period. Set this to N to print every Nth record per partition, 
starting with the first record. N must be >= 1.
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Enable Runtime Column Propagation for new links. This 
checkbox appears if you have selected Enable Runtime Column 
propagation for Parallel jobs for this project in the DataStage 
Administrator. Check it to enable runtime column propagation by 
default for all new links on this job (see "Runtime Column 
Propagation" in Parallel Job Developer’s Guide for a description).

Advanced Runtime Options. This field allows experienced 
Orchestrate users to enter parameters that are added to the OSH 
command line. Under normal circumstances this should be left 
blank.

Generated OSH Page
This page appears for parallel jobs if you have selected the 

Generated OSH visible option in the DataStage Administrator (see 

"Parallel Page" in DataStage Administrator Guide). The page allows 

you to view the code generated by parallel jobs when they are 

compiled.

Specifying Parallel Job Defaults
You specify date/time and number formats for a job on the Defaults 

page:

The page shows the current defaults for date, time, timestamp, and 

decimal separator. To change the default, clear the corresponding 

Project default check box, then either select a new format from the 

drop down list or type in a new format.
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Mainframe Job Properties
Mainframe jobs The mainframe job General page is as follows:

Category. The category to which the job belongs.

Job version number. The version number of the job. A job 
version number has several components:

– The version number N.n.n. This number checks the 
compatibility of the job with the version of DataStage installed. 
This number is automatically set when DataStage is installed 
and cannot be edited.

– The release number n.N.n. This number is automatically 
incremented every time you release a job.

– The bug fix number n.n.N. This number reflects minor changes 
to the job design or properties. To change this number, select it 
and enter a new value directly or use the arrow buttons to 
increase the number. 

Century break year. Where a two-digit year is used in the data, 
this is used to specify the year that is used to separate 19nn years 
from 20nn years.

Perform expression semantic checking. Click this to enable 
semantic checking in the mainframe expression editor. Be aware 
that selecting this can incur performance overheads. This is most 
likely to affect jobs with large numbers of column derivations.
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Generate operational meta data. Click this to have the job 
generate operational meta data for use in MetaStage. Clicking this 
enables the Operational meta data page.

NULL indicator location. Select Before column or After 
column to specify the position of NULL indicators in mainframe 
column definitions.

NULL indicator value. Specify the character used to indicate 
nullability of mainframe column definitions. NULL indicators must 
be single-byte, printable characters. Specify one of the following: 

– A single character value (1 is the default)

– An ASCII code in the form of a three-digit decimal number 
from 000 to 255

– An ASCII code in hexadecimal form of %Hnn or %hnn where 
'nn' is a hexadecimal digit (0-9, a-f, A-F)

Non-NULL Indicator Value. Specify the character used to 
indicate non-NULL column definitions in mainframe flat files. 
NULL indicators must be single-byte, printable characters. Specify 
one of the following: 

– A single character value (0 is the default)

– An ASCII code in the form of a three-digit decimal number 
from 000 to 255

– An ASCII code in hexadecimal form of %Hnn or %hnn where 
'nn' is a hexadecimal digit (0-9, a-f, A-F)

Short job description. An optional brief description of the job.

Full job description. An optional detailed description of the job.

Click OK to record your changes in the job design. Changes are not 

saved to the Repository until you save the job design.

Specifying Mainframe Job Parameters
Mainframe jobs Instead of entering inherently variable factors as part of the job design 

you can set up parameters which represent processing variables. 

For mainframe jobs the parameter values are placed in a file that is 

accessed when the job is compiled and run on the mainframe. 

Job parameters are defined, edited, and deleted in the Parameters p

age of the Job Properties dialog box. 

All job parameters are defined by editing the empty row in the Job 

Parameters grid. For more information about adding and deleting 

rows, or moving between the cells of a grid, see Appendix A, “Editing 

Grids.” 
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Warning Before you remove a job parameter definition, you 

must make sure that you remove the references to this 

parameter in your job design. If you do not do this, 

your job may fail to run. 

The mainframe job Parameters page is as follows:

It contains the following fields and columns:

Parameter file name. The name of the file contain the 
parameters.

COBOL DD name. The DD name for the location of the file.

Name. The name of the parameter.

Type. The type of the parameter. It can be one of:

– Char. A fixed-length string where the Length attribute is used 
to determine its length. The COBOL program defines this 
parameter with PIC X(length).

– Decimal. A COBOL signed zoned-decimal number, the 
precision is indicated by Length and the scale by Scale. The 
COBOL program defines this parameter with PIC S9(length-
scale)V9(scale).

– Integer. A COBOL signed zoned-decimal number, where the 
Length attribute is used to define its length. The COBOL 
program defines this parameter with PIC S9(length).

Length. The length of a char or a decimal parameter.

Scale. The precision of a decimal parameter.

Description. Optional description of the parameter.
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Using Mainframe Job Parameters

You can use job parameters as part of mainframe expressions. The 

Expression Editor offers a list of the job parameters that have been 

defined. See DataStage Enterprise MVS Edition: Mainframe Job 

Developer’s Guide for a description of the Expression Editor.

The actual values for job parameters are specified in a separate file 

which is uploaded to the mainframe with the job. See DataStage 

Enterprise MVS Edition: Mainframe Job Developer’s Guide for more 

details.

Specifying Mainframe Job Environment Properties
Mainframe jobs The environment properties of a mainframe job in the Job 

Properties dialog box allow you to specify information that is used 

when code is generated for mainframe jobs.

It contains the following fields:

DBMS. If your design includes relational stages, the code 
generation process looks here for database details to include in 
the JCL files. If these fields are blank, it will use the project 
defaults as specified in the DataStage Administrator. 

– System name. The name of the database used by the 
relational stages in the job. If not specified, the project default 
is used.

– User name and Password. These will be used throughout the 
job. If not specified, the project default is used. 
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– Rows per commit. Defines the number of rows that are 
written to a DB2 database before they are committed. The 
default setting is 0, which means to commit after all rows are 
processed. If you enter a number, the commit occurs after the 
specified number of rows are processed. For inserts, only one 
row is written. For updates or deletes, multiple rows may be 
written. However, if an error is detected, a rollback occurs. 

Teradata. If your design includes Teradata stages, the code 
generation process looks here for database details to include in 
the JCL files. 

– TDP id and Account id. The connection details used in 
Teradata stages throughout the job.

– User ID and Password. These will be used throughout the 
job. 

Specifying Extension Variable Values
If you have customized the JCL templates and added extension 

variables, you can supply values for these variables for a particular job 

in the Extension page of the Job Properties dialog box.

It contains a grid with the following columns:

Name. The name of the extension variable. The name must begin 
with an alphabetic character and can contain only alphabetic or 
numeric characters. It can be upper or lower case or mixed.

Value. The value that the extension variable will take in this job. 
No validation is done on the value.
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Specifying Operational Meta Data
If your job is going to generate operational meta data for use with 

MetaStage you can specify the details of how the meta data will be 

handled on this page.

The fields are:

Machine Profile. If you have already specified a machine profile 
that contains some or all of the required details, you can select it 
from the drop-down list and the relevant fields will be 
automatically filled in.

IP address. IP Host name/address for the machine running your 
program and generating the operational meta data.

File exchange method. Choose between FTP and connect direct.

User name. The user name for connecting to the machine.

Password. The password for connecting to the machine

XML file target directory and Dataset name for XML file. 
Specify the target directory and dataset name for the XML file 
which will record the operational meta data.

Job Sequence Properties
To edit job properties in the DataStage Manager, double-click a job 

sequence in the project tree in the DataStage Manager window or, 

alternatively, select the job sequence and choose File ➤ Properties… 
. The Properties dialog box appears, it has four pages; General, 
Parameters, Job Control, and Dependencies.
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The General page is as follows:

The General page contains:

Category. The job category containing the job sequence.

Version number. The version number of the job sequence. A 
version number has several components:

– The version number N.n.n. This number checks the 
compatibility of the job with the version of DataStage installed. 
This number is automatically set when DataStage is installed 
and cannot be edited.

– The release number n.N.n. This number is automatically 
incremented every time you release a job sequence. (You can 
release a job sequence in the same way as you release a job.)

– The bug fix number n.n.N. This number reflects minor changes 
to the job sequence design or properties. To change this 
number, select it and enter a new value directly or use the 
arrow buttons to increase the number.

Allow Multiple Instance. Select this to enable the DataStage 
Director to run multiple instances of this job sequence.

The compilation options specify details about restarting the sequence 

if one of the jobs fails for some reason.

Add checkpoints so sequence is restartable on failure. 
Select this to enable restarting for this job sequence. If you have 
enabled this feature on a project-wide basis in the DataStage 
Administrator, this check box is selected by default when the 
sequence is first created.
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Automatically handle job runs that fail. Select this to have 
DataStage automatically handle failing jobs within a sequence 
(this means that you do not have to have a specific trigger for job 
failure). When you select this option, the following happens 
during job sequence compilation:

– For each job activity that does not have a specific trigger for 
error handling, code is inserted that branches to an error 
handling point. (If an activity has either a specific failure 
trigger, or if it has an OK trigger and an otherwise trigger, it is 
judged to be handling its own aborts, so no code is inserted.)

If the compiler has inserted error-handling code the following 

happens if a job within the sequence fails:

– A warning is logged in the sequence log about the job not 
finishing OK.

– If the job sequence has an exception handler defined, the code 
will go to it.

– If there is no exception handler, the sequence aborts with a 
suitable message.

If you have enabled this feature on a project-wide basis in the 

DataStage Administrator, this check box is selected by default 

when the sequence is first created.

Note that, when using this feature, you should avoid using any 

routines within the job sequence that return any value other than 

0 to indicate success, as non-zero values will always be taken as 

indicating failure (all routines supplied with DataStage return 0).

Log warnings after activities that finish with status other 
than OK. Select this to have the sequence log a message in the 
sequence log if it runs a job that finished with a non-zero 
completion code (for example, warnings or fatal errors). Messages 
are also logged for routine or command activities that fail (i.e., 
return a non-zero completion code).

Log report messages after each job run. Select this to have 
the sequence log a status report for a job immediately the job run 
finishes. The following is an example of the information that will 
be logged:

**************************************************
STATUS REPORT FOR JOB: jobname
Generated: 2003-10-31 16:13:09
Job start time=2003-10-31 16:13:07
Job end time=2003-10-31 16:13:07
Job elapsed time=00:00:00
Job status=1 (Finished OK)

Stage: stagename1, 10000 rows input 
Stage start time=2003-10-31 16:17:27, end time=2003
-10-31 16:17:27, elapsed=00:00:00
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Link: linkname1, 10000 rows
Stage: stagename2, 10000 rows input
Stage start time=2003-10-31 16:17:28, end time=2003
-10-31 16:17:28, elapsed=00:00:00

Link: linkname2, 10000 rows
Link: linkname3, 10000 rows

Short Description. An optional brief description of the job 
sequence.

Full Description. An optional detailed description of the job 
sequence.

The Parameters page is as follows:

The Parameters page allows you to specify parameters for the job 

sequence. Values for the parameters are collected when the job 

sequence is run in the Director. The parameters you define here are 

available to all the activities in the job sequence.

The Parameters grid has the following columns:

Parameter name. The name of the parameter.

Prompt. Text used as the field name in the run-time dialog box.

Type. The type of the parameter (to enable validation).

Default Value. The default setting for the parameter.

Help text. The text that appears if a user clicks Property Help in 
the Job Run Options dialog box when running the job sequence.

The Job Control page displays the code generated when the job 

sequence is compiled.
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The Dependencies page is as follows:

The Dependencies page of the Properties dialog box shows you 

the dependencies the job sequence has. These may be functions, 

routines, or jobs that the job sequence runs. Listing the dependencies 

of the job sequence here ensures that, if the job sequence is packaged 

for use on another system, all the required components will be 

included in the package.

The details as follows:

Type. The type of item upon which the job sequence depends:

– Job. Released or unreleased job. If you have added a job to the 
sequence, this will automatically be included in the 
dependencies. If you subsequently delete the job from the 
sequence, you must remove it from the dependencies list 
manually.

– Local. Locally cataloged BASIC functions and subroutines (i.e., 
Transforms and Before/After routines).

– Global. Globally cataloged BASIC functions and subroutines 
(i.e., Custom UniVerse functions).

– File. A standard file.

– ActiveX. An ActiveX (OLE) object (not available on UNIX-
based systems).

Name. The name of the function or routine. The name required 
varies according to the Type of the dependency:
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– Job. The name of a released, or unreleased, job. 

– Local. The catalog name. 

– Global. The catalog name.

– File. The file name.

– ActiveX. The Name entry is actually irrelevant for ActiveX 
objects. Enter something meaningful to you (ActiveX objects 
are identified by the Location field).

Location. The location of the dependency. A browse dialog box is 
available to help with this. This location can be an absolute path, 
but it is recommended you specify a relative path using the 
following environment variables:

– %SERVERENGINE% – DataStage engine account directory 
(normally C:\Ascential\DataStage\ServerEngine).

– %PROJECT% – Current project directory.

– %SYSTEM% – System directory on Windows or /usr/lib on 
UNIX.

Using Extended Job View
Extended Job View enables you to view the various components of a 

job or job sequence from within the Manager. To use it, select View ➤ 
Extended Job View.

With Extended Job View on, the hierarchy of Job components 

becomes visible in the DataStage Manager. The hierarchy is displayed 

in the tree view (left pane), and items in the list view (right pane).

The hierarchy for jobs is as follows:

1 Job Containers

2 Jobs

3 Stages

4 Links

5 Columns

When a column is selected in the tree view, the list view displays a 

derivation trail for that column. This shows the columns from which 

the selected column was derived in the form Stage.Link.Column. 

Extended Job View also indicates where one job is dependent on 

another. Jobs controlled by a job will be shown as subitems of that 

job under a Dependencies item.
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The hierarchy for job sequences is as follows:

1 Job Containers

2 Jobs Sequences

3 Activities

4 Triggers

The dependencies of the job sequence are shown as subitems under a 

Dependencies item.

When you select a job or job sequence in the tree view, a shortcut 

menu becomes available:

Edit. Opens the job or job sequence in the DataStage Designer, 
ready for editing.

Event Log. Opens the job or job sequence in the DataStage 
Director, showing the relevant job log.

Properties. Opens the Properties dialog box for the job or job 
sequence.
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Managing Shared Containers

Shared containers allow you to define portions of job design in a form 

that can be reused by other jobs. Shared containers are defined in the 

DataStage Designer, and stored in the DataStage Repository. You can 

perform certain management tasks on shared containers from the 

DataStage Manager in a similar way to managing DataStage Jobs 

from the Manager.

Each shared container in a project has properties, including optional 

descriptions and job parameters. You can view and edit the job 

properties from the DataStage Designer or the DataStage Manager.

To edit shared container properties in the DataStage Manager, double-

click a shared container in the project tree in the DataStage Manager 

window, alternatively you can select the shared container and choose 

File ➤ Properties… or click the Properties button on the toolbar.
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The Container Properties dialog box appears, it has two pages 

General and Parameters. 

The General page has the following fields:

Category. The category to which the job belongs.

Container version number. The version number of the 
container. A container version number has several components:

– The version number N.n.n. This number checks the 
compatibility of the job with the version of DataStage installed. 
This number is automatically set when DataStage is installed 
and cannot be edited.

– The bug fix number n.n.N. This number reflects minor changes 
to the container design or properties. To change this number, 
select it and enter a new value directly or use the arrow buttons 
to increase the number. 

Short job description. An optional brief description of the 
container.

Full job description. An optional detailed description of the 
container.

Specifying Shared Container Parameters
Container parameters allow you to design flexible, reusable 

containers. Instead of entering inherently variable factors as part of 

the container design, you can set up parameters which represent 

processing variables, this allows you to reuse the container in 

different jobs.
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Container parameters are defined, edited, and deleted in the 

Parameters page of the Container Properties dialog box. When 

you use the container in an actual job design, you specify actual 

values for the parameters in the Shared Container stage Properties 

page in the job design.

All container parameters are defined by editing the empty row in the 

Parameters grid. For more information about adding and deleting 

rows, or moving between the cells of a grid, see Appendix A, “Editing 

Grids.” 

The Parameters page is as follows

The Job Parameters grid has the following columns:

Parameter name. The name of the parameter.

Type. The type of the parameter (to enable validation).

Help text. The text that appears at the bottom of the Shared 
Container stage Properties page when you select this parameter 
ready to specify a value for it.

Specify the type of the parameter by choosing one of the following 

from the drop-down list in the Type column:

String. The default type.

Integer. Long int (–2147483648 to +2147483647).

Float. Double (1.79769313486232E308 to –4.94065645841247E–
324 and 4.94065645841247E–324 to –1.79769313486232E308).

Pathname. Enter a default pathname or file name by typing it into 
Default Value or double-click the Default Value cell to open the 
Browse dialog box.
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Date. Date in the format yyyy-mm-dd

Time. Time in the format hh:mm:ss.
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Managing Stages

All the stage types that you can use in your DataStage jobs have 

definitions which you can view under the Stage Type category in the 

project tree. All of the definitions for built-in stage types are read-only. 

This is true for Server jobs, Parallel Jobs and Mainframe jobs. The 

definitions for plug-in stages supplied by Ascential are also read-only.

There are two types of stage whose definitions you can alter:

Parallel job custom stages. You can define new stage types for 
Parallel jobs by creating a new stage type and editing its definition 
in the DataStage Manager.

Custom plug-in stages. Where you have defined your own 
plug-in stages you can register these with the DataStage 
Repository and specify their definitions in the DataStage Manager.

Custom Stages for Parallel Jobs
There are three different types of stage that you can define:

Custom. This allows knowledgeable Orchestrate users to specify 
an Orchestrate operator as a DataStage stage. This is then 
available to use in DataStage Parallel jobs.

Build. This allows you to design and build your own operator as a 
stage to be included in DataStage Parallel Jobs.

Wrapped. This allows you to specify a UNIX command to be 
executed by a DataStage stage. You define a wrapper file that in 
turn defines arguments for the UNIX command and inputs and 
outputs.

The DataStage Manager provides an interface that allows you to 

define a new DataStage Parallel job stage of any of these types. This 
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interface is also available from the Repository window of the 

DataStage Designer.

Naming Parallel Stage Types
The rules for naming parallel stage typesare as follows:

Stage type names can be any length.

They must begin with an alphabetic character.

They can contain alphanumeric, period, and underscore 
characters. 

Stage type category names can be any length and consist of any 

characters, including spaces.

Defining Custom Stages
You can define a custom stage in order to include an Orchestrate 

operator in a DataStage stage which you can then include in a 

DataStage job. The stage will be available to all jobs in the project in 

which the stage was defined. You can make it available to other 

projects using the DataStage Manager Export/Import facilities. The 

stage is automatically added to the job palette.

To define a custom stage type from the DataStage Manager:
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1 Select the Stage Types category in the Repository tree.

2 Choose File ➤ New Parallel Stage ➤ Custom from the main 
menu or New Parallel Stage ➤ Custom from the shortcut 
menu. The Stage Type dialog box appears.

3 Fill in the fields on the General page as follows:

– Stage type name. This is the name that the stage will be 
known by to DataStage. Avoid using the same name as 
existing stages.

– Category. The category that the new stage will be stored in 
under the stage types branch of the Repository tree view. Type 
in or browse for an existing category or type in the name of a 
new one. The category also determines what group in the 
palette the stage will be added to. Choose an existing category 
to add to an existing group, or specify a new category to create 
a new palette group.

– Parallel Stage type. This indicates the type of new Parallel 
job stage you are defining (Custom, Build, or Wrapped). You 
cannot change this setting.

– Execution Mode. Choose the execution mode. This is the mode 
that will appear in the Advanced tab on the stage editor. You 
can override this mode for individual instances of the stage as 
required, unless you select Parallel only or Sequential only. See 
"Advanced Tab" in Parallel Job Developer’s Guide for a 
description of the execution mode. 
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– Mapping. Choose whether the stage has a Mapping tab or 
not. A Mapping tab enables the user of the stage to specify 
how output columns are derived from the data produced by 
the stage. Choose None to specify that output mapping is not 
performed, choose Default to accept the default setting that 
DataStage uses.

– Preserve Partitioning. Choose the default setting of the 
Preserve Partitioning flag. This is the setting that will appear in 
the Advanced tab on the stage editor. You can override this 
setting for individual instances of the stage as required. See 
"Advanced Tab" in Parallel Job Developer’s Guide for a 
description of the preserve partitioning flag. 

– Partitioning. Choose the default partitioning method for the 
stage. This is the method that will appear in the Inputs page 
Partitioning tab of the stage editor. You can override this 
method for individual instances of the stage as required. See 
"Partitioning Tab" in Parallel Job Developer’s Guide for a 
description of the partitioning methods. 

– Collecting. Choose the default collection method for the 
stage. This is the method that will appear in the Inputs page 
Partitioning tab of the stage editor. You can override this 
method for individual instances of the stage as required. See 
"Partitioning Tab" in Parallel Job Developer’s Guide for a 
description of the collection methods. 

– Operator. Enter the name of the Orchestrate operator that you 
want the stage to invoke. 

– Short Description. Optionally enter a short description of the 
stage.

– Long Description. Optionally enter a long description of the 
stage.
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Go to the Links page and specify information about the links 

allowed to and from the stage you are defining.

Use this to specify the minimum and maximum number of input 

and output links that your custom stage can have, and to enable 

the ViewData feature for target data (you cannot enable target 

ViewData if your stage has any output links). When the stage is 

used in a job design, a ViewData button appears on the Input 

page, which allows you to view the data on the actual data target 

(provided some has been written there).

In order to use the target ViewData feature, you have to specify an 

Orchestrate operator to read the data back from the target. This 

will usually be different to the operator that the stage has used to 

write the data (i.e., the operator defined in the Operator field of 

the General page). Specify the reading operator and associated 

arguments in the Operator and Options fields.

If you enable target ViewData, a further field appears in the 

Properties grid, called ViewData (see page 7-8).

4 Go to the Creator page and optionally specify information about 
the stage you are creating. We recommend that you assign a 
version number to the stage so you can keep track of any 
subsequent changes.

You can specify that the actual stage will use a custom GUI by 

entering the ProgID for a custom GUI in the Custom GUI Prog ID 

field. 

You can also specify that the stage has its own icon. You need to 

supply a 16 x 16 bibitmap and a 32 x 32 bit bitmap to be displayed 
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in vatious place in the DataStage user interface. Click the 16 x 16 
Bitmap button and browse for the smaller bitmap file. Click the 

32 x 32 Bitmap button and browse for the large bitmap file. Click 

the Reset Bitmap Info button to revert to using the default 

DataStage icon for this stage.. 

5 Go to the Properties page. This allows you to specify the options 
that the Orchestrate operator requires as properties that appear in 
the Stage Properties tab. For custom stages the Properties tab 
always appears under the Stage page.

6 Fill in the fields as follows:
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– Property name. The name of the property. 

– Data type. The data type of the property. Choose from:

Boolean

Float

Integer

String

Pathname

List

Input Column

Output Column

If you choose Input Column or Output Column, when the stage is 

included in a job a drop-down list will offer a choice of the defined 

input or output columns. 

If you choose list you should open the Extended Properties 
dialog box from the grid shortcut menu to specify what appears in 

the list.

– Prompt. The name of the property that will be displayed on 
the Properties tab of the stage editor.

– Default Value. The value the option will take if no other is 
specified. 

– Required. Set this to True if the property is mandatory.

– Repeats. Set this true if the property repeats (i.e., you can 
have multiple instances of it).

– Conversion. Specifies the type of property as follows:

-Name. The name of the property will be passed to the 

operator as the option value. This will normally be a hidden 

property, i.e., not visible in the stage editor.

-Name Value. The name of the property will be passed to the 

operator as the option name, and any value specified in the 

stage editor is passed as the value.

-Value. The value for the property specified in the stage editor 

is passed to the operator as the option name. Typically used to 

group operator options that are mutually exclusive.

Value only. The value for the property specified in the stage 

editor is passed as it is.
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Input Schema. Specifies that the property will contain a 

schema string whose contents are populated from the Input 

page Columns tab.

Output Schema. Specifies that the property will contain a 

schema string whose contents are populated from the Output 

page Columns tab.

None. This allows the creation of properties that do not 

generate any osh, but can be used for conditions on other 

properties (for example, for use in a situation where you have 

mutually exclusive properties, but at least one of them must be 

specified).

– Schema properties require format options. Select this 
check box to specify that the stage being specified will have a 
Format tab.

If you have enabled target ViewData on the Links page, the 

following property is also displayed:

– ViewData. Select Yes to indicate that the value of this 
property should be used when viewing data. For example, if 
this property specifies a file to write to when the stage is used 
in a job design, the value of this property will be used to read 
the data back if ViewData is used in the stage.

If you select a conversion type of Input Schema or Output 
Schema, you should note the following: 

– Data Type is set to String.

– Required is set to Yes.

– The property is marked as hidden and will not appear on the 
Properties page when the custom stage is used in a job 
design.

If your stage can have multiple input or output links there would 

be a Input Schema property or Output Schema property per-link.

When the stage is used in a job design, the property will contain 

the following OSH for each input and/or output link:

–property_name record {format_props} ( column_definition 
{format_props}; …)

Where:

– property_name is the name of the property (usually ‘schema’)

– format_properties are formatting information supplied on the 
Format page (if the stage has one).
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– there is one column_definition for each column defined in the 
Columns tab for that link. The format_props in this case refers 
to per-column format information specified in the Edit 
Column Meta Data dialog box.

Schema properties are mutually exclusive with schema file 

properties. If your custom stage supports both, you should use the 

Extended Properties dialog box to specify a condition of 

“schemafile= “ for the schema property. The schema property is 

then only valid provided the schema file property is blank (or does 

not exist).

7 If you want to specify a list property, or otherwise control how 
properties are handled by your stage, choose Extended 
Properties from the Properties grid shortcut menu to open the 
Extended Properties dialog box.

The settings you use depend on the type of property you are 

specifying:

– Specify a category to have the property appear under this 
category in the stage editor. By default all properties appear in 
the Options category.

– Specify that the property will be hidden and not appear in the 
stage editor. This is primarily intended to support the case 
where the underlying operator needs to know the JobName. 
This can be passed using a mandatory String property with a 
default value that uses a DS Macro. However, to prevent the 
user from changing the value, the property needs to be hidden.

– If you are specifying a List category, specify the possible values 
for list members in the List Value field.
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– If the property is to be a dependent of another property, select 
the parent property in the Parents field.

– Specify an expression in the Template field to have the actual 
value of the property generated at compile time. It is usually 
based on values in other properties and columns. 

– Specify an expression in the Conditions field to indicate that 
the property is only valid if the conditions are met. The 
specification of this property is a bar '|' separated list of 
conditions that are AND'ed together. For example, if the 
specification was a=b|c!=d, then this property would only be 
valid (and therefore only available in the GUI) when property a 
is equal to b, and property c is not equal to d.

Click OK when you are happy with the extended properties.

8 If your custom stage will create columns, go to the Mapping 
Additions page. It contains a grid that allows for the specification 
of columns created by the stage. You can also specify that column 
details are filled in from properties supplied when the stage is 
used in a job design, allowing for dynamic specification of 
columns.

The grid contains the following fields:

– Column name. The name of the column created by the stage. 
You can specify the name of a property you specified on the 
Property page of the dialog box to dynamically allocate the 
column name. Specify this in the form #property_name#, the 
created column will then take the value of this property, as 
specified at design time, as the name of the created column.
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– Parallel type. The type of the column (this is the underlying 
data type, not the SQL data type). Again you can specify the 
name of a property you specified on the Property page of the 
dialog box to dynamically allocate the column type. Specify 
this in the form #property_name#, the created column will then 
take the value of this property, as specified at design time, as 
the type of the created column. (Note that you cannot use a 
repeatable property to dynamically allocate a column type in 
this way.)

– Nullable. Choose Yes or No to indicate whether the created 
column can contain a null.

– Conditions. Allows you to enter an expression specifying the 
conditions under which the column will be created. This could, 
for example, depend on the setting of one of the properties 
specified in the Property page.

You can propagate the values of the Conditions fields to other 

columns if required. Do this by selecting the columns you want to 

propagate to, then right-clicking in the source Conditions field 

and choosing Propagate from the shortcut menu. A dialog box 

asks you to confirm that you want to propagate the conditions to 

all columns.

Defining Build Stages
You define a Build stage to enable you to provide a custom operator 

that can be executed from a DataStage Parallel job stage. The stage 

will be available to all jobs in the project in which the stage was 

defined. You can make it available to other projects using the 

DataStage Manager Export facilities. The stage is automatically added 

to the job palette.

When defining a Build stage you provide the following information:

Description of the data that will be input to the stage.

Whether records are transferred from input to output. A transfer 
copies the input record to the output buffer. If you specify auto 
transfer, the operator transfers the input record to the output 
record immediately after execution of the per record code. The 
code can still access data in the output buffer until it is actually 
written.

Any definitions and header file information that needs to be 
included.

Code that is executed at the beginning of the stage (before any 
records are processed).
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Code that is executed at the end of the stage (after all records have 
been processed).

Code that is executed every time the stage processes a record.

Compilation and build details for actually building the stage.

The Code for the Build stage is specified in C++. There are a number of 

macros available to make the job of coding simpler . There are also a 

number of header files available containing many useful functions. 

See Parallel Job Advanced Developer’s Guide.

When you have specified the information, and request that the stage 

is generated, DataStage generates a number of files and then 

compiles these to build an operator which the stage executes. The 

generated files include: 

Header files (ending in .h)

Source files (ending in .c)

Object files (ending in .so)

The following shows a build stage in diagrammatic form:

To define a Build stage from the DataStage Manager:

Input 
buffer

Output 
buffer

Transfer directly copies records from input buffer
to output buffer. Records can still be accessed by

code while in the buffer. 

Per-record code. 
Used to process 

each record

Input port - records from
 input link

Output port - records to 
output link

Build Stage

Post-loop code - 
executed after all

records are processed 

Pre-loop code - 
executed before any

records are processed 
7-12 Manager Guide



Managing Stages Custom Stages for Parallel Jobs
1 Select the Stage Types category in the Repository tree.

2 Choose File ➤ New Parallel Stage ➤ Build from the main 
menu or New Parallel Stage ➤ Build from the shortcut menu. 
The Stage Type dialog box appears:

3 Fill in the fields on the General page as follows:

– Stage type name. This is the name that the stage will be 
known by to DataStage. Avoid using the same name as 
existing stages.

– Category. The category that the new stage will be stored in 
under the stage types branch. Type in or browse for an existing 
category or type in the name of a new one. The category also 
determines what group in the palette the stage will be added 
to. Choose an existing category to add to an existing group, or 
specify a new category to create a new palette group.

– Class Name. The name of the C++ class. By default this takes 
the name of the stage type.

– Parallel Stage type. This indicates the type of new parallel 
job stage you are defining (Custom, Build, or Wrapped). You 
cannot change this setting.

– Execution mode. Choose the default execution mode. This is 
the mode that will appear in the Advanced tab on the stage 
editor. You can override this mode for individual instances of 
the stage as required, unless you select Parallel only or 
Sequential only. See "Advanced Tab" in Parallel Job 
Developer’s Guide for a description of the execution mode.
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– Preserve Partitioning. This shows the default setting of the 
Preserve Partitioning flag, which you cannot change in a Build 
stage. This is the setting that will appear in the Advanced tab 
on the stage editor. You can override this setting for individual 
instances of the stage as required. See "Advanced Tab" in 
Parallel Job Developer’s Guide for a description of the preserve 
partitioning flag.

– Partitioning. This shows the default partitioning method, 
which you cannot change in a Build stage. This is the method 
that will appear in the Inputs Page Partitioning tab of the 
stage editor. You can override this method for individual 
instances of the stage as required. See "Partitioning Tab" in 
Parallel Job Developer’s Guide for a description of the 
partitioning methods. 

– Collecting. This shows the default collection method, which 
you cannot change in a Build stage. This is the method that will 
appear in the Inputs Page Partitioning tab of the stage editor. 
You can override this method for individual instances of the 
stage as required. See "Partitioning Tab" in Parallel Job 
Developer’s Guide for a description of the collection methods.

– Operator. The name of the operator that your code is defining 
and which will be executed by the DataStage stage. By default 
this takes the name of the stage type. 

– Short Description. Optionally enter a short description of the 
stage.

– Long Description. Optionally enter a long description of the 
stage.

4 Go to the Creator page and optionally specify information about 
the stage you are creating. We recommend that you assign a 
release number to the stage so you can keep track of any 
subsequent changes. 

You can specify that the actual stage will use a custom GUI by 

entering the ProgID for a custom GUI in the Custom GUI Prog ID 

field. 

You can also specify that the stage has its own icon. You need to 

supply a 16 x 16 bibitmap and a 32 x 32 bit bitmap to be displayed 

in vatious place in the DataStage user interface. Click the 16 x 16 
Bitmap button and browse for the smaller bitmap file. Click the 

32 x 32 Bitmap button and browse for the large bitmap file. Click 
7-14 Manager Guide



Managing Stages Custom Stages for Parallel Jobs
the Reset Bitmap Info button to revert to using the default 

DataStage icon for this stage.

5 Go to the Properties page. This allows you to specify the options 
that the Build stage requires as properties that appear in the Stage 
Properties tab. For custom stages the Properties tab always 
appears under the Stage page.

Fill in the fields as follows:
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– Property name. The name of the property. This will be passed 
to the operator you are defining as an option, prefixed with ‘-’ 
and followed by the value selected in the Properties tab of the 
stage editor.

– Data type. The data type of the property. Choose from:

Boolean

Float

Integer

String

Pathname

List

Input Column

Output Column

If you choose Input Column or Output Column, when the stage is 

included in a job a drop-down list will offer a choice of the defined 

input or output columns.

If you choose list you should open the Extended Properties 
dialog box from the grid shortcut menu to specify what appears in 

the list.

– Prompt. The name of the property that will be displayed on 
the Properties tab of the stage editor.

– Default Value. The value the option will take if no other is 
specified. 

– Required. Set this to True if the property is mandatory.

– Conversion. Specifies the type of property as follows:

-Name. The name of the property will be passed to the 

operator as the option value. This will normally be a hidden 

property, i.e., not visible in the stage editor.

-Name Value. The name of the property will be passed to the 

operator as the option name, and any value specified in the 

stage editor is passed as the value.

-Value. The value for the property specified in the stage editor 

is passed to the operator as the option name. Typically used to 

group operator options that are mutually exclusive.

Value only. The value for the property specified in the stage 

editor is passed as it is.
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6 If you want to specify a list property, or otherwise control how 
properties are handled by your stage, choose Extended 
Properties from the Properties grid shortcut menu to open the 
Extended Properties dialog box.

The settings you use depend on the type of property you are 

specifying:

– Specify a category to have the property appear under this 
category in the stage editor. By default all properties appear in 
the Options category.

– If you are specifying a List category, specify the possible values 
for list members in the List Value field.

– If the property is to be a dependent of another property, select 
the parent property in the Parents field.

– Specify an expression in the Template field to have the actual 
value of the property generated at compile time. It is usually 
based on values in other properties and columns. 

– Specify an expression in the Conditions field to indicate that 
the property is only valid if the conditions are met. The 
specification of this property is a bar '|' separated list of 
conditions that are AND'ed together. For example, if the 
specification was a=b|c!=d, then this property would only be 
valid (and therefore only available in the GUI) when property a 
is equal to b, and property c is not equal to d.

Click OK when you are happy with the extended properties.
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7 Click on the Build page. The tabs here allow you to define the 
actual operation that the stage will perform.

The Interfaces tab enable you to specify details about inputs to 

and outputs from the stage, and about automatic transfer of 

records from input to output. You specify port details, a port being 

where a link connects to the stage. You need a port for each 

possible input link to the stage, and a port for each possible output 

link from the stage.

You provide the following information on the Input sub-tab: 

– Port Name. Optional name for the port. The default names for 
the ports are in0, in1, in2 … . You can refer to them in the code 
using either the default name or the name you have specified.

– Alias. Where the port name contains non-ascii characters, you 
can give it an alias in this column.

– AutoRead. This defaults to True which means the stage will 
automatically read records from the port. Otherwise you 
explicitly control read operations in the code.

– Table Name. Specify a table definition in the DataStage 
Repository which describes the meta data for the port. You can 
browse for a table definition by choosing Select Table from 
the menu that appears when you click the browse button. You 
can also view the schema corresponding to this table definition 
by choosing View Schema from the same menu. You do not 
have to supply a Table Name. If any of the columns in your 
table definition have names that contain non-ascii characters, 
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you should choose Column Aliases from the menu. The 
Build Column Aliases dialog box appears. This lists the 
columns that require an alias and let you specify one.

– RCP. Choose True if runtime column propagation is allowed for 
inputs to this port. Defaults to False. You do not need to set this 
if you are using the automatic transfer facility.

You provide the following information on the Output sub-tab:

– Port Name. Optional name for the port. The default names for 
the links are out0, out1, out2 … . You can refer to them in the 
code using either the default name or the name you have 
specified.

– Alias. Where the port name contains non-ascii characters, you 
can give it an alias in this column.

– AutoWrite. This defaults to True which means the stage will 
automatically write records to the port. Otherwise you 
explicitly control write operations in the code. Once records are 
written, the code can no longer access them.

– Table Name. Specify a table definition in the DataStage 
Repository which describes the meta data for the port. You can 
browse for a table definition. You do not have to supply a Table 
Name. A shortcut menu accessed from the browse button 
offers a choice of Clear Table Name, Select Table, Create 
Table,View Schema, and Column Aliases. The use of these 
is as described for the Input sub-tab.

– RCP. Choose True if runtime column propagation is allowed for 
outputs from this port. Defaults to False. You do not need to set 
this if you are using the automatic transfer facility.

The Transfer sub-tab allows you to connect an input buffer to an 

output buffer such that records will be automatically transferred 

from input to output. You can also disable automatic transfer, in 

which case you have to explicitly transfer data in the code. 
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Transferred data sits in an output buffer and can still be accessed 

and altered by the code until it is actually written to the port.

You provide the following information on the Transfer tab:

– Input. Select the input port to connect to the buffer from the 
drop-down list. If you have specified an alias, this will be 
displayed here.

– Output. Select the output port to transfer input records from 
the output buffer to from the drop-down list. If you have 
specified an alias, this will be displayed here.

– Auto Transfer. This defaults to False, which means that you 
have to include code which manages the transfer. Set to True to 
have the transfer carried out automatically.

– Separate. This is False by default, which means this transfer 
will be combined with other transfers to the same port. Set to 
True to specify that the transfer should be separate from other 
transfers.

The Logic tab is where you specify the actual code that the stage 

executes. 

The Definitions sub-tab allows you to specify variables, include 

header files, and otherwise initialize the stage before processing 

any records.
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The Pre-Loop sub-tab allows you to specify code which is 

executed at the beginning of the stage, before any records are 

processed.

The Per-Record sub-tab allows you to specify the code which is 

executed once for every record processed.

The Post-Loop sub-tab allows you to specify code that is 

executed after all the records have been processed.

You can type straight into these pages or cut and paste from 

another editor. The shortcut menu on the Pre-Loop, Per-Record, 

and Post-Loop pages gives access to the macros that are 

available for use in the code.

The Advanced tab allows you to specify details about how the 

stage is compiled and built. Fill in the page as follows:

– Compile and Link Flags. Allows you to specify flags that are 
passed to the C++ compiler.

– Verbose. Select this check box to specify that the compile and 
build is done in verbose mode.

– Debug. Select this check box to specify that the compile and 
build is done in debug mode. Otherwise, it is done in optimize 
mode.

– Suppress Compile. Select this check box to generate files 
without compiling, and without deleting the generated files. 
This option is useful for fault finding.

– Base File Name. The base filename for generated files. All 
generated files will have this name followed by the appropriate 
suffix. This defaults to the name specified under Operator on 
the General page.

– Source Directory. The directory where generated .c files are 
placed. This defaults to the buildop folder in the current project 
directory. You can also set it using the 
DS_OPERATOR_BUILDOP_DIR environment variable in the 
DataStage Administrator (see DataStage Administrator Guide).

– Header Directory. The directory where generated .h files are 
placed. This defaults to the buildop folder in the current project 
directory. You can also set it using the 
DS_OPERATOR_BUILDOP_DIR environment variable in the 
DataStage Administrator (see DataStage Administrator Guide).

– Object Directory. The directory where generated .so files are 
placed. This defaults to the buildop folder in the current project 
directory. You can also set it using the 
DS_OPERATOR_BUILDOP_DIR environment variable in the 
DataStage Administrator (see DataStage Administrator Guide).
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– Wrapper directory. The directory where generated .op files 
are placed. This defaults to the buildop folder in the current 
project directory. You can also set it using the 
DS_OPERATOR_BUILDOP_DIR environment variable in the 
DataStage Administrator (see DataStage Administrator Guide).

8 When you have filled in the details in all the pages, click Generate 
to generate the stage. A window appears showing you the result 
of the build. 

Defining Wrapped Stages
You define a Wrapped stage to enable you to specify a UNIX 

command to be executed by a DataStage stage. You define a wrapper 

file that handles arguments for the UNIX command and inputs and 

outputs. The DataStage Manager provides an interface that helps you 

define the wrapper. The stage will be available to all jobs in the project 

in which the stage was defined. You can make it available to other 

projects using the DataStage Manager Export facilities. You can add 

the stage to your job palette using palette customization features in 

the DataStage Designer.

When defining a Wrapped stage you provide the following 

information:

Details of the UNIX command that the stage will execute.

Description of the data that will be input to the stage.

Description of the data that will be output from the stage.

Definition of the environment in which the command will execute.

The UNIX command that you wrap can be a built-in command, such 

as grep, a utility, such as SyncSort, or your own UNIX application. The 

only limitation is that the command must be ‘pipe-safe’ (to be pipe-

safe a UNIX command reads its input sequentially, from beginning to 

end). 

You need to define meta data for the data being input to and output 

from the stage. You also need to define the way in which the data will 

be input or output. UNIX commands can take their inputs from 

standard in, or another stream, a file, or from the output of another 

command via a pipe. Similarly data is output to standard out, or 

another stream, to a file, or to a pipe to be input to another command. 

You specify what the command expects.

DataStage handles data being input to the Wrapped stage and will 

present it in the specified form. If you specify a command that expects 

input on standard in, or another stream, DataStage will present the 

input data from the jobs data flow as if it was on standard in. Similarly 
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it will intercept data output on standard out, or another stream, and 

integrate it into the job’s data flow.

You also specify the environment in which the UNIX command will be 

executed when you define the wrapped stage.

To define a Wrapped stage from the DataStage Manager:

1 Select the Stage Types category in the Repository tree.

2 Choose File ➤ New Parallel Stage ➤ Wrapped from the main 
menu or New Parallel Stage ➤ Wrapped from the shortcut 
menu. The Stage Type dialog box appears:

3 Fill in the fields on the General page as follows:

– Stage type name. This is the name that the stage will be 
known by to DataStage. Avoid using the same name as 
existing stages or the name of the actual UNIX command you 
are wrapping.

– Category. The category that the new stage will be stored in 
under the stage types branch. Type in or browse for an existing 
category or type in the name of a new one. The category also 
determines what group in the palette the stage will be added 
to. Choose an existing category to add to an existing group, or 
specify a new category to create a new palette group.

– Parallel Stage type. This indicates the type of new Parallel 
job stage you are defining (Custom, Build, or Wrapped). You 
cannot change this setting.
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– Wrapper Name. The name of the wrapper file DataStage will 
generate to call the command. By default this will take the 
same name as the Stage type name.

– Execution mode. Choose the default execution mode. This is 
the mode that will appear in the Advanced tab on the stage 
editor. You can override this mode for individual instances of 
the stage as required, unless you select Parallel only or 
Sequential only. See "Advanced Tab" in Parallel Job 
Developer’s Guide for a description of the execution mode.

– Preserve Partitioning. This shows the default setting of the 
Preserve Partitioning flag, which you cannot change in a 
Wrapped stage. This is the setting that will appear in the 
Advanced tab on the stage editor. You can override this 
setting for individual instances of the stage as required. See 
"Advanced Tab" in Parallel Job Developer’s Guide for a 
description of the preserve partitioning flag. 

– Partitioning. This shows the default partitioning method, 
which you cannot change in a Wrapped stage. This is the 
method that will appear in the Inputs Page Partitioning tab 
of the stage editor. You can override this method for individual 
instances of the stage as required. See "Partitioning Tab" in 
Parallel Job Developer’s Guide for a description of the 
partitioning methods.

– Collecting. This shows the default collection method, which 
you cannot change in a Wrapped stage. This is the method that 
will appear in the Inputs Page Partitioning tab of the stage 
editor. You can override this method for individual instances of 
the stage as required. See "Partitioning Tab" in Parallel Job 
Developer’s Guide for a description of the collection methods. 

– Command. The name of the UNIX command to be wrapped, 
plus any required arguments. The arguments that you enter 
here are ones that do not change with different invocations of 
the command. Arguments that need to be specified when the 
Wrapped stage is included in a job are defined as properties for 
the stage.

– Short Description. Optionally enter a short description of the 
stage.

– Long Description. Optionally enter a long description of the 
stage.

4 Go to the Creator page and optionally specify information about 
the stage you are creating. We recommend that you assign a 
release number to the stage so you can keep track of any 
subsequent changes.
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You can specify that the actual stage will use a custom GUI by 

entering the ProgID for a custom GUI in the Custom GUI Prog ID 

field. 

You can also specify that the stage has its own icon. You need to 

supply a 16 x 16 bibitmap and a 32 x 32 bit bitmap to be displayed 

in vatious place in the DataStage user interface. Click the 16 x 16 
Bitmap button and browse for the smaller bitmap file. Click the 

32 x 32 Bitmap button and browse for the large bitmap file. Click 

the Reset Bitmap Info button to revert to using the default 

DataStage icon for this stage.
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5 Go to the Properties page. This allows you to specify the 
arguments that the UNIX command requires as properties that 
appear in the stage Properties tab. For wrapped stages the 
Properties tab always appears under the Stage page.

Fill in the fields as follows:

– Property name. The name of the property that will be 
displayed on the Properties tab of the stage editor.

– Data type. The data type of the property. Choose from:

Boolean

Float

Integer

String

Pathname

List

Input Column

Output Column

If you choose Input Column or Output Column, when the stage 

is included in a job a drop-down list will offer a choice of the 

defined input or output columns.

If you choose list you should open the Extended Properties 
dialog box from the grid shortcut menu to specify what 

appears in the list.
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– Prompt. The name of the property that will be displayed on 
the Properties tab of the stage editor.

– Default Value. The value the option will take if no other is 
specified. 

– Required. Set this to True if the property is mandatory.

– Repeats. Set this true if the property repeats (i.e. you can have 
multiple instances of it).

– Conversion. Specifies the type of property as follows:

-Name. The name of the property will be passed to the 

command as the argument value. This will normally be a 

hidden property, i.e., not visible in the stage editor.

-Name Value. The name of the property will be passed to the 

command as the argument name, and any value specified in 

the stage editor is passed as the value.

-Value. The value for the property specified in the stage editor 

is passed to the command as the argument name. Typically 

used to group operator options that are mutually exclusive.

Value only. The value for the property specified in the stage 

editor is passed as it is.

6 If you want to specify a list property, or otherwise control how 
properties are handled by your stage, choose Extended 
Properties from the Properties grid shortcut menu to open the 
Extended Properties dialog box.

The settings you use depend on the type of property you are 

specifying:
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– Specify a category to have the property appear under this 
category in the stage editor. By default all properties appear in 
the Options category.

– If you are specifying a List category, specify the possible values 
for list members in the List Value field.

– If the property is to be a dependent of another property, select 
the parent property in the Parents field.

– Specify an expression in the Template field to have the actual 
value of the property generated at compile time. It is usually 
based on values in other properties and columns. 

– Specify an expression in the Conditions field to indicate that 
the property is only valid if the conditions are met. The 
specification of this property is a bar '|' separated list of 
conditions that are AND'ed together. For example, if the 
specification was a=b|c!=d, then this property would only be 
valid (and therefore only available in the GUI) when property a 
is equal to b, and property c is not equal to d.

Click OK when you are happy with the extended properties.

7 Go to the Wrapped page. This allows you to specify information 
about the command to be executed by the stage and how it will be 
handled.

The Interfaces tab is used to describe the inputs to and outputs 

from the stage, specifying the interfaces that the stage will need to 

function.
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Details about inputs to the stage are defined on the Inputs sub-

tab:

– Link. The link number, this is assigned for you and is read-
only. When you actually use your stage, links will be assigned 
in the order in which you add them. In our example, the first 
link will be taken as link 0, the second as link 1 and so on. You 
can reassign the links using the stage editor’s Link Ordering 
tab on the General page.

– Table Name. The meta data for the link. You define this by 
loading a table definition from the Repository. Type in the 
name, or browse for a table definition. Alternatively, you can 
specify an argument to the UNIX command which specifies a 
table definition. In this case, when the wrapped stage is used in 
a job design, the designer will be prompted for an actual table 
definition to use. 

– Stream. Here you can specify whether the UNIX command 
expects its input on standard in, or another stream, or whether 
it expects it in a file. Click on the browse button to open the 
Wrapped Stream dialog box. 

In the case of a file, you should also specify whether the file to be 

read is given in a command line argument, or by an environment 

variable. 

Details about outputs from the stage are defined on the Outputs 

sub-tab:

– Link. The link number, this is assigned for you and is read-
only. When you actually use your stage, links will be assigned 
in the order in which you add them. In our example, the first 
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link will be taken as link 0, the second as link 1 and so on. You 
can reassign the links using the stage editor’s Link Ordering 
tab on the General page.

– Table Name. The meta data for the link. You define this by 
loading a table definition from the Repository. Type in the 
name, or browse for a table definition. 

– Stream. Here you can specify whether the UNIX command 
will write its output to standard out, or another stream, or 
whether it outputs to a file. Click on the browse button to open 
the Wrapped Stream dialog box.

In the case of a file, you should also specify whether the file to 

be written is specified in a command line argument, or by an 

environment variable. 

The Environment tab gives information about the environment 

in which the command will execute.

Set the following on the Environment tab:

– All Exit Codes Successful. By default DataStage treats an 
exit code of 0 as successful and all others as errors. Select this 
check box to specify that all exit codes should be treated as 
successful other than those specified in the Failure codes 
grid.

– Exit Codes. The use of this depends on the setting of the All 
Exits Codes Successful check box.
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If All Exits Codes Successful is not selected, enter the codes in 

the Success Codes grid which will be taken as indicating 

successful completion. All others will be taken as indicating 

failure.

If All Exits Codes Successful is selected, enter the exit codes in 

the Failure Code grid which will be taken as indicating failure. All 

others will be taken as indicating success.

– Environment. Specify environment variables and settings that 
the UNIX command requires in order to run.

8 When you have filled in the details in all the pages, click Generate 
to generate the stage. 

Plug-In Stages
When designing jobs in the DataStage Designer, you can use plug-in 

stages in addition to the built-in stages supplied with DataStage. Plug-

ins are written to perform specific tasks that the built-in stages do not 

support, for example:

Custom aggregations

Control of external devices (for example, tape drives)

Access to external programs

Two plug-ins are automatically installed with DataStage for use with 

server jobs:

BCPLoad. The BCPLoad plug-in bulk loads data into a single table 
in a Microsoft SQL Server (Release 6 or 6.5) or Sybase (System 10 
or 11) database. 

Oracle 7 Bulk Load. The Oracle 7 Bulk Load plug-in generates 
control and data files for bulk loading into a single table on an 
Oracle target database. The files are suitable for loading into the 
target database using the Oracle command sqlldr. 

Other plug-ins are supplied with DataStage, but must be explicitly 

installed. You can install plug-ins when you install DataStage. Some 

plug-ins have versions for parallel jobs as well as for server jobs. 

Some plug-ins have a custom GUI, which can be installed at the same 

time. You can choose which plug-ins to install during the DataStage 

Server install. You install the corresponding custom GUIs during the 

DataStage client install. See Install and Upgrade Guide for more 

details.

You can subsequently install extra plug-ins either from the CD-ROM or 

by downloading them from the Web. These are then installed using 

the Package Installer as described in "Installing DataStage Packages" 

in DataStage Administartor Guide. 
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If the plug-in you require is not listed, contact Ascential to see if one is 

likely to become available. Alternatively, you can write your own plug-

in.

A plug-in consists of a set of routines that access external databases 

and/or perform complex programming. You must have a thorough 

knowledge of C to design and develop a plug-in.

To write your own plug-in: 

1 Assess the purpose of the plug-in. You need to determine what the 
plug-in must do in terms of data extraction or data conversion. 
Check that Ascential does not already have an available plug-in for 
this purpose.

2 Develop the routines using the DataStage C plug-in Stage 
Interface. These routines are used to extract, aggregate, or 
transform data when the job is run. If you need help writing the 
plug-in routines required to process your data, contact your local 
Ascential Customer Support Center. 

3 Register the plug-in with the DataStage Manager. It is 
recommended that your plug-in dynamically registers itself. 
Alternatively, you can register the plug-in manually.

DataStage has a generic Stage dialog box that can be used by plug-

ins, but it is also possible to define your own GUI for a plug-in and 

install that in DataStage.

Certain general management tasks can be carried out on plug-ins 

from the DataStage Manager.

Manually Registering a Plug-In Definition
If a plug-in that you design does not dynamically register itself (as 

recommended) you can register it manually from the DataStage 

Manager as follows:

1 Choose Tools ➤ Register Plug-In… . The Register plug-in 
dialog box appears:

2 Enter the path and name of the plug-in DLL in the Path of plug-in 
field.
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3 Specify where the plug-in will be stored in the Repository by 
entering the category name in the Category field. 

4 If you require the plug-in to be used in parallel jobs, select the 
Parallel stage type required check box.

5 Click OK to register the plug-in definition and close the dialog box.

Viewing Plug-In Definition Details
Once a plug-in has been registered with the Manager, you can view its 

details in the Stage Type dialog box. To do this, click the Plug-in icon 

in the Manager display area and do one of the following:

Choose File ➤ Properties… .

Choose Properties… from the shortcut menu.

Double-click the plug-in in the display area.

Click the Properties button on the toolbar.

The plug-in definition is read-only; you cannot change any of the 

details. The only exception to this is a plug-in that you added under an 

earlier version of DataStage.

This dialog box has up to five pages:

General. Contains the name and type of the plug-in and optional 
short and long descriptions. This page also contains the name and 
path of the plug-in DLL, and specifies whether the plug-in 
supports meta data import, transaction grouping, and/or data 
browsing.

Creator. Displays information about the creator and the version 
of the plug-in. 
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Properties. Specifies properties for the stage and the input and 
output links. 

Dependencies. Specifies the dependent DLLs. 

NLS. Specifies how character set mapping is carried out by the 
plug-in. For more information, see “Specifying Character Set 
Mapping.”

Specifying Character Set Mapping
If you want your plug-in to use data in character sets other than ASCII, 

you must specify how the plug-in handles character set mapping from 

the NLS page.

Click Works with external character set to specify that the data 

requires mapping:

If the plug-in performs its own mapping, you must also select 
Handles its own mapping. 

If the plug-in does not perform the character set mapping, you 
must specify the map to be used from the plug-in stage dialog box 
when you use the plug-in in a job design. 

If the plug-in does not require any character set mapping, select 

Works with internal character set.

Removing a Registered Plug-In
To remove a plug-in that you have previously registered:

1 Select the plug-in from the DataStage Manager display area.

2 Choose Tools ➤ Unregister Plug-In. The plug-in is removed.
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Packaging a Plug-In
If you have written a plug-in that you want to distribute to users on 

other DataStage systems, you need to package it. For details on how 

to package a plug-in for deployment, see "Using the Packager Wizard" 

on page 15-17.

Using a Plug-In
You can use a plug-in by inserting a plug-in stage in your job design. 

Plug-in stages are used the same way as built-in stages. 

The plug-in you choose determines the function and properties of the 

plug-in stage. When you have chosen a plug-in, you can edit the stage 

to define the data flowing into, through, or from it. 
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8
Managing Programming Components

The DataStage Repository holds many built-in routines and 

transforms which can be used as building blocks when designing 

DataStage jobs.

If required, you can define your own custom building blocks from 

within the DataStage Manager. The components, and the means of 

defining them, vary depending on whether they are intended for use 

in server jobs, parallel jobs, or mainframe jobs.

Components for Server Jobs
For many DataStage server jobs you may not need to perform any 

programming tasks. You can just choose ready made transforms and 

routines from the built-in ones supplied with DataStage and stored in 

the Repository. In the case where you want to define custom 

components, DataStage provides powerful procedural programming 

facilities.

At the heart of server job programming in DataStage is the BASIC 

language. For more information about BASIC syntax, see "BASIC 

Programming" in Server Job Developer’s Guide. 

There are several areas within the DataStage Manager where you may 

define programming components:

Defining custom routines to use as building blocks in other 
programming tasks. For example, you may define a routine which 
will then be reused by several custom transforms. You can view, 
edit, and create your own BASIC routines using the DataStage 
Manager. 
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Defining custom transforms. The function specified in a transform 
definition converts the data in a chosen column. You can view, 
edit, and create your own transforms using the DataStage 
Manager.

Defining before-stage and after-stage subroutines. These 
subroutines perform an action before or after a stage in a 
DataStage job has processed data. These subroutines can be used 
by Aggregator, Transformer, and some plug-in stages.

Defining before-job and after-job subroutines. These subroutines 
perform an action before or after a job is run and are set as job 
properties. 

Defining job control routines. These subroutines can be used to 
control other jobs from within the current job. 

Working with Server Routines
Server routines are stored in the Routines branch of the DataStage 

Repository, where you can create, view, or edit them using the 

Routine dialog box. The following program components are 

classified as routines:

Transform functions. These are functions that you can use 
when defining custom transforms. DataStage has a number of 
built-in transform functions which are located in the Routines ➤ 
Examples ➤ Functions branch of the Repository. You can also 
define your own transform functions in the Routine dialog box. 

Before/After subroutines. When designing a job, you can 
specify a subroutine to run before or after the job, or before or 
after an active stage. DataStage has a number of built-in before/
after subroutines, which are located in the Routines ➤ Built-in ➤ 
Before/After branch in the Repository. You can also define your 
own before/after subroutines using the Routine dialog box.

Custom UniVerse functions. These are specialized BASIC 
functions that have been defined outside DataStage. Using the 
Routine dialog box, you can get DataStage to create a wrapper 
that enables you to call these functions from within DataStage. 
These functions are stored under the Routines branch in the 
Repository. You specify the category when you create the routine. 
If NLS is enabled, you should be aware of any mapping 
requirements when using custom UniVerse functions. If a function 
uses data in a particular character set, it is your responsibility to 
map the data to and from Unicode.

ActiveX (OLE) functions. You can use ActiveX (OLE) functions 
as programming components within DataStage. Such functions 
are made accessible to DataStage by importing them. This creates 
a wrapper that enables you to call the functions. After import, you 
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can view and edit the BASIC wrapper using the Routine dialog 
box. By default, such functions are located in the Routines ➤ 
Class name branch in the Repository, but you can specify your 
own category when importing the functions.

Web Service routines. You can use operations imported from a 
web service as programming components within DataStage. Such 
routines are created by importing from a web service WSDL file. 

When using the Expression Editor, all of these components appear 

under the DS Routines… command on the Suggest Operand 
menu.

A special case of routine is the job control routine. Such a routine is 

used to set up a DataStage job that controls other DataStage jobs. Job 

control routines are specified in the Job control page on the Job 
Properties dialog box. Job control routines are not stored under the 

Routines branch in the Repository. 

When you create, view, or edit a routine under the Routines branch in 

the DataStage Manager, the Server Routine dialog box appears. This 

dialog box has five pages: General, Creator, Arguments, Code, 

and Dependencies.

There are five buttons in the Server Routine dialog box. Their 

availability depends on the action you are performing and the type of 

routine you are editing.

Close. Closes the Routine dialog box. If you have any unsaved 
changes, you are prompted to save them.

Save. Saves the routine.

Compile… . Compiles a saved routine. This button is available 
only when there are no outstanding (unsaved) changes.

Test… . Tests a routine. This button is available only for routines 
of type Transform Function and Custom UniVerse Function. 
This is because you cannot test before-subroutines and after-
subroutines in isolation. This button is active only when the 
routine has compiled or referenced successfully. 

Help. Invokes the Help system.

Naming Server Routines

Routine names can be any length. They must begin with an alphabetic 

character and can contain alphanumeric and period characters.

Routine category names can be any length and consist of any 

characters, including spaces.
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The Server Routine Dialog Box

This section describes the various pages of the Server Routine dialog 

box.

General Page 

The General page is displayed by default. It contains general 

information about the routine, including:

Routine name. The name of the function or subroutine. 

Type. The type of routine. There are three types of routine: 
Transform Function, Before/After Subroutine, or Custom 
UniVerse Function.

Category. The branch the routine is stored under in the 
Repository. 

External Catalog Name. This is only available if you have 
chosen Custom UniVerse Function from the Type box. Enter 
the cataloged name of the external routine.

Short description. An optional brief description of the routine. 
The text entered in this field is displayed when you choose View 
➤ Details from the DataStage Manager window or print a report.

Long description. An optional detailed description of the 
routine.
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Creator Page

The Creator page contains information about the creator and version 

number of the routine, including: 

Vendor. The company who created the routine.

Author. The creator of the routine.

Version. The version number of the routine, which is used when 
the routine is imported. The Version field contains a three-part 
version number, for example, 3.1.1. The first part of this number is 
an internal number used to check compatibility between the 
routine and the DataStage system. The second part of this number 
represents the release number. This number should be 
incremented when major changes are made to the routine 
definition or the underlying code. The new release of the routine 
supersedes any previous release. Any jobs using the routine use 
the new release. The last part of this number marks intermediate 
releases when a minor change or fix has taken place.

If you are creating a routine definition, the first part of the version 

number is set according to the version of DataStage you are 

using. You can edit the rest of the number to specify the release 

level. Click the part of the number you want to change and enter a 

number directly, or use the arrow button to increase the value.

Copyright. Copyright information.
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Arguments Page

The default argument names and whether you can add or delete 

arguments depends on the type of routine you are editing:

Before/After subroutines. The argument names are InputArg 
and Error Code. You can edit the argument names and 
descriptions but you cannot delete or add arguments.

Transform Functions and Custom UniVerse Functions. By 
default these have one argument called Arg1. You can edit 
argument names and descriptions and add and delete arguments. 
There must be at least one argument, but no more than 255.
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Code Page 

The Code page is used to view or write the code for the routine. The 

toolbar contains buttons for cutting, copying, pasting, and formatting 

code, and for activating Find (and Replace). The main part of this 

page consists of a multiline text box with scroll bars. For more 

information on how to use this page, see "Entering Code" on 

page 8-10.

Note This page is not available if you selected Custom 
UniVerse Function on the General page.
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Dependencies Page

The Dependencies page allows you to enter any locally or globally 

cataloged functions or routines that are used in the routine you are 

defining. This is to ensure that, when you package any jobs using this 

routine for deployment on another system, all the dependencies will 

be included in the package. The information required is as follows:

Type. The type of item upon which the routine depends. Choose 
from the following:

LocalLocally cataloged BASIC functions and

subroutines.

GlobalGlobally cataloged BASIC functions and

subroutines.

FileA standard file.

ActiveXAn ActiveX (OLE) object (not available on UNIX-

based systems).

Name. The name of the function or routine. The name required 
varies according to the type of dependency:

Local The catalog name. 

Global The catalog name.

File The file name.
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ActiveX The Name entry is actually irrelevant for ActiveX 

objects. Enter something meaningful to you (ActiveX objects are 

identified by the Location field).

Location. The location of the dependency. A browse dialog box is 
available to help with this. This location can be an absolute path, 
but it is recommended you specify a relative path using the 
following environment variables:

%SERVERENGINE% – DataStage engine account directory 

(normally C:\Ascential\DataStage\Engine on Windows and 

<dsadminhome>\Ascential\DataStage\DSEngine on UNIX).

%PROJECT% – Current project directory.

%SYSTEM% – System directory on Windows or /usr/lib on UNIX.

The Browse Files dialog box is shown below. You cannot navigate to 

the parent directory of an environment variable.

When browsing for the location of a file on a UNIX server, there is an 

entry called Root in the Base Locations drop-down list.

Creating a Routine

To create a new routine, select the Routines branch in the DataStage 

Manager window and do one of the following:

Choose File ➤ New Server Routine… .

Choose New Server Routine… from the shortcut menu.

Click the New button on the toolbar.

The Server Routine dialog box appears. On the General page:
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1 Enter the name of the function or subroutine in the Routine 
name field. This should not be the same as any BASIC function 
name.

2 Choose the type of routine you want to create from the Type drop-
down list box. There are three options:

– Transform Function. Choose this if you want to create a 
routine for a Transform definition.

– Before/After Subroutine. Choose this if you want to create a 
routine for a before-stage or after-stage subroutine or a before-
job or after-job subroutine. 

– Custom UniVerse Function. Choose this if you want to refer 
to an external routine, rather than define one in this dialog box. 
If you choose this, the Code page will not be available.

3 Enter or browse for a category name in the Category field. This 
name is used to create a branch under the main Routines branch. 
If you do not enter a name in this field, the routine is created 
under the main Routines branch. 

4 Optionally enter a brief description of the routine in the Short 
description field. The text entered here is displayed when you 
choose View ➤ Details from the DataStage Manager window.

5 Optionally enter a more detailed description of the routine in the 
Long description field. 

Once this page is complete, you can enter creator information on the 

Creator page, argument information on the Arguments page, and 

details of any dependencies on the Dependencies page. You must 

then enter your code on the Code page. 

Entering Code

You can enter or edit code for a routine on the Code page in the Server 

Routine dialog box. 

The first field on this page displays the routine name and the 

argument names. If you want to change these properties, you must 

edit the fields on the General and Arguments pages. 

The main part of this page contains a multiline text entry box, in which 

you must enter your code. To enter code, click in the box and start 

typing. You can use the following standard Windows edit functions in 

this text box:

Delete using the Del key

Cut using Ctrl-X

Copy using Ctrl-C
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Paste using Ctrl-V

Go to the end of the line using the End key

Go to the beginning of the line using the Home key

Select text by clicking and dragging or double-clicking

Some of these edit functions are included in a shortcut menu which 

you can display by clicking the right mouse button. You can also cut, 

copy, and paste code using the buttons in the toolbar.

Your code must only contain BASIC functions and statements 

supported by DataStage. If you are unsure of the supported functions 

and statements, or the correct syntax to use, see DataStage 

Developer’s Help or "BASIC Programming" in Server Job Developer’s 

Guide for a complete list of supported DataStage BASIC functions.

If NLS is enabled, you can use non-English characters in the following 

circumstances:

In comments

In string data (that is, strings contained in quotation marks)

The use of non-English characters elsewhere causes compilation 

errors.

If you want to format your code, click the Format button on the 

toolbar.

The return field on this page displays the return statement for the 

function or subroutine. You cannot edit this field.

Saving Code

When you have finished entering or editing your code, the routine 

must be saved. A routine cannot be compiled or tested if it has not 

been saved. To save a routine, click Save in the Server Routine 

dialog box. The routine properties (its name, description, number of 

arguments, and creator information) and the associated code are 

saved in the Repository. 

Compiling Code

When you have saved your routine, you must compile it. To compile a 

routine, click Compile… in the Server Routine dialog box. The 

status of the compilation is displayed in the lower window of the 

Server Routine dialog box. If the compilation is successful, the 

routine is marked as “built” in the Repository and is available for use. 

If the routine is a Transform Function, it is displayed in the list of 

available functions when you edit a transform. If the routine is a 

Before/After Subroutine, it is displayed in the drop-down list box of 
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available subroutines when you edit an Aggregator, Transformer, or 

plug-in stage, or define job properties. 

To troubleshoot any errors, double-click the error in the compilation 

output window. DataStage attempts to find the corresponding line of 

code that caused the error and highlights it in the code window. You 

must edit the code to remove any incorrect statements or to correct 

any syntax errors.

If NLS is enabled, watch for multiple question marks in the 

Compilation Output window. This generally indicates that a character 

set mapping error has occurred.

When you have modified your code, click Save then Compile… . If 

necessary, continue to troubleshoot any errors, until the routine 

compiles successfully. 

Once the routine is compiled, you can use it in other areas of 

DataStage or test it. For more information, see "Testing a Routine" on 

page 8-12.

Testing a Routine

Before using a compiled routine, you can test it using the Test… 

button in the Server Routine dialog box. The Test… button is 

activated when the routine has been successfully compiled. 

Note The Test… button is not available for a Before/After 
Subroutine. Routines of this type cannot be tested in 

isolation and must be executed as part of a running job. 

When you click Test…, the Test Routine dialog box appears:

This dialog box contains a grid and buttons. The grid has a column for 

each argument and one for the test result. 

You can add and edit rows in the grid to specify the values for 

different test cases. For more information about using and editing a 

grid, see Appendix A, “Editing Grids.”
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To run a test with a chosen set of values, click anywhere in the row 

you want to use and click Run. If you want to run tests using all the 

test values, click Run All. The Result… column is populated as each 

test is completed. 

To see more details for a particular test, double-click the Result… cell 

for the test you are interested in. The Test Output window appears, 

displaying the full test results:

Click Close to close this window.

If you want to delete a set of test values, click anywhere in the row you 

want to remove and press the Delete key or choose Delete row from 

the shortcut menu.

When you have finished testing the routine, click Close to close the 

Test Routine dialog box. Any test values you entered are saved when 

you close the dialog box. 

Using Find and Replace

If you want to search the code for specific text, or replace text, you can 

use Find and Replace. To start Find, click the Find button on the 

Code page toolbar. The Find dialog box appears:

This dialog box has the following fields, options, and buttons:

Find what. Contains the text to search for. Enter appropriate text 
in this field. If text was highlighted in the code before you chose 
Find, this field displays the highlighted text. 
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Match case. Specifies whether to do a case-sensitive search. By 
default this check box is cleared. Select this check box to do a case-
sensitive search.

Up and Down. Specifies the direction of search. The default 
setting is Down. Click Up to search in the opposite direction.

Find Next. Starts the search. This button is unavailable until you 
specify text to search for. Continue to click Find Next until all 
occurrences of the text have been found.

Cancel. Closes the Find dialog box. 

Replace… . Displays the Replace dialog box. For more 
information, see "Replacing Text" on page 8-14.

Help. Invokes the Help system.

Replacing Text

If you want to replace text in your code with an alternative text string, 

click the Replace… button in the Find dialog box. When you click this 

button, the Find dialog box changes to the Replace dialog box:

This dialog box has the following fields, options, and buttons:

Find what. Contains the text to search for and replace.

Replace with. Contains the text you want to use in place of the 
search text. 

Match case. Specifies whether to do a case-sensitive search. By 
default this check box is cleared. Select this check box to do a case-
sensitive search.

Up and Down. Specifies the direction of search and replace. The 
default setting is Down. Click Up to search in the opposite 
direction.

Find Next. Starts the search and replace. This button is 
unavailable until you specify text to search for. Continue to click 
Find Next until all occurrences of the text have been found.

Cancel. Closes the Replace dialog box.
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Replace. Replaces the search text with the alternative text. 

Replace All. Performs a global replace of all instances of the 
search text. 

Help. Invokes the Help system.

Viewing and Editing a Routine

You can view and edit any user-written functions and subroutines in 

your project. To view or modify a function or subroutine, select the 

function or subroutine in the display area and do one of the following:

Choose File ➤ Properties… .

Choose Properties… from the shortcut menu.

Click the Properties button on the toolbar.

Double-click the function or subroutine in the display area.

The Routine dialog box appears. You can edit any of the fields and 

options on any of the pages. If you make any changes to a server 

routine, you must save, compile, and test the code before closing the 

Server Routine dialog box. See "Saving Code" on page 8-11 for more 

information.

Copying a Routine

You can copy an existing routine using the DataStage Manager. To 

copy a routine, select it in the display area and do one of the 

following:

Choose File ➤ Copy.

Choose Copy from the shortcut menu.

Click the Copy button on the toolbar.

The routine is copied and a new routine is created under the same 

branch in the project tree. By default, the name of the copy is called 

CopyOfXXX, where XXX is the name of the chosen routine. An edit 

box appears allowing you to rename the copy immediately. The new 

routine must be compiled before it can be used. 

Renaming a Routine

You can rename any user-written routines using the DataStage 

Manager. To rename an item, select it in the display area and do one 

of the following:
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Click the routine again. An edit box appears and you can enter a 
different name or edit the existing one. Save the new name by 
pressing Enter or by clicking outside the edit box.

Choose File ➤ Rename. An edit box appears and you can enter a 
different name or edit the existing one. Save the new name by 
pressing Enter or by clicking outside the edit box.

Choose Rename from the shortcut menu. An edit box appears 
and you can enter a different name or edit the existing one. Save 
the new name by pressing Enter or by clicking outside the edit 
box.

Double-click the routine. The Server Routine dialog box appears 
and you can edit the Routine name field. Click Save, then Close.

Importing External ActiveX (OLE) Functions
To import ActiveX (OLE) functions:

1 From the DataStage Manager, choose Import ➤ External 
Function Definitions… . The Import Transform Functions 
Definitions wizard appears and prompts you to supply the 
pathname of the file containing the transforms to be imported. 
This is normally a DLL file which must have already been installed 
on the server machine.

2 Enter or browse for the pathname, then click Next. The wizard 
queries the specified DLL file to establish what automation classes 
it contains and presents these in a drop-down list.

3 Select an automation class and click Next. The wizard interrogates 
the automation class to obtain details of the suitable functions it 
supports. It then displays these.

4 Select the functions that you want to import and specify the 
Repository category under which the functions will appear (the 
default is Routines ➤ class name). Click Next. The wizard 
displays the details of the proposed import.

5 If you are happy with the details, click Import. DataStage starts to 
generate the required routines and displays a progress bar. On 
completion a summary screen appears.

Click Finish to exit the wizard.

Custom Transforms
Transforms are stored in the Transforms branch of the DataStage 

Repository, where you can create, view or edit them using the 

Transform dialog box. Transforms specify the type of data 

transformed, the type it is transformed into, and the expression that 

performs the transformation.
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The DataStage Expression Editor helps you to enter correct 

expressions when you define custom transforms in the DataStage 

Manager. The Expression Editor can:

Facilitate the entry of expression elements

Complete the names of frequently used variables

Validate variable names and the complete expression

When you are entering expressions, the Expression Editor offers 

choices of operands and operators from context-sensitive shortcut 

menus.

DataStage is supplied with a number of built-in transforms (which you 

cannot edit). You can also define your own custom transforms, which 

are stored in the Repository and can be used by other DataStage jobs.

When using the Expression Editor, the transforms appear under the 

DS Transform… command on the Suggest Operand menu.

Transforms are used in the Transformer stage to convert your data to 

a format you want to use in the final data mart. Each transform 

specifies the BASIC function used to convert the data from one type to 

another. There are a number of built-in transforms supplied with 

DataStage, but if these are not suitable or you want a specific 

transform to act on a specific data element, you can create custom 

transforms in the DataStage Manager. The advantage of creating a 

custom transform over just entering the required expression in the 

Transformer Editor is that, once defined, the transform is available for 

use from anywhere within the project. It can also be easily exported to 

other DataStage projects.

To provide even greater flexibility, you can also define your own 

custom routines and functions from which to build custom 

transforms. There are three ways of doing this:

Entering the code within DataStage (using BASIC functions). See 
"Creating a Routine" on page 8-9.

Creating a reference to an externally cataloged routine. See 
"Creating a Routine" on page 8-9.

Importing external ActiveX (OLE) functions. See "Importing 
External ActiveX (OLE) Functions" on page 8-16.

To create a custom transform:

1 From the DataStage Manager, select the Transforms branch in 
the project tree and do one of the following:

– Choose File ➤ New Transform… .

– Choose New Transform… from the shortcut menu.
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– Click the New button on the toolbar.

The Transform dialog box appears:

This dialog box has two pages:

– General. Displayed by default. Contains general information 
about the transform.

– Details. Allows you to specify source and target data 
elements, the function, and arguments to use.

2 Enter the name of the transform in the Transform name field. 
This name is used to create a leaf under the category branch. The 
name entered here must be unique; as no two transforms can 
have the same name. Also note that the transform should not 
have the same name as an existing BASIC function; if it does, the 
function will be called instead of the transform when you run the 
job.

3 Enter a category name in the Category field. This name is used to 
create a branch under the main Transforms branch. If you do not 
enter a name in this field, the transform is created under the main 
Transforms branch. 

You can create more than one branch level for the category by 

including \ in the name. For example, if you enter Custom\User, 

the following branches are created:

Transforms ➤ Custom ➤ User

In this example, the new transform is created as a leaf under the 

User branch.

4 Optionally enter a brief description of the transform in the Short 
description field. The text entered here is displayed when you 
choose View ➤ Details from the DataStage Manager window.
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5 Optionally enter a detailed description of the transform in the 
Long description field. Once this page is complete, you can 
specify how the data is converted.

6 Click the Details tab. The Details page appears at the front of the 
Transform dialog box:

7 Optionally choose the data element you want as the target data 
element from the Target data element drop-down list box. 
(Using a target and a source data element allows you to apply a 
stricter data typing to your transform. See Chapter 4, "Managing 
Data Elements,"for a description of data elements.)

8 Specify the source arguments for the transform in the Source 
Arguments grid. Enter the name of the argument and optionally 
choose the corresponding data element from the drop-down list.

9 Use the Expression Editor in the Definition field to enter an 
expression which defines how the transform behaves. The 
Expression Editor is described in "The DataStage Expression 
Editor" in Server Job Developer’s Guide. The Suggest Operand 
menu is slightly different when you use the Expression Editor to 
define custom transforms and offers commands that are useful 
when defining transforms.

Suggest Operand Menu

Defining Custom Transforms
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10 Click OK to save the transform and close the Transform dialog 
box. The new transform appears in the project tree under the 
specified branch.

You can then use the new transform from within the Transformer 

Editor.

Note If NLS is enabled, avoid using the built-in Iconv and Oconv 

functions to map data unless you fully understand the 

consequences of your actions.

Components for Parallel Jobs
For many DataStage parallel jobs you may not need to perform any 

programming tasks. You can just choose ready made functions from 

the built-in ones supplied with DataStage. You can also, however, 

define your own functions that can be accessed from the expression 

editor, such functions must be supplied within a UNIX shared library 

or in a standard object file (filename.o) and then referenced by 

defining a parallel routine within the DataStage project which calls it.

Note Functions must be compiled with a C++ compiler (not a C 

compiler).

Parallel jobs also have the ability of executing routines before or after 

an active stage executes. These routines are defined and stored in the 

DataStage Repository, and then called in the Triggers page of the 

particular Transformer stage Properties dialog box (see "Transformer 

Stage Properties" in Parallel Job Developer’s Guide for more details). 

These routines must be supplied in a UNIX shared library or an object 

file, and do not return a value (any values returned are ignored).

Example parallel routines are supplied on the DataStage Installation 

CD in the directory Samples/TrxExternalFunctions.The readme file 

explains how to use the examples on each platform.

Working with Parallel Routines
When you create, view, or edit a parallel routine under the Routines 
branch in the DataStage Manager, the Parallel Routine dialog box 

appears. This dialog box has three pages: General, Creator, and 

Arguments.

There are three buttons in the Parallel Routine dialog box:

Close. Closes the Routine dialog box. If you have any unsaved 
changes, you are prompted to save them.

Save. Saves the routine.
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Help. Starts the Help system.

Naming Parallel Routines

Routine names can be any length. They must begin with an alphabetic 

character and can contain alphanumeric and period characters.

Routine category names can be any length and consist of any 

characters, including spaces.

Creating a Routine

To create a new routine, select the Routines branch in the DataStage 

Manager window and do one of the following:

Choose File ➤ New Parallel Routine… .

Select New Parallel Routine… from the shortcut menu.

The Parallel Routine dialog box appears:

The General page is displayed by default. Enter general information 

about the routine, including:

Routine name. Type the name of the routine. 

Type. Choose External Function if this routine is calling a 
function to include in a transformer expression. Choose External 
Before/After Routine if you are defining a routine to execute as 
a transformer stage before/after routine.
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Category. Type or browse for a category name to store the 
routine in the Repository. If you do not enter a name in this field, 
the routine is created under the main Routines branch.

Object Type. Choose Library or Object. This specifies how the C 
function is linked in the job. If you choose Library, the function is 
not linked into the job and you must ensure that the shared library 
is available at run time. For the Library invocation method the 
routine must be provided in a shared library rather than an object 
file. If you choose Object the function is linked into the job, and 
so does not need to be available at run time. The routine can be 
contained in a shared library or an object file. Note that, if you use 
the Object option, and subsequently update the function, the job 
will need to be recompiled to pick up the update. If you choose the 
Library option, you must enter the pathname of the shared library 
file in the Library path field. If you choose the Object option you 
must enter the pathname of the object file in the Library path 
field.

External subroutine name. The C function that this routine is 
calling (must be the name of a valid routine in a shared library).

Return Type. Choose the type of the value that the function will 
return. The drop-down list offers a choice of native C types. This is 
unavailable for External Before/After Routines, which do not 
return a value. Note that the actual type definitions in function 
implementations may vary depending on platform type. This 
particularly applies to ‘long’ and ‘unsigned long’ C native types. 
These can be defined as ‘long’ and ‘unsigned long’ on Tru64 
platforms, but for all other platforms should be defined as ‘long 
long’ and ‘unsigned long long’ in the actual code. Similarly a 
return type of ‘char’ should be defined as ‘signed char’ in the code 
on all platforms.

Library path. If you have specified the Library option, type or 
browse on the server for the pathname of the shared library that 
contains the function. This is used at compile time to locate the 
function. The pathname should be the exact name of the library or 
object file, and must have the prefix lib and the appropriate suffix, 
e.g., /disk1/userlibs/libMyFuncs.so, /disk1/userlibs/
MyStaticFuncs.o. Suffixes are as follows:

Solaris.so or .a

AIX.so or .a

HPUX.a or .sl

Tru64.so or .a

If you have specified the Object option, enter the pathname of the 

object file. Typically the file will be suffixed with .o. This file must 

exist and be a valid object file for the linker.
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Short description. Type an optional brief description of the 
routine. The text entered in this field is displayed when you 
choose View ➤ Details from the DataStage Manager window or 
print a report. 

Long description. Type an optional detailed description of the 
routine. 

Next, select the Creator page to enter creator information:

The Creator page allows you to specify information about the creator 

and version number of the routine, including:

Vendor. Type the name of the company who created the routine.

Author. Type the name of the person who created the routine.

Version. Type the version number of the routine. This is used 
when the routine is imported. The Version field contains a three-
part version number, for example, 3.1.1. The first part of this 
number is an internal number used to check compatibility 
between the routine and the DataStage system, and cannot be 
changed. The second part of this number represents the release 
number. This number should be incremented when major 
changes are made to the routine definition or the underlying code. 
The new release of the routine supersedes any previous release. 
Any jobs using the routine use the new release. The last part of 
this number marks intermediate releases when a minor change or 
fix has taken place.

Copyright. Type the copyright information.
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The last step is to define routine arguments by selecting the 

Arguments page:

The underlying functions for External Functions can have any number 

of arguments, with each argument name being unique within the 

function definition. The underlying functions for External Before/After 

routines can have up to eight arguments, with each argument name 

being unique within the function definition. In both cases these names 

must conform to C variable name standards. 

Expected arguments for a routine appear in the expression editor, or 

on the Triggers page of the transformer stage Properties dialog box, 

delimited by % characters (for example, %arg1%). When actually 

using a routine, substitute the argument value for this string.

The fields are as follows:

Argument name. Type the name of the argument to be passed to 
the routine.

I/O type. All arguments are input arguments, so the I/O type can 
only be set to I.

Native type. Offers a choice of the C native types in a drop-down 
list. Note that the actual type definitions in function 
implementations may vary depending on platform type. This 
particularly applies to ‘long’ and ‘unsigned long’ C native types. 
These can be defined as ‘long’ and ‘unsigned long’ on Tru64 
platforms, but for all other platforms should be defined as ‘long 
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long’ and ‘unsigned long long’ in the actual code. Similarly a 
return type of ‘char’ should be defined as ‘signed char’ in the code 
on all platforms. 

Description. Type an optional description of the argument.

Components for Mainframe Jobs
There is only one programming building block held in the DataStage 

Repository for mainframe jobs, the external routine. There are three 

types of mainframe routine:

External Routine. Calls a COBOL library function. 

External Source Routine. Calls a user-supplied program that 
allows a DataStage job to access an external data source as the 
job runs on the mainframe. 

External Target Routine. Calls a user-supplied program that 
allows a DataStage job to write to an external data source as the 
job runs on the mainframe. 

The External Routine stage in a DataStage mainframe job enables you 

to call a COBOL subroutine that exists in a library external to 

DataStage in your job. You must first define the routine, details of the 

library, and its input and output arguments. The routine definition is 

stored in the DataStage Repository and can be referenced from any 

number of External Routine stages in any number of mainframe jobs.

The External Source stage in a DataStage mainframe job allows you 

to read data from file types that are not supported in Enterprise MVS 

Edition. After you write an external source program, you create an 

external source routine in the DataStage Repository. The external 

source routine specifies the attributes of the external source program. 

Defining and calling external routines is described in more detail in 

the DataStage Enterprise MVS Edition: Mainframe Job Developer’s 

Guide.

The External Target stage in a DataStage mainframe job allows you to 

write data to file types that are not supported in Enterprise MVS 

Edition. After you write an external target program, you create an 

external target routine in the DataStage Repository. The external 

target routine specifies the attributes of the external target program. 

Defining and calling external routines is described in more detail in 

the DataStage Enterprise MVS Edition: Mainframe Job Developer’s 

Guide.
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Working with Mainframe Routines
In mainframe jobs, routines allow you to incorporate complex 

processing or functionality specific to your environment in the COBOL 

programs generated by DataStage. Some possible uses of an external 

routine could include a call to a statistical analysis program, an 

interface to a database type not supported by Enterprise MVS Edition, 

or a call to an existing COBOL program that performs a specialized 

function. Such a routine can be written in any language that can be 

called by a COBOL program, such as COBOL, Assembler, or C.

When you create, view, or edit a mainframe routine under the 

Routines branch in the DataStage Manager, the Mainframe 
Routine dialog box appears. This dialog box has up to four pages: 

General, Creator, and Arguments, plus a JCL page if you are 

editing an External Source routine.

There are three buttons in the Mainframe Routine dialog box:

Close. Closes the Routine dialog box. If you have any unsaved 
changes, you are prompted to save them.

Save. Saves the routine.

Help. Starts the Help system.

Naming Routines

Routine names can be one to eight characters in length. They must 

begin with an alphabetic character and can contain alphanumeric, $, #, 

and @ characters.

Routine category names can be any length and consist of any 

characters, including spaces.

Creating a Routine

To create a new routine, select the Routines branch in the DataStage 

Manager window and do one of the following:

Choose File ➤ New Mainframe Routine… .

Select New Mainframe Routine… from the shortcut menu. 
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The Mainframe Routine dialog box appears:

The General page is displayed by default. Enter general information 

about the routine, including:

Routine name. Type the name (up to 8 characters) of the function 
or subroutine. In mainframe terms, the routine name is the name 
of an entry point in a member of a load or object library. The 
library member may also contain other entry points with other 
names. The routine name must match the external subroutine 
name if dynamic invocation (the default) is selected, and 
automatically appears in the External subroutine name field.

Type. Choose External Routine, External Source Routine or 
External Target Routine from the drop-down list.

Category. Type or browse for a category name to store the 
routine in the Repository. If you do not enter a name in this field, 
the routine is created under the main Routines branch.

Platform. Select the operating system that the COBOL subroutine 
will run on. (OS/390 is the only platform currently supported.)

External subroutine name. Type the name of the load or object 
library member that contains the subroutine or function entry 
point. If dynamic invocation is selected, then the external subrou-
tine name must match the routine name. If the invocation method 
is static, then the two names need not match.

Library path. Type the pathname of the library that contains the 
routine member.
Manager Guide 8-27



Components for Mainframe Jobs Managing Programming Components
Invocation method. Select the invocation method for the 
routine. Dynamic invocation calls the routine at runtime. Static 
invocation embeds the routine within a program. Dynamic is the 
default.

Short description. Type an optional brief description of the 
routine. The text entered in this field is displayed when you 
choose View ➤ Details from the DataStage Manager window or 
print a report. It also appears in the External Routine stage editor.

Long description. Type an optional detailed description of the 
routine. 

Next, select the Creator page to enter creator information:

The Creator page allows you to specify information about the creator 

and version number of the routine, including:

Vendor. Type the name of the company who created the routine.

Author. Type the name of the person who created the routine.

Version. Type the version number of the routine. This is used 
when the routine is imported. The Version field contains a three-
part version number, for example, 3.1.1. The first part of this 
number is an internal number used to check compatibility 
between the routine and the DataStage system, and cannot be 
changed. The second part of this number represents the release 
number. This number should be incremented when major 
changes are made to the routine definition or the underlying code. 
The new release of the routine supersedes any previous release. 
Any jobs using the routine use the new release. The last part of 
this number marks intermediate releases when a minor change or 
fix has taken place.
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Copyright. Type the copyright information.

The last step is to define routine arguments by selecting the 

Arguments page:

Arguments are optional for mainframe routines. To load arguments 

from an existing table definition, click Load. To create a new 

argument, type directly in the Arguments page grid or, if you need to 

specify COBOL attributes, do one of the following:

Right-click in the column area and select Edit row… from the 
shortcut menu.

Press Ctrl-E.

The Edit Routine Argument Meta Data dialog box appears.

The top pane contains the same fields that appear on the Arguments 
page grid. Enter the information for each argument you want to define 

as follows:

Argument name. Type the name of the argument to be passed to 
the routine.

Level number. Only appears for External Source or Target 
routines.

I/O type. Only appears for External routines. Select the direction 
to pass the data. There are three options:

– Input. A value is passed from the data source to the external 
routine. The value is mapped to an input row element.

– Output. A value is returned from the external routine to the 
stage. The value is mapped to an output column.
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– Both. A value is passed from the data source to the external 
routine and returned from the external routine to the stage. 
The value is mapped to an input row element, and later 
mapped to an output column.

Native type. Select the native data type of the argument value 
from the drop-down list.

Length. Type a number representing the length or precision of 
the argument.

Scale. If the argument is numeric, type a number to define the 
number of decimal places.

Nullable. Only appears for External Source routines. Select Yes, 
No, or Unknown from the drop-down list to specify whether the 
argument can contain null values. The default is No on the Edit 
Routine Argument Meta Data dialog box.

Date Format. Only appears for External Source routines. Choose 
the date format from the drop-down list of available formats.

Description. Type an optional description of the argument.

The bottom pane of the Edit Routine Argument Meta Data dialog 

box displays the COBOL page by default. Use this page to enter any 

required COBOL information for the mainframe argument:

Level Number. Only appears for External Source or Target 
routines. Type in a number giving the COBOL level number in the 
range 02 – 49. The default value is 05.

Occurs. Only appears for External Source routines. Type in a 
number giving the COBOL occurs clause. If the argument defines 
a group, gives the number of elements in the group.

Usage. Select the COBOL usage clause from the drop-down list.

Sign indicator. Select Signed or blank from the drop-down list 
to specify whether the argument can be signed or not. The default 
is blank.

Sign option. If the argument is signed, select the location of the 
sign in the data from the drop-down list.

Sync indicator. Select SYNC or blank from the drop-down list to 
indicate whether this is a COBOL-synchronized clause or not. The 
default is blank.

Redefined Field. Only appears for External Source or Target 
routines. Optionally specify a COBOL REDEFINES clause. This 
allows you to describe data in the same storage area using a 
different data description. 
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Depending on. Only appears for External Source routines. 
Optionally choose a COBOL OCCURS-DEPENDING ON clause 
from the drop-down list.

Storage length. Gives the storage length in bytes of the 
argument as defined. This field is derived and cannot be edited.

Picture. Gives the COBOL PICTURE clause, which is derived from 
the argument definition and cannot be edited.

If you are editing an External Source or Target routine, click the JCL 

tab to go to the JCL page. This allows you to supply any additional 

JCL that your routine might require. Type in the JCL or click Load JCL 

to load it from a file.

Click Save when you are finished to save the routine definition.

Viewing and Editing a Routine

You can view and edit any mainframe routines in your project. To view 

or modify a routine, select it in the display area and do one of the 

following:

Choose File ➤ Properties… .

Choose Properties… from the shortcut menu.

Click the Properties button on the toolbar.

Double-click the routine in the display area.

The Routine dialog box appears. You can edit any of the fields and 

options on any of the pages. 
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Copying a Routine

You can copy an existing routine using the DataStage Manager. To 

copy a routine, select it in the display area and do one of the 

following:

Choose File ➤ Copy.

Choose Copy from the shortcut menu.

Click the Copy button on the toolbar.

The routine is copied and a new routine is created under the same 

branch in the project tree. By default, the name of the copy is called 

CopyOfXXX, where XXX is the name of the chosen routine. An edit 

box appears allowing you to rename the copy immediately. The new 

routine must be compiled before it can be used. 

Renaming a Routine

You can rename any user-written routines using the DataStage 

Manager. To rename an item, select it in the display area and do one 

of the following:

Click the routine again. An edit box appears and you can enter a 
different name or edit the existing one. Save the new name by 
pressing Enter or by clicking outside the edit box.

Choose File ➤ Rename. An edit box appears and you can enter a 
different name or edit the existing one. Save the new name by 
pressing Enter or by clicking outside the edit box.

Choose Rename from the shortcut menu. An edit box appears 
and you can enter a different name or edit the existing one. Save 
the new name by pressing Enter or by clicking outside the edit 
box.

Double-click the routine. The Mainframe Routine dialog box 
appears and you can edit the Routine name field. Click Save, 
then Close.
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Mainframe Machine Profiles

Mainframe Mainframe machine profiles are used when DataStage uploads 

generated code to a mainframe. They are also used by the mainframe 

FTP stage. They provide a reuseable way of defining the mainframe 

DataStage is uploading code or FTPing to. You can create mainframe 

machine profiles and store them in the DataStage repository. You can 

create, copy, rename, move, and delete them in the same way as 

other Repository objects. 

To create a machine profile:

1 From the DataStage Manager, select the Machine Profiles 
branch in the project tree and do one of the following:

– Choose File ➤ New Machine Profile… . 

– Choose New Machine Profile… from the shortcut menu.

– Click the New button on the toolbar.

The Machine Profile dialog box appears:
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This dialog box has three pages:

– General. Displayed by default. Contains general information 
about the machine profile.

– Connection. Allows you to specify connection details for 
connecting to the mainframe, includes IP Host name/address, 
Port, User name, password, and whether the FTP service is 
active or passive.

– Libraries. Allows you to specify the location of a number of 
libraries on the mainframe.

2 Enter the name of the machine profile in the Machine profile 
name field. This name is used to create an icon under the 
category branch. The name entered here must be unique as no 
two machine profiles can have the same name.

3 Enter, or choose, a category name in the Category field. This 
name is used to create a branch under the main Machine 
profiles branch. If you do not enter a name in this field, the profile 
is created under the main Machine profiles branch. 

4 Choose the type of platform for which you are defining a profile 
from the Platform type drop-down list.

5 Optionally enter a brief description of the profile in the Short 
description field. The text entered here is displayed when you 
choose View ➤ Details from the DataStage Manager window or 
print a machine profiles report. 

6 Optionally enter a detailed description of the data in the Long 
description field. This description is displayed only when you 
view the properties of a machine profile.
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7 Click the Connection tab to go to the Connection page.

8 Specify the IP Host name/address for the machine.

9 Specify the Port to connect to. The default port number is 21.

10 Choose an Ftp transfer type of ASCII or Binary.

11 Specify a user name and password for connecting to the machine. 
The password is stored in encrypted form.

12 Click Active or Passive as appropriate for the FTP service.

13 If you are generating process meta data from mainframe jobs for 
MetaStage, specify the target directory and dataset name for the 
XML file which will record the operational meta data.
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14 Click the Libraries tab to go to the Libraries page.

15 In Source library specify the destination for the generated code.

16 In Compile JCL library specify the destination for the compile 
JCL file.

17 In Run JCL library specify the destination for the run JCL file.

18 In Object library specify the location of the object library. This is 
where compiler output is transferred.

19 In DBRM library specify the location of the DBRM library. This is 
where information about a DB2 program is transferred.

20 In Load library specify the location of the Load library. This is 
where executable programs are transferred.

21 In Jobcard accounting information specify the location of 
identification information for the jobcard.

22 Click OK to save the machine profile and to close the Machine 
Profile dialog box. 

Naming Machine Profiles
Machine profile names can be one to eight characters in length. They 

must begin with an alphabetic character and can contain 

alphanumeric, $, #, and @ characters.
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Machine profile category names can be any length and consist of any 

characters, including spaces.
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Managing IMS Databases and

IMS Viewsets

Mainframe DataStage can store information about the structure of IMS Databases 

and IMS Viewsets which can then be used by Mainframe jobs to read 

IMS databases, or use them as lookups. These facilities are available if 

you have Enterprise MVS Edition installed along with the IMS Source 

package.

The information is stored in the following repository objects: 

IMS Databases (DBDs). Each IMS database object describes the 
physical structure of an IMS database.

IMS Viewsets (PSBs/PCBs). Each IMS viewset object describes 
an application’s view of an IMS database.

These types of object are only visible in the Repository tree if you 

have actually imported database or viewset definitions.

Importing IMS Definitions
You can import IMS definitions into the DataStage Repository from 

Data Base Description (DBD) files and Program Specification Block 

(PSB) files. A DBD file defines the physical structure of an IMS 

database. A PSB file defines an application’s view of an IMS database. 

During DBD import, the DataStage table name is created from the 

DBD name and the segment name. Column names are created from 

the DBD field names; however, only those fields that are defined in the 

DBD become columns. Fillers are created where necessary to 

maintain proper field displacement and segment size. If you have a 

definition of the complete IMS segment in the form of a CFD, you can 
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import it to create the completely defined table, including any 

columns that were captured as fillers.

DataStage captures the following clauses from DBD files:

DBD

DATASET

AREA

SEGM

LCHILD

FIELD

XDFIELD

DBDGEN

FINISH

END

The clauses captured from PSB files include:

PCB

SENSEG

SENFLD

PSBGEN

END

You can import IMS definitions from IMS version 5 and above. IMS 

field types are converted to COBOL native data types during capture, 

as described in the table below.

IMS 
Field 
Type

COBOL Native 
Type

COBOL Usage 
Representation

SQL 
Type

X CHARACTER PIC X(n)1

1 (n) is equal to the number of bytes.

Char

P DISPLAY_NUMERIC PIC S9(n)V9(0) COMP-
3

Decimal

C CHARACTER PIC X(n) Char

F BINARY PIC S9(9) COMP Integer

H BINARY PIC S9(4) COMP SmallInt
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Choose Import ➤ IMS Definitions ➤ Data Base Description 
(DBD)…to import a DBD or Import ➤ IMS Definitions ➤ Program 
Specificaton Block (PSB)… to import a PSB. The Import Meta 
Data dialog box appears:

This dialog box has the following fields:

Seen from. Your computer’s network identification name. The 
name is automatically filled in and is read-only.

IMS file description pathname. The pathname where the IMS 
file is located. You can type the pathname or browse for it by 
clicking the … (browse) button. The IMS file must either reside on 
the DataStage client workstation or on a network that is visible 
from the client workstation. The default capture file extension is 
*.dbd for DBD files or *.psb for PSB files.

Platform type. The operating system for the mainframe 
platform. (OS/390 is the only platform currently supported.)

Database names or Viewset names. The databases or 
viewsets defined in the selected DBD or PSB file. This list will 
appear after you enter the IMS pathname. Click Refresh to refresh 
the list if necessary. Select a single item by clicking the database 
or viewset name, or select multiple items by holding down the 
Ctrl key and clicking the names. To select all items, click Select 
all. 

To see a summary description of an item, select it and click 

Details. The Details of dialog box appears, displaying the type, 

description, modification history, and column names.

To category. The name of the category in the Repository where 
the item will be saved. This field is automatically filled in when 
you select a database or viewset name. The default category is 
IMS Database\filename for DBD files or IMS Viewset\filename for 
PSB files. You can change the category by typing a name in the To 
category field.
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When importing from a PSB there is an additional field:

Create associated tables. Select this check box to have 
DataStage create a table in the Repository that corresponds to 
each sensitive segment in the PSB file, and columns in the table 
that correspond to each sensitive field. Only those fields that are 
defined in the PSB become columns; fillers are created where 
necessary to maintain proper field displacement and segment 
size. The associated tables are stored in the Table Definitions 
branch of the project tree. 

If you have a CFD with a definition of the complete IMS segment, 

you can import it to create the completely defined table, including 

any columns that were captured as fillers. You can then change 

the associated table for each segment in the IMS Viewset Editor; 

see "Viewing and Editing IMS Definitions"on page 10-4 for details.

Click OK after selecting the items to import. The data is extracted and 

parsed. If any syntactical or semantic errors are found, the Import 
Error dialog box appears, allowing you to view and fix the errors, skip 

the import of the incorrect item, or stop the import process altogether. 

After the import is complete, IMS definitions are stored in the IMS 
Databases and IMS Viewsets branches of the Manager project tree.

Viewing and Editing IMS Definitions
After you import IMS databases and viewsets, you can view and edit 

their definitions in the Manager. 

Note Editing of IMS definitions is limited to entering descriptions 

and creating mappings between viewset segments and 

their associated tables. If you want to edit columns, you 

must open the associated table definition. Tables associated 

with IMS definitions are stored in the Viewsets folder of 

the Table Definitions branch of the project tree. For 

details on editing table definitions, see "Viewing or 

Modifying a Table Definition" on page 3-39.

To open an IMS database or viewset for editing, select it in the display 

area and do one of the following:

Choose File ➤ Properties.

Choose Properties from the shortcut menu.

Double-click the item in the display area.

Click the Properties button on the toolbar.
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Depending on the type of IMS item you selected, either the IMS 
Database dialog box appears or the IMS Viewset dialog box 

appears. Remember that, if you edit the definitions, this will not affect 

the actual database it describes.

IMS Database Editor
The IMS Database editor allows you to view, edit, or create IMS 

database objects. 

This dialog box is divided into two panes. The left pane displays the 

IMS

database, segments, and datasets in a tree, and the right pane 

displays the

properties of selected items. Depending on the type of item selected, 

the

right pane has up to two pages:

Database. There are two pages for database properties:

– General. Displays the general properties of the database 
including the name, version number, access type, organization, 
category, and short and long descriptions. All of these fields 
are read-only except for the short and long descriptions.

– Hierarchy. Displays the segment hierarchy of the database. 
You can right-click to view the hierarchy in detailed mode. This 
diagram is read-only.

Segment. There are two pages for segment properties:
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– General. Displays the segment name, the parent segment, its 
minimum and maximum size in bytes, and a description. All of 
these fields are read-only except for the description.

– Fields. Displays the fields of the selected segment. The field 
descriptions are read-only.

Dataset. Properties are displayed on one page and include the 
DD names that are used in the JCL to read the file. These names 
are read-only. You can optionally enter a description of the 
dataset.

For a full description of IMS database objects see Mainframe Job 

Developer’s Guide.

IMS Viewset Editor
The IMS Viewset editor allows you to view, edit, or create IMS viewset 

objects. 

This dialog box is divided into two panes. The left pane contains a tree 

structure displaying the IMS viewset (PSB), its views (PCBs), and the 

sensitive segments. The right pane displays the properties of selected 

items. It has up to three pages depending on the type of item selected:

Viewset. Properties are displayed on one page and include the 
PSB name and the category in the Repository where the viewset is 
stored. These fields are read-only. You can optionally enter short 
and long descriptions.

View. There are two pages for view properties:
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– General. Displays the PCB name, DBD name, type, and an 
optional description. If you did not create associated tables 
during import or you want to change which tables are 
associated with PCB segments, click the Segment/Table 
Mapping… button. The Segment/Associated Table 
Mapping dialog box appears:

To create a table association for a segment, select a table in the 

left pane and drag it to the segment in the right pane. The left 

pane displays available tables in the Repository which are of type 

QSAM_SEQ_COMPLEX. The right pane displays the segment 

names and the tables currently associated with them; you can 

right-click to clear one or all of the current table mappings.

Click OK when you are done with the mappings, or click Cancel 
to discard any changes you have made and revert back to the 

original table associations.

– Hierarchy. Displays the PCB segment hierarchy in a read-only 
diagram. You can right-click to view the hierarchy in detailed 
mode.

Sensitive Segment. There are three pages for sensitive segment 
properties:

– General. Displays the segment name and its associated table. 
If you want to change the associated table, click the browse 
button next to the Associate table field to select another 
table.

– Sen Fields. Displays the sensitive fields associated with the 
sensitive segment. These fields are read-only.

– Columns. Displays the columns of the associated table. The 
column descriptions are read-only.
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For a full description of IMS viewset objects see Mainframe Job 

Developer’s Guide.
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The Parallel Engine Configuration File

One of the great strengths of the DataStage Enterprise Edition is that, 

when designing parallel jobs, you don’t have to worry too much about 

the underlying structure of your system, beyond appreciating its 

parallel processing capabilities. If your system changes, is upgraded 

or improved, or if you develop a job on one platform and implement it 

on another, you don’t necessarily have to change your job design.

DataStage learns about the shape and size of the system from the 

configuration file. It organizes the resources needed for a job 

according to what is defined in the configuration file. When your 

system changes, you change the file not the jobs.

This chapter describes how to define configuration files that specify 

what processing, storage, and sorting facilities on your system should 

be used to run a parallel job. You can maintain multiple configuration 

files and read them into the system according to your varying 

processing needs.

When you install DataStage Enterprise Edition the system is 

automatically configured to use the supplied default configuration file. 

This allows you to run parallel jobs right away, but is not optimized for 

your system. Follow the instructions in this chapter to produce 

configuration file specifically for your system.

Configurations Editor
The DataStage Manager provides a configuration file editor to help 

you define configuration files for the parallel engine. To use the editor, 
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choose Tools ➤ Configurations, the Configurations dialog box 

appears:

To define a new file, choose (New) from the Configurations drop-

down list and type into the upper text box. Guidance on the operation 

and format of a configuration file is given in the following sections. 

Click Save to save the file at any point. You are asked to specify a 

configuration name, the config file is then saved under that name with 

an .apt extension.
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You can verify your file at any time by clicking Check. Verification 

information is output in the Check Configuration Output pane at 

the bottom of the dialog box.

To edit an existing configuration file, choose it from the 

Configurations drop-down list. You can delete an existing 

configuration by selecting it and clicking Delete. You are warned if you 

are attempting to delete the last remaining configuration file.

You specify which configuration will be used by setting the 

APT_CONFIG_FILE environment variable. This is set on installation to 

point to the default configuration file, but you can set it on a project 

wide level from the DataStage Administrator (see "Setting 

Environment Variables" in DataStage Administrator Guide) or for 

individual jobs from the Job Properties dialog (see "Environment 

Variables" on page 5-10).

Configuration Considerations
The parallel engine’s view of your system is determined by the 

contents of your current configuration file. Your file defines the 

processing nodes and disk space connected to each node that you 

allocate for use by parallel jobs. When invoking a parallel job, the 

parallel engine first reads your configuration file to determine what 

system resources are allocated to it and then distributes the job to 

those resources. 
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When you modify the system by adding or removing nodes or disks, 

you must modify your configuration file correspondingly. Since the 

parallel engine reads the configuration file every time it runs a parallel 

job, it automatically scales the application to fit the system without 

your having to alter the job code.

Your ability to modify the parallel engine configuration means that 

you can control the parallelization of a parallel job during its 

development cycle. For example, you can first run the job on one 

node, then on two, then on four, and so on. You can measure system 

performance and scalability without altering application code.

Logical Processing Nodes
A parallel engine configuration file defines one or more processing 

nodes on which your parallel job will run. The processing nodes are 

logical rather than physical. The number of processing nodes does 

not necessarily correspond to the number of CPUs in your system. 

Your configuration file can define one processing node for each 

physical node in your system, or multiple processing nodes for each 

physical node. 

Optimizing Parallelism
The degree of parallelism of a parallel job is determined by the 

number of nodes you define when you configure the parallel engine. 

Parallelism should be optimized for your hardware rather than simply 

maximized. Increasing parallelism distributes your work load but it 

also adds to your overhead because the number of processes 

increases. Increased parallelism can actually hurt performance once 

you exceed the capacity of your hardware. Therefore you must weigh 

the gains of added parallelism against the potential losses in 

processing efficiency.

Obviously, the hardware that makes up your system influences the 

degree of parallelism you can establish. 

SMP systems allow you to scale up the number of CPUs and to run 

your parallel application against more memory. In general, an SMP 

system can support multiple logical nodes. Some SMP systems allow 

scalability of disk I/O. "Configuration Options for an SMP" on 

page 11-6 discusses these considerations.

In a cluster or MPP environment, you can use the multiple CPUs and 

their associated memory and disk resources in concert to tackle a 

single computing problem. In general, you have one logical node per 

CPU on an MPP system. "Configuration Options for an MPP System" 

on page 11-9 describes these issues.
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The properties of your system’s hardware also determines 

configuration. For example, applications with large memory 

requirements, such as sort operations, are best assigned to machines 

with a lot of memory. Applications that will access an RDBMS must 

run on its server nodes; and stages using other proprietary software, 

such as SAS, must run on nodes with licenses for that software.

Here are some additional factors that affect the optimal degree of 

parallelism:

CPU-intensive applications, which typically perform multiple CPU-
demanding operations on each record, benefit from the greatest 
possible parallelism, up to the capacity supported by your system.

Parallel jobs with large memory requirements can benefit from 
parallelism if they act on data that has been partitioned and if the 
required memory is also divided among partitions.

Applications that are disk- or I/O-intensive, such as those that 
extract data from and load data into RDBMSs, benefit from 
configurations in which the number of logical nodes equals the 
number of disk spindles being accessed. For example, if a table is 
fragmented 16 ways inside a database or if a data set is spread 
across 16 disk drives, set up a node pool consisting of 16 
processing nodes. 

For some jobs, especially those that are disk-intensive, you must 
sometimes configure your system to prevent the RDBMS from 
having either to redistribute load data or to re-partition the data 
from an extract operation. 

The speed of communication among stages should be optimized 
by your configuration. For example, jobs whose stages exchange 
large amounts of data should be assigned to nodes where stages 
communicate by either shared memory (in an SMP environment) 
or a high-speed link (in an MPP environment). The relative 
placement of jobs whose stages share small amounts of data is 
less important.

For SMPs, you may want to leave some processors for the 
operating system, especially if your application has many stages 
in a job. See "Configuration Options for an SMP" on page 11-6.

In an MPP environment, parallelization can be expected to 
improve the performance of CPU-limited, memory-limited, or disk 
I/O-limited applications. See "Configuration Options for an MPP 
System" on page 11-9.

The most nearly-equal partitioning of data contributes to the best 

overall performance of a job run in parallel. For example, when hash 

partitioning, try to ensure that the resulting partitions are evenly 

populated.This is referred to as minimizing skew. Experience is the 

best teacher. Start with smaller data sets and try different 
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parallelizations while scaling up the data set sizes to collect 

performance statistics.

Configuration Options for an SMP
An SMP contains multiple CPUs which share operating system, disk, 

and I/O resources. Data is transported by means of shared memory. A 

number of factors contribute to the I/O scalability of your SMP. These 

include the number of disk spindles, the presence or absence of RAID, 

the number of I/O controllers, and the speed of the bus connecting the 

I/O system to memory.

SMP systems allow you to scale up the number of CPUs. Increasing 

the number of processors you use may or may not improve job 

performance, however, depending on whether your application is 

CPU-, memory-, or I/O-limited. If, for example, a job is CPU-limited, 

that is, the memory, memory bus, and disk I/O of your hardware 

spend a disproportionate amount of time waiting for the CPU to finish 

its work, it will benefit from being executed in parallel. Running your 

job on more processing units will shorten the waiting time of other 

resources and thereby speed up the overall application.

All SMP systems allow you to increase your parallel job’s memory 

access bandwidth. However, none allow you to increase the memory 

bus capacity beyond that of the hardware configuration. Therefore, 

memory-intensive jobs will also benefit from increased parallelism, 

provided they do not saturate the memory bus capacity of your 

system. If your application is already approaching, or at the memory 

bus limit, increased parallelism will not provide performance 

improvement. 

Some SMP systems allow scalability of disk I/O. In those systems, 

increasing parallelism can increase the overall throughput rate of jobs 

that are disk I/O-limited.
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For example, the following figure shows a data flow containing three 

parallel stages: 

For each stage in this data flow, the parallel engine creates a single 

UNIX process on each logical processing node (provided that stage 

combining is not in effect). On an SMP defined as a single logical 

node, each stage runs sequentially as a single process, and the 

parallel engine executes three processes in total for this job. If the 

SMP has three or more CPUs, the three processes in the job can be 

executed simultaneously by different CPUs. If the SMP has fewer than 

three CPUs, the processes must be scheduled by the operating system 

for execution, and some or all of the processors must execute 

multiple processes, preventing true simultaneous execution.

In order for an SMP to run parallel jobs, you configure the parallel 

engine to recognize the SMP as a single or as multiple logical 

processing node(s), that is:

1 <= M <= N logical processing nodes, where N is the 
number of CPUs on the SMP and M is the number of 
processing nodes on the configuration. (Although M can be 
greater than N when there are more disk spindles than 
there are CPUs.)

As a rule of thumb, it is recommended that you create one processing 

node for every two CPUs in an SMP. You can modify this configuration 

to determine the optimal configuration for your system and 

application during application testing and evaluation. In fact, in most 

cases the scheduling performed by the operating system allows for 

significantly more than one process per processor to be managed 

before performance degradation is seen. The exact number depends 

on the nature of the processes, bus bandwidth, caching effects, and 

other factors.

stage 1

 data flow

stage 2

stage 3
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Depending on the type of processing performed in your jobs (sorting, 

statistical analysis, database I/O), different configurations may be 

preferable. 

For example, on an SMP viewed as a single logical processing node, 

the parallel engine creates a single UNIX process on the processing 

node for each stage in a data flow. The operating system on the SMP 

schedules the processes to assign each process to an individual CPU. 

If the number of processes is less than the number of CPUs, some 

CPUs may be idle. For jobs containing many stages, the number of 

processes may exceed the number of CPUs. If so, the processes will 

be scheduled by the operating system. 

Suppose you want to configure the parallel engine to recognize an 

eight-CPU SMP, for example, as two or more processing nodes. When 

you configure the SMP as two separate processing nodes, the parallel 

engine creates two processes per stage on the SMP. For the three-

stage job shown above, configuring an SMP as more than two parallel 

engine processing nodes creates at least nine UNIX processes, 

although only eight CPUs are available. Process execution must be 

scheduled by the operating system. 

For that reason, configuring the SMP as three or more parallel engine 

processing nodes can conceivably degrade performance as compared 

with that of a one- or two-processing node configuration. This is so 

because each CPU in the SMP shares memory, I/O, and network 

resources with the others. However, this is not necessarily true if 

some stages read from and write to disk or the network; in that case, 

other processes can use the CPU while the I/O-bound processes are 

blocked waiting for operations to finish.

Example Configuration File for an SMP
This section contains a sample configuration file for the four-CPU SMP 

shown below: 

CPU CPU

CPUCPU

SMP 
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The table below lists the processing node names and the file systems 

used by each processing node for both permanent and temporary 

storage in this example system:

The table above also contains a column for node pool definitions. 

Node pools allow you to execute a parallel job or selected stages on 

only the nodes in the pool. See "Node Pools and the Default Node 

Pool" on page 11-22 for more details.

In this example, the parallel engine processing nodes share two file 

systems for permanent storage. The nodes also share a local file 

system (/scratch) for temporary storage. 

Here is the configuration file corresponding to this system. 

"Configuration Files" on page 11-15 discusses the keywords and 

syntax of configuration files.

{
node "node0" {

fastname "node0_byn" /* node name on a fast network */
pools "" "node0" "node0_fddi" /* node pools */ 
resource disk "/orch/s0" {}   
resource disk "/orch/s1" {}  
resource scratchdisk "/scratch" {}  

}
node "node1" {

fastname "node0_byn"
pools "" "node1" "node1_fddi"  
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}

}
}

Configuration Options for an MPP System 
An MPP consists of multiple hosts, where each host runs its own 

image of the operating system and contains its own processors, disk, 

I/O resources, and memory. This is also called a shared-nothing 

environment. Each host in the system is connected to all others by a 

high-speed network. A host is also referred to as a physical node. 

In an MPP environment, you can use the multiple CPUs and their 

associated memory and disk resources in concert. In this 

Node 
name

Node name on 
fast network

Node 
pools

Directory for
permanent 
storage

Directory for
temp storage

node0 node0_byn "", node0, 
node0_fddi

/orch/s0
/orch/s1

/scratch

node1 node0_byn "", node1, 
node1_fddi

/orch/s0
/orch/s1

/scratch
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environment, each CPU has its own dedicated memory, memory bus, 

disk, and disk access.

When configuring an MPP, you specify the physical nodes in your 

system on which the parallel engine will run your parallel jobs. You do 

not have to specify all nodes. 

An Example of a Four-Node MPP System Configuration
The following figure shows a sample MPP system containing four 

physical nodes:

This figure shows a disk-everywhere configuration. Each node is 

connected to both a high-speed switch and an Ethernet. Note that the 

configuration information below for this MPP would be similar for a 

cluster of four SMPs connected by a network.

The following table shows the storage local to each node:

Node name Node name on 
fast network

Node pools Directory for
permanent 
storage

Directory for
temp storage

node0 node0_css "", 
node0, 
node0_cs
s

/orch/s0
/orch/s1

/scratch

node1 node1_css "", node1, 
node1_css

/orch/s0
/orch/s1

/scratch

node2 node2_css "", node2, 
node2_css

/orch/s0
/orch/s1

/scratch

node3 node3_css "", node3, 
node3_css

/orch/s0
/orch/s1

/scratch

high-speed network (switch)

CPU

node0_css

node0

CPU

node1_css

node1

CPU

node2_css

node2

CPU

node3_css

node3

Ethernet
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Note that because this is an MPP system, each node in this 

configuration has its own disks and hence its own /orch/s0, /orch/s1, 

and /scratch. If this were an SMP, the logical nodes would be sharing 

the same directories.

Here is the configuration file for this sample system. "Configuration 

Files" on page 11-15 discusses the keywords and syntax of 

configuration files.

{
node "node0" {

fastname "node0_css" /* node name on a fast network*/
pools "" "node0" "node0_css"  /* node pools */ 
resource disk "/orch/s0" {}
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}  

}
node "node1" {

fastname "node1_css"
pools "" "node1" "node1_css"   
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}

}
node "node2" {

fastname "node2_css"
pools "" "node2" "node2_css"   
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}

}
node "node3" {

fastname "node3_css"
pools "" "node3" "node3_css"   
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}
}

}

Configuration Options for an SMP Cluster
An SMP cluster consists of one or more SMPs and, optionally, single-

CPU nodes connected by a high-speed network. In this case, each 

SMP in the cluster is referred to as a physical node. When you 

configure your system, you can divide a physical node into logical 

nodes. The following figure shows a cluster containing four physical 

nodes, one of which (node1) is an SMP containing two CPUs.
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An Example of an SMP Cluster Configuration
The following configuration file divides physical node1 into logical 

nodes node1 and node1a. Both are connected to the high-speed 

switch by the same fastname; in the configuration file, the same 

fastname is specified for both nodes. "Configuration Files" on 

page 11-15 discusses the keywords and syntax of Orchestrate 

configuration files.

{
node "node0" {

fastname "node0_css"/* node name on a fast network */
pools "" "node0" "node0_css" /* node pools */ 
resource disk "/orch/s0" {}   
resource disk "/orch/s1" {}  
resource scratchdisk "/scratch" {}  

}

node "node1" {
fastname "node1_css"
pools "" "node1" "node1_css"  
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}

}
node "node1a"{

fastname "node1_css"
pools "" "node1" "node1_css"  
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}

}
node "node2" {

fastname "node2_css"
pools "" "node2" "node2_css"  
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}

}

high-speed network (switch)

CPU

node0_css

node0

CPU

node1_css

node1

CPU

node2_css

node2

CPU

node3_css

node3

Ethernet

CPU
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node "node3" {
fastname "node3_css"
pools "" "node3" "node3_css"  
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}

}
}

In this example, consider the disk definitions for /orch/s0. Since node1 

and node1a are logical nodes of the same physical node, they share 

access to that disk. Each of the remaining nodes, node0, node2, and 

node3, has its own /orch/s0 that is not shared. That is, there are four 

distinct disks called /orch/s0. Similarly, /orch/s1 and /scratch are 

shared between node1 and node1a but not the others.

Options for a Cluster with the Conductor Unconnected 
to the High-Speed Switch

The parallel engine starts your parallel job from the Conductor node. 

A cluster may have a node that is not connected to the others by a 

high-speed switch, as in the following figure:

In this example, node4 is the Conductor, which is the node from which 

you need to start your application. By default, the parallel engine 

communicates between nodes using the fastname, which in this 

example refers to the high-speed switch. But because the Conductor 

is not on that switch, it cannot use the fastname to reach the other 

nodes. 

high-speed network (switch)

CPU

node0_css

CPU

node1_css

node1

CPU

node2_css

node2

CPU

node3_css

node3

ethernet

CPU

CPU

node4

node0
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Therefore, to enable the Conductor node to communicate with the 

other nodes, you need to identify each node on the high-speed switch 

by its canonicalhostname and give its Ethernet name as its quoted 

attribute, as in the following configuration file. "Configuration Files" 

on page 11-15 discusses the keywords and syntax of Orchestrate 

configuration files.

{
node "node0" {

fastname "node0_css"  
resource canonicalhostname "node1-eth-1"
pools "" "node0" "node0_css"   
resource disk "/orch/s0" {}   
resource disk "/orch/s1" {}  
resource scratchdisk "/scratch" {}  
}

node "node1" {
fastname "node1_css" 
resource canonicalhostname "node1-eth-1"
pools "" "node1" "node1_css"   
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}
}

node "node2" {
fastname "node2_css" 
resource canonicalhostname "node1-eth-1"
pools "" "node2" "node2_css"   
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}
}

node "node3" {
fastname "node3_css" 
resource canonicalhostname "node1-eth-1"
pools "" "node3" "node3_css"   
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk "/scratch" {}
}

node "node4" {
pools "" "conductor" "node4" “node4_css”

/* not in the default pool */
resource disk "/orch/s0" {} 
resource disk "/orch/s1" {} 
resource scratchdisk “/scratch” {}

}
}

Note Since node4 is not on the high-speed switch and we are 

therefore using it only as the Conductor node, we have left 

it out of the default node pool (""). This causes the parallel 

engine to avoid placing stages on node4. See "Node Pools 

and the Default Node Pool" on page 11-22.
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Diagram of a Cluster Environment
The following figure shows a mixed MPP and SMP cluster 

environment containing six physical nodes. Only the four nodes of the 

left are intended to be allocated for use by the parallel engine.

Configuration Files
This section describes parallel engine configuration files, and their 

uses and syntax. The parallel engine reads a configuration file to 

ascertain what processing and storage resources belong to your 

system. Processing resources include nodes; and storage resources 

include both disks for the permanent storage of data and disks for the 

temporary storage of data (scratch disks). The parallel engine uses 

this information to determine, among other things, how to arrange 

resources for parallel execution.

You must define each processing node on which the parallel engine 

runs jobs and qualify its characteristics; you must do the same for 

each disk that will store data. You can specify additional information 

about nodes and disks on which facilities such as sorting or SAS 

operations will be run, and about the nodes on which to run stages 

that access the following relational data base management systems: 

DB2, INFORMIX, and Oracle. 

You can maintain multiple configuration files and read them into the 

system according to your needs.

Orchestrate provides a sample configuration file, install_dir/etc/

config.apt, where install_dir is the top-level directory of your parallel 

engine installation.

This section contains the following subsections:

CPUCPU CPUCPU
CPU

CPU CPU

CPU

CPU

high-speed network (switch)

parallel engine processing 

CPU
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"The Default Path Name and the APT_CONFIG_FILE" on page 11-16

"Syntax" on page 11-16

"Node Names" on page 11-17

"Options" on page 11-18

"Node Pools and the Default Node Pool" on page 11-22

"Disk and Scratch Disk Pools and Their Defaults" on page 11-23

"Buffer Scratch Disk Pools" on page 11-24

The Default Path Name and the APT_CONFIG_FILE
The default name of the configuration file is config.apt. When you 

run a parallel job, the parallel engine searches for the file config.apt 

as follows:

In the current working directory 

If it is not there, in install_dir/etc, where install_dir is the top-level 
directory of your parallel engine installation ($APT_ORCHHOME)

You can give the configuration file a different name or location or both 

from their defaults. If you do, assign the new path and file name to the 

environment variable APT_CONFIG_FILE. If APT_CONFIG_FILE is 

defined, the parallel engine uses that configuration file rather than 

searching in the default locations. In a production environment, you 

can define multiple configurations and set APT_CONFIG_FILE to 

different path names depending on which configuration you want to 

use.

You can set APT_CONFIG_FILE on a project wide level from the 

DataStage Administrator (see "Setting Environment Variables" in 

DataStage Administrator Guide) or for individual jobs from the Job 

Properties dialog (see "Environment Variables" on page 5-10).

Note Although the parallel engine may have been copied to all 

processing nodes, you need to copy the configuration file 

only to the nodes from which you start parallel engine 

applications (conductor nodes). 

Syntax
Configuration files are text files containing string data that is passed 

to Orchestrate. The general form of a configuration file is as follows:

/* commentary */
{
node "node name" {

<node information>
.
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.

.
 }
.
.
.

}

These are the syntactic characteristics of configuration files:

Braces { } begin and end the file.

The word node begins every node definition. 

The word node is followed by the name of the node enclosed in 
quotation marks. For a detailed discussion of node names, see 
"Node Names" on page 11-17.

Braces { } follow the node name. They enclose the information 
about the node (its options), including an enumeration of each 
disk and scratch disk resource. The legal options are: fastname, 
pools, and resource.

Spaces separate items.

Quotation (") marks surround the attributes you assign to options, 
that is, the names of nodes, disks, scratch disks, and pools.

Comments are demarcated by /* . . . */, in the style of the C 
programming language. They are optional, but are recommended 
where indicated in the examples.

Node Names
Each node you define is followed by its name enclosed in quotation 

marks, for example:

node "orch0"

For a single CPU node or workstation, the node’s name is typically the 

network name of a processing node on a connection such as a high-

speed switch or Ethernet. Issue the following UNIX command to learn 

a node’s network name:

$ uname -n

On an SMP, if you are defining multiple logical nodes corresponding 

to the same physical node, you replace the network name with a 

logical node name. In this case, you need a fast name for each logical 

node. 

If you run an application from a node that is undefined in the 

corresponding configuration file, each user must set the environment 
Manager Guide 11-17



Configuration Files The Parallel Engine Configuration File
variable APT_PM_CONDUCTOR_NODENAME to the fast name of the 

node invoking the parallel job. 

Options
Each node takes options that define the groups to which it belongs 

and the storage resources it employs. Options are as follows: 

fastname 

This option takes as its quoted attribute the name of the node as it is 

referred to on the fastest network in the system, such as an IBM 

switch, FDDI, or BYNET. The fastname is the physical node name that 

stages use to open connections for high volume data transfers. The 

attribute of this option is often the network name. For an SMP, all 

CPUs share a single connection to the network, and this setting is the 

same for all parallel engine processing nodes defined for an SMP. 

Typically, this is the principal node name, as returned by the UNIX 

command uname -n.

pools 

The pools option indicates the names of the pools to which this node 

is assigned. The option’s attribute is the pool name or a space-

separated list of names, each enclosed in quotation marks. For a 

detailed discussion of node pools, see "Node Pools and the Default 

Node Pool" on page 11-22.

Note that the resource disk and resource scratchdisk options can 

also take pools as an option, where it indicates disk or scratch disk 

pools. For a detailed discussion of disk and scratch disk pools, see 

"Disk and Scratch Disk Pools and Their Defaults" on page 11-23.

Node pool names can be dedicated. Reserved node pool names 

include the following names:

Syntax: fastname "name"

Syntax: pools "node_pool_name0" "node_pool_name1" 
...

DB2 See the DB2 resource below and "The 

resource DB2 Option" on page 11-25.

INFORMIX See the INFORMIX resource below and "The 

resource INFORMIX Option" on page 11-26.

ORACLE See the ORACLE resource below and "The 

resource ORACLE option" on page 11-27.
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Reserved disk pool names include the following names:

resource 

The resource_type can be one of the following:

canonicalhostname 

The canonicalhostname resource takes as its quoted attribute the 

ethernet name of a node in a cluster that is unconnected to the 

Conductor node by the high-speed network. If the Conductor node 

cannot reach the unconnected node by a fastname, you must define 

the unconnected node’s canonicalhostname to enable 

communication.

DB2 

This option allows you to specify logical names as the names of DB2 

nodes. For a detailed discussion of configuring DB2, see "The 

resource DB2 Option" on page 11-25.

sas See "The SAS Resources" on page 11-28.

sort See "Sort Configuration" on page 11-29.

See "Buffer Scratch Disk Pools" on 

page 11-24.

export For use by the export stage. 

lookup For use by the lookup stage.

sasdatas
et

See "The SAS Resources" on page 11-28.

sort See "Sort Configuration" on page 11-29.

Syntax: resource resource_type "location" 
[{pools "disk_pool_name"}] 

|
resource resource_type "value"

Syntax: canonicalhostname "ethernet name"

Syntax: resource DB2 "node_number" 
[{pools "instance_owner" ...}]
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disk 

Assign to this option the quoted absolute path name of a directory 

belonging to a file system connected to the node. The node reads 

persistent data from and writes persistent data to this directory. One 

node can have multiple disks. Relative path names are not supported.

Typically, the quoted name is the root directory of a file system, but it 

does not have to be. For example, the quoted name you assign to disk 

can be a subdirectory of the file system.

You can group disks in pools. Indicate the pools to which a disk 

belongs by following its quoted name with a pools definition 

enclosed in braces. For a detailed discussion of disk pools, see "Disk 

and Scratch Disk Pools and Their Defaults" on page 11-23.

INFORMIX 

This option allows you to specify logical names as the names of 

INFORMIX nodes. For a detailed discussion of configuring INFORMIX, 

see "The resource INFORMIX Option" on page 11-26.

ORACLE 

This option allows you to define the nodes on which Oracle runs. For a 

detailed discussion of configuring Oracle, see "The resource ORACLE 

option" on page 11-27.

sasworkdisk 

This option is used to specify the path to your SAS work directory. See 

"The SAS Resources" on page 11-28.

Syntax: resource disk "directory_path" 
[{pools "poolname"...}]

Syntax: resource INFORMIX "coserver_basename" 
[{pools "db_server_name" ... }]

Syntax: resource ORACLE "nodename" 
[{pools "db_server_name" ...}]

Syntax: resource sasworkdisk "directory_path" 
[{pools "poolname"...}]
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scratchdisk 

Assign to this option the quoted absolute path name of a directory on 

a file system where intermediate data will be temporarily stored. All 

Orchestrate users using this configuration must be able to read from 

and write to this directory. Relative path names are unsupported.

The directory should be local to the processing node and reside on a 

different spindle from that of any other disk space. One node can have 

multiple scratch disks.

Assign at least 500 MB of scratch disk space to each defined node. 

Nodes should have roughly equal scratch space. If you perform 

sorting operations, your scratch disk space requirements can be 

considerably greater, depending upon anticipated use. 

We recommend that:

Every logical node in the configuration file that will run sorting 
operations have its own sort disk, where a sort disk is defined as a 
scratch disk available for sorting that resides in either the sort or 
default disk pool. 

Each logical node’s sorting disk be a distinct disk drive. 
Alternatively, if it is shared among multiple sorting nodes, it 
should be striped to ensure better performance. 

For large sorting operations, each node that performs sorting have 
multiple distinct sort disks on distinct drives, or striped.

You can group scratch disks in pools. Indicate the pools to which a 

scratch disk belongs by following its quoted name with a pools 

definition enclosed in braces. For more information on disk pools, see 

"Disk and Scratch Disk Pools and Their Defaults" on page 11-23.

The following sample SMP configuration file defines four logical 

nodes.

{
node "borodin0" {

fastname "borodin"
pools "compute_1" ""
resource disk "/sfiles/node0" {pools ""}
resource scratchdisk "/scratch0" {pools "" "sort"} 

}
node "borodin1" {

fastname "borodin"
pools "compute_1" ""
resource disk "/sfiles/node1" {pools ""}
resource scratchdisk "/scratch1" {pools "" "sort"}

}

Syntax: resource scratchdisk "directory_path" 
[{pools "poolname"...}]
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node "borodin2" {
fastname "borodin"
pools "compute_1" ""
resource disk "/sfiles/node2" {pools ""}
resource scratchdisk "/scratch2" {pools "" "sort"}

}
node "borodin3" 
{

fastname "borodin"
pools "compute_1" ""
resource disk "/sfiles/node3" {pools ""}
resource scratchdisk "/scratch3" {pools "" "sort"}

}
}

In the example shown above:

All nodes are elements of pool compute_1 and the default node 
pool, indicated by "". 

The resource disk of node borodin0 is the directory /sfiles/node0.

The resource disks of nodes borodin1 to borodin3 are the 
directories /sfiles/node1, /sfiles/node2, and /sfiles/node3.

All resource disks are elements of the default disk pool, indicated 
by "".

For sorting, each logical node has its own scratch disk.

All scratch disks are elements of the sort scratch disk pool and the 
default scratch disk pool which is indicated by "".

Node Pools and the Default Node Pool
Node pools allow association of processing nodes based on their 

characteristics. For example, certain nodes can have large amounts of 

physical memory, and you can designate them as compute nodes. 

Others can connect directly to a mainframe or some form of high-

speed I/O. These nodes can be grouped into an I/O node pool. 

The option pools is followed by the quoted names of the node pools 

to which the node belongs. A node can be assigned to multiple pools, 

as in the following example, where node1 is assigned to the default 

pool ("") as well as the pools node1, node1_css, and pool4.

node "node1" 
{
fastname "node1_css"
pools "" "node1" "node1_css" "pool4" 
resource disk "/orch/s0" {} 
resource scratchdisk "/scratch" {}
}

A node belongs to the default pool unless you explicitly specify a 

pools list for it, and omit the default pool name ("") from the list.
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Once you have defined a node pool, you can constrain a parallel stage 

or parallel job to run only on that pool, that is, only on the processing 

nodes belonging to it. If you constrain both an stage and a job, the 

stage runs only on the nodes that appear in both pools. 

Nodes or resources that name a pool declare their membership in that 

pool.

We suggest that when you initially configure your system you place 

all nodes in pools that are named after the node’s name and fast 

name. Additionally include the default node pool in this pool, as in the 

following example:

node "n1" 
{
fastname "nfast"
pools "" "n1" "nfast"
}

By default, the parallel engine executes a parallel stage on all nodes 

defined in the default node pool. You can constrain the processing 

nodes used by the parallel engine either by removing node 

descriptions from the configuration file or by constraining a job or 

stage to a particular node pool. 

Disk and Scratch Disk Pools and Their Defaults
When you define a processing node, you can specify the options 

resource disk and resource scratchdisk. They indicate the directories 

of file systems available to the node. You can also group disks and 

scratch disks in pools. Pools reserve storage for a particular use, such 

as holding very large data sets. The syntax for setting up disk and 

scratch disk pools is as follows:

resource disk "disk_name" 
{pools "disk_pool0" ... "disk_poolN"}

resource scratchdisk "s_disk_name" 
{pools "s_pool0" ... "s_poolN"}

where: 

disk_name and s_disk_name are the names of directories.

disk_pool... and s_pool... are the names of disk and scratch 
disk pools, respectively.

Pools defined by disk and scratchdisk are not combined; therefore, 

two pools that have the same name and belong to both resource disk 

and resource scratchdisk define two separate pools. 

A disk that does not specify a pool is assigned to the default pool. The 

default pool may also be identified by "" by and { } (the empty pool 

list). For example, the following code configures the disks for node1:
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node "node1" {
resource disk "/orch/s0" {pools "" "pool1"} 
resource disk "/orch/s1" {pools "" "pool1"} 
resource disk "/orch/s2" { } /* empty pool list */
resource disk "/orch/s3" {pools "pool2"} 
resource scratchdisk "/scratch"{pools "" "scratch_pool1"}

}

In this example:

The first two disks are assigned to the default pool. 

The first two disks are assigned to pool1. 

The third disk is also assigned to the default pool, indicated by { }.

The fourth disk is assigned to pool2 and is not assigned to the 
default pool. 

The scratch disk is assigned to the default scratch disk pool and to 
scratch_pool1.

Application programmers make use of pools based on their 

knowledge of both their system and their application.

Buffer Scratch Disk Pools 
Under certain circumstances, the parallel engine uses both memory 

and disk storage to buffer virtual data set records.The amount of 

memory defaults to 3 MB per buffer per processing node. The amount 

of disk space for each processing node defaults to the amount of 

available disk space specified in the default scratchdisk setting for 

the node. 

The parallel engine uses the default scratch disk for temporary storage 

other than buffering. If you define a buffer scratch disk pool for a 

node in the configuration file, the parallel engine uses that scratch 

disk pool rather than the default scratch disk for buffering, and all 

other scratch disk pools defined are used for temporary storage other 

than buffering.

Here is an example configuration file that defines a buffer scratch disk 

pool:

{
node node1 {

fastname "node1_css"  
pools "" "node1" "node1_css"  
resource disk "/orch/s0" {}
resource scratchdisk "/scratch0" {pools "buffer"}
resource scratchdisk "/scratch1" {}
}

node node2 {
fastname "node2_css"  
pools "" "node2" "node2_css"  
11-24 Manager Guide



The Parallel Engine Configuration File The resource DB2 Option
resource disk "/orch/s0" {}
resource scratchdisk "/scratch0" {pools "buffer"}
resource scratchdisk "/scratch1" {}
}

}

In this example, each processing node has a single scratch disk 

resource in the buffer pool, so buffering will use /scratch0 but not /

scratch1. However, if /scratch0 were not in the buffer pool, both /

scratch0 and /scratch1 would be used because both would then be in 

the default pool. 

The resource DB2 Option
The DB2 file db2nodes.cfg contains information for translating DB2 

node numbers to node names. You must define the node names 

specified in db2nodes.cfg in your configuration file, if you want the 

parallel engine to communicate with DB2. You can designate each 

node specified in db2nodes.cfg in one of the following ways:

By assigning to node its quoted network name, as returned by the 
UNIX operating system command uname -n; for example, node 
"node4".

By assigning to node a logical name, for example "DB2Node3". If 
you do so, you must specify the option resource DB2 followed by 
the node number assigned to the node in db2nodes.cfg. 

The resource DB2 option can also take the pools option. You assign to 

it the user name of the owner of each DB2 instance configured to run 

on each node. DB2 uses the instance to determine the location of 

db2nodes.cfg.

Here is a sample DB2 configuration:

{
node "Db2Node0" {

/* other configuration parameters for node0 */
resource DB2 "0" {pools "Mary" "Tom"}

}
node "Db2Node1" {

/* other configuration parameters for node1 */
resource DB2 "1" {pools "Mary" "Tom"}

}
node "Db2Node2" {

/* other configuration parameters for node2 */
resource DB2 "2" {pools "Mary" "Tom" "Bill"}

}

node "Db2Node3" {
/* other configuration parameters for node3 */
resource DB2 "3" {pools "Mary" "Bill"}
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}

/* other nodes used by the parallel engine*/

}

In the example above:

The resource DB2 option takes the DB2 node number 
corresponding to the processing node. 

All nodes are used with the DB2 instance Mary.

Nodes 0, 1, and 2 are used with the DB2 instance Tom.

Nodes 2 and 3 are used with the DB2 instance Bill. 

If you now specify a DB2 instance of Mary in your Orchestrate 

application, the location of db2nodes.cfg is ~Mary/sqllib/

db2nodes.cfg.

The resource INFORMIX Option
To communicate with INFORMIX, the parallel engine must be 

configured to run on all processing nodes functioning as INFORMIX 

coservers. This means that the Orchestrate configuration must include 

a node definition for the coserver nodes. The list of INFORMIX 

coservers is contained in the file pointed to by the environment 

variable $INFORMIXSQLHOSTS or in the file $INFORMIXDIR/etc/

sqlhosts. 

There are two methods for specifying the INFORMIX coserver names 

in the Orchestrate configuration file. 

1 Your Orchestrate configuration file can contain a description of 
each node, supplying the node name (not a synonym) as the 
quoted name of the node. Typically, the node name is the network 
name of a processing node as returned by the UNIX command 
uname -n.

Here is a sample configuration file for a system containing 

INFORMIX coserver nodes node0, node1, node2, and node3:
{

node "node0" {
/* configuration parameters for node0 */
}
node "node1" {
/* configuration parameters for node1 */
}
node "node2" {
/* configuration parameters for node2 */
}
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node "node3" {
/* configuration parameters for node3 */
}

/* other nodes used by the parallel engine*/
}

2 You can supply a logical rather than a real network name as the 
quoted name of node. If you do so, you must specify the resource 
INFORMIX option followed by the name of the corresponding 
INFORMIX coserver.

Here is a sample INFORMIX configuration: 
{

node "IFXNode0" {
/* other configuration parameters for node0 */
resource INFORMIX "node0" {pools "server"}
}
node "IFXNode1" {
/* other configuration parameters for node1 */
resource INFORMIX "node1" {pools "server"}
}
node "IFXNode2" {
/* other configuration parameters for node2 */
resource INFORMIX "node2" {pools "server"}
}
node "IFXNode3" {
/* other configuration parameters for node3 */
resource INFORMIX "node3" {pools "server"}
}

/* other nodes used by the parallel engine*/
}

When you specify resource INFORMIX, you must also specify the 

pools parameter. It indicates the base name of the coserver groups for 

each INFORMIX server. These names must correspond to the coserver 

group base name using the shared-memory protocol. They also 

typically correspond to the DBSERVERNAME setting in the 

ONCONFIG file. For example, coservers in the group server are 

typically named server.1, server.2, and so on.

The resource ORACLE option
By default, the parallel engine executes Oracle stages on all 

processing nodes belonging to the default node pool, which typically 

corresponds to all defined nodes. 

You can optionally specify the resource ORACLE option to define the 

nodes on which you want to run the Oracle stages. If you do, 

Orchestrate runs the Oracle stages only on the processing nodes for 
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which resource ORACLE is defined. You can additionally specify the 

pools parameter of resource ORACLE to define resource pools, which 

are groupings of Oracle nodes. 

Here is a sample Oracle configuration: 

{
node "node0" {

/* other configuration parameters for node0 */
resource ORACLE "node0" {pools "group1" "group2" 

"group3"}
}
node "node1" {

/* other configuration parameters for node1 */
resource ORACLE "node1" {pools "group1" "group2"}

}
node "node2" {

/* other configuration parameters for node2 */
resource ORACLE "node2" {pools "group1" "group3"}

}
node "node3" {

/* other configuration parameters for node3 */
resource ORACLE "node3" {pools "group1" "group2" "group3"}

}

/* any other nodes used by the parallel engine*/
}

In the example above, Oracle runs on node0 to node3. 

node0–node3 are used with node pool group1.

node0, node1, and node3 are used with node pool group2.

node0, node2, and node3 are used with node pool group3.

The SAS Resources

Adding SAS Information to your Configuration File
To configure your system to use the SAS stage, you need to specify 

the following information in your configuration file: 

The location of the SAS executable, if it is not in your PATH;

An SAS work disk directory, one for each parallel engine node;

Optionally, a disk pool specifically for parallel SAS data sets, 
called sasdataset.

The resource names sas and sasworkdisk and the disk pool name 

sasdataset are all reserved words. Here is an example of each of these 

declarations:
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resource sas "/usr/sas612/" { } 
resource sasworkdisk "/usr/sas/work/" { }
resource disk "/data/sas/" {pools "" "sasdataset"}

While the disks designated as sasworkdisk need not be a RAID 

configuration, best performance will result if each parallel engine 

logical node has its own reserved disk that is not shared with other 

parallel engine nodes during sorting and merging. The total size of 

this space for all nodes should optimally be equal to the total work 

space you use when running SAS sequentially (or a bit more, to allow 

for uneven distribution of data across partitions).

The number of disks in the sasdataset disk pool is the degree of 

parallelism of parallel SAS data sets. Thus if you have 24 processing 

nodes, each with its associated disk in the sasdataset disk pool, 

parallel SAS data sets will be partitioned among all 24 disks, even if 

the operation preceding the disk write is, for example, only four-way 

parallel.

Example
Here a single node, grappelli0, is defined, along with its fast name. 

Also defined are the path to a SAS executable, a SAS work disk 

(corresponding to the SAS work directory), and two disk resources, 

one for parallel SAS data sets and one for non-SAS file sets. 

node "grappelli0" 
{
fastname "grappelli"
pools "" "a"
resource sas "/usr/sas612" { }
resource scratchdisk "/scratch" { }
resource sasworkdisk "/scratch" { }
disk "/data/pds_files/node0" { pools "" "export" }
disk "/data/pds_files/sas" { pools "" "sasdataset" }
}

Sort Configuration
You may want to define a sort scratch disk pool to assign scratch disk 

space explicitly for the storage of temporary files created by the Sort 

stage. In addition, if only a subset of the nodes in your configuration 

have sort scratch disks defined, we recommend that you define a sort 

node pool, to specify the nodes on which the sort stage should run. 

Nodes assigned to the sort node pool should be those that have 

scratch disk space assigned to the sort scratch disk pool. 

The parallel engine then runs sort only on the nodes in the sort node 

pool, if it is defined, and otherwise uses the default node pool. The 
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Sort stage stores temporary files only on the scratch disks included in 

the sort scratch disk pool, if any are defined, and otherwise uses the 

default scratch disk pool.

When the parallel engine runs, it determines the locations of 

temporary files by:

1 Searching the parallel engine configuration for any scratch disk 
resources in the sort resource pool on the nodes sort will run on. If 
found, the scratch disks are used as a location for temporary 
storage by sort.

2 If no scratch disk resources are found that belong to the disk pool 
sort, the system determines whether any scratch disk resources 
belong to the default scratch disk pool on the nodes sort will run 
on. If so, the scratch disks belonging to the default pool are used 
by tsort for temporary storage. 

3 If no scratch disk resources are found that belong to either sort or 
the default scratch disk pool, the parallel engine issues a warning 
message and runs sort using the directory indicated by the 
TMPDIR environment variable or /tmp for temporary storage.

Allocation of Resources
The allocation of resources for a given stage, particularly node and 

disk allocation, is done in a multi-phase process. Constraints on which 

nodes and disk resources are used are taken from the parallel engine 

arguments, if any, and matched against any pools defined in the 

configuration file. Additional constraints may be imposed by, for 

example, an explicit requirement for the same degree of parallelism 

as the previous stage. After all relevant constraints have been applied, 

the stage allocates resources, including instantiation of Player 

processes on the nodes that are still available and allocation of disks 

to be used for temporary and permanent storage of data. 

Selective Configuration with Startup Scripts
As part of running an application, the parallel engine creates a remote 

shell on all parallel engine processing nodes on which the application 

will be executed. After the parallel engine creates the remote shell, it 

copies the environment from the system on which the application was 

invoked to each remote shell. This means that all remote shells have 

the same configuration by default.
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However, you can override the default and set configuration 

parameters for individual processing nodes. To do so, you create a 

parallel engine startup script. If a startup script exists, the parallel 

engine runs it on all remote shells before it runs your application.

When you invoke an application, the parallel engine looks for the 

name and location of a startup script as follows:

1 It uses the value of the APT_STARTUP_SCRIPT environment 
variable. 

2 It searches the current working directory for a file named 
startup.apt.

3 Searches for the file install_dir/etc/startup.apt on the 
system that invoked the parallel engine application, where 
install_dir is the top-level directory of the installation.

4 If the script is not found, it does not execute a startup script.

Here is a template you can use with Korn shell to write your own 

startup script.

#!/bin/ksh  # specify Korn shell 
# your shell commands go here

shift 2 # required for all shells
exec $* # required for all shells

You must include the last two lines of the shell script. This prevents 

your application from running if your shell script detects an error.

The following startup script for the Bourne shell prints the node name, 

time, and date for all processing nodes before your application is run:

#!/bin/sh # specify Bourne shell 

echo ‘hostname‘ ‘date‘
shift 2
exec $*

A single script can perform node-specific initialization by means of a 

case statement. In the following example, the system has two nodes 

named node1 and node2. This script performs initialization based on 

which node it is running on. 

#!/bin/sh # use Bourne shell

# Example APT startup script.
case `hostname` in

node1)
# perform node1 init
node-specific directives
;;

node2)
# perform node2 init
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node-specific directives
;;

esac
shift 2
exec $*

The parallel engine provides the APT_NO_STARTUP_SCRIPT 
environment variable to prevent the parallel engine from running the 

startup script. By default, the parallel engine executes the startup 

script. If the variable is set, the parallel engine ignores the startup 

script. This can be useful for debugging a startup script.

Hints and Tips
The configuration file tells the engine how to exploit the underlying 

computer system. For a given system there is not necessarily one 

ideal configuration file because of the high variability between the 

way different jobs work. So where do you start? 

Let's assume you are running on a shared-memory multi-processor 

system, i.e., an SMP box (these are the most common platforms 

today). Let's assume these properties. You can adjust the illustration 

below to match your precise situation: 

computer's hostname "fastone" 

6 CPUs 

4 separate file systems on 4 drives named /fs0 /fs1 /fs2 /fs3 

The configuration file to use as a starting point would look like the one 

below. Note the way the disk/scratchdisk resources are handled. 

That's the real trick here. 

{ /* config file allows C-style comments. */
/* 

config files look like they have flexible syntax. 
They do NOT. Keep all the sub-items of the individual 
node specifications in the order shown here. 

*/
node "n0" {
pools "" /* on an SMP node pools aren't used often. */
fastname "fastone" 
resource scratchdisk "/fs0/ds/scratch" {} /*start with fs0*/
resource scratchdisk "/fs1/ds/scratch" {}
resource scratchdisk "/fs2/ds/scratch" {}
resource scratchdisk "/fs3/ds/scratch" {}
resource disk "/fs0/ds/disk" {} /* start with fs0 */
resource disk "/fs1/ds/disk" {}
resource disk "/fs2/ds/disk" {}
resource disk "/fs3/ds/disk" {}
}
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node "n1" {pools "" 
fastname "fastone"
resource scratchdisk "/fs1/ds/scratch" {} /*start with fs1*/
resource scratchdisk "/fs2/ds/scratch" {}
resource scratchdisk "/fs3/ds/scratch" {}
resource scratchdisk "/fs0/ds/scratch" {} 
resource disk "/fs1/ds/disk" {} /* start with fs1 */
resource disk "/fs2/ds/disk" {}
resource disk "/fs3/ds/disk" {}
resource disk "/fs0/ds/disk" {} 
}
node "n2" {
pools "" 
fastname "fastone"
resource scratchdisk "/fs2/ds/scratch" {} /*start with fs2*/
resource scratchdisk "/fs3/ds/scratch" {}
resource scratchdisk "/fs0/ds/scratch" {} 
resource scratchdisk "/fs1/ds/scratch" {} 
resource disk "/fs2/ds/disk" {} /* start with fs2 */
resource disk "/fs3/ds/disk" {}
resource disk "/fs0/ds/disk" {} 
resource disk "/fs1/ds/disk" {} 
}
node "n3" {
pools "" 
fastname "fastone"
resource scratchdisk "/fs3/ds/scratch" {} /*start with fs3*/
resource scratchdisk "/fs0/ds/scratch" {} 
resource scratchdisk "/fs1/ds/scratch" {} 
resource scratchdisk "/fs2/ds/scratch" {} 
resource disk "/fs3/ds/disk" {} /* start with fs3 */
resource disk "/fs0/ds/disk" {} 
resource disk "/fs1/ds/disk" {} 
resource disk "/fs2/ds/disk" {} 
}
node "n4" {
pools "" 
fastname "fastone"
/* 
* Ok, now what. We rotated through starting with a
* different disk, but we have a basic problem here which is
* that there are more CPUs than disks. So what do we do
* now? The answer: something that is not perfect. We're
* going to repeat the sequence. You could shuffle
* differently i.e., use /fs0 /fs2 /fs1 /fs3 as an order.
* I'm not sure it will matter all that much. 
*/
resource scratchdisk "/fs0/ds/scratch" {} /*start with fs0

again*/
resource scratchdisk "/fs1/ds/scratch" {} 
resource scratchdisk "/fs2/ds/scratch" {} 
resource scratchdisk "/fs3/ds/scratch" {}
resource disk "/fs0/ds/disk" {} /* start with fs0 again */
resource disk "/fs1/ds/disk" {} 
resource disk "/fs2/ds/disk" {} 
resource disk "/fs3/ds/disk" {}
}
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node "n5" {
pools "" 
fastname "fastone"
resource scratchdisk "/fs1/ds/scratch" {} /*start with fs1*/
resource scratchdisk "/fs2/ds/scratch" {} 
resource scratchdisk "/fs3/ds/scratch" {}
resource scratchdisk "/fs0/ds/scratch" {} 
resource disk "/fs1/ds/disk" {} /* start with fs1 */
resource disk "/fs2/ds/disk" {} 
resource disk "/fs3/ds/disk" {}
resource disk "/fs0/ds/disk" {} 
}

} /* end of whole config */

The above config file pattern could be called "give everyone all the 

disk". This configuration style works well when the flow is complex 

enough that you can't really figure out and precisely plan for good I/O 

utilization. Giving every partition (node) access to all the I/O resources 

can cause contention, but the parallel engine tends to use fairly large 

blocks for I/O so the contention isn't as much of a problem as you 

might think. This configuration style works for any number of CPUs 

and any number of disks since it doesn't require any particular 

correspondence between them. The heuristic principle at work here is 

this "When it's too difficult to figure out precisely, at least go for 

achieving balance." 

The alternative to the above configuration style is more careful 

planning of the I/O behavior so as to reduce contention. You can 

imagine this could be hard given our hypothetical 6-way SMP with 4 

disks because setting up the obvious one-to-one correspondence 

doesn't work. Doubling up some nodes on the same disk is unlikely to 

be good for overall performance since we create a hotspot. We could 

give every CPU 2 disks and rotate around, but that would be little 

different than our above strategy. So, let's imagine a less constrained 

environment and give ourselves 2 more disks /fs4 and /fs5. Now a 

config file might look like this: 

{ 
node "n0" {
pools "" 
fastname "fastone"
resource scratchdisk "/fs0/ds/scratch" {} 
resource disk "/fs0/ds/disk" {} 
}
node "n1" {
pools "" 
fastname "fastone"
resource scratchdisk "/fs1/ds/scratch" {} 
resource disk "/fs1/ds/disk" {} 
}
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node "n2" {
pools "" 
fastname "fastone"
resource scratchdisk "/fs2/ds/scratch" {}
resource disk "/fs2/ds/disk" {}
}
node "n3" {
pools "" 
fastname "fastone"
resource scratchdisk "/fs3/ds/scratch" {} 
resource disk "/fs3/ds/disk" {} 
}
node "n4" {
pools "" 
fastname "fastone"
resource scratchdisk "/fs4/ds/scratch" {} 
resource disk "/fs4/ds/disk" {} 
}
node "n5" {
pools "" 
fastname "fastone"
resource scratchdisk "/fs5/ds/scratch" {} 
resource disk "/fs5/ds/disk" {} 
}
} /* end of whole config */

This is simplest, but realize that no single player (stage/operator 

instance) on any one partition can go faster than the single disk it has 

access to. 

You could combine strategies by adding in a node pool where disks 

have this one-to-one association with nodes. These nodes would then 

not be in the default node pool, but a special one that you would 

assign stages/operators to specifically. 

Other configuration file hints: 

Consider avoiding the disk/disks that your input files reside on. 
Often those disks will be hotspots until the input phase is over. If 
the job is large and complex this is less of an issue since the input 
part is proportionally less of the total work. 

Ensure that the different file systems mentioned as the disk and 
scratchdisk resources hit disjoint sets of spindles even if they're 
located on a RAID system. 

Know what is real and what is NFS: Real disks are directly 
attached, or are reachable over a SAN (storage-area network - 
dedicated, just for storage, low-level protocols). 

– Never use NFS file systems for scratchdisk resources. 

– If you use NFS file system space for disk resources, then you 
need to know what you are doing. For example, your final 
result files may need to be written out onto the NFS disk area, 
but that doesn't mean the intermediate data sets created and 
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used temporarily in a multi-job sequence should use this NFS 
disk area. Better to setup a "final" disk pool, and constrain the 
result sequential file or data set to reside there, but let 
intermediate storage go to local or SAN resources, not NFS. 

Know what data points are striped (RAID) and which are not. 
Where possible, avoid striping across data points that are already 
striped at the spindle level. 
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Usage Analysis

The Usage Analysis tool allows you to check where items in the 

DataStage Repository are used. Usage Analysis gives you a list of the 

items that use a particular source item. You can in turn use the tool to 

examine items on the list, and see where they are used.

For example, you might want to discover how changing a particular 

item would affect your DataStage project as a whole. The Usage 

Analysis tool allows you to select the item in the DataStage Manager 

and view all the instances where it is used in the current project.

You can also get the Usage Analysis tool to warn you when you are 

about to delete or change an item that is used elsewhere in the 

project.

Using the Usage Analysis Tool
To use the Usage Analysis tool:

1 Select the item (or items) whose use you want to analyze in the 
right pane of the DataStage Manager window.

2 Start the Usage Analysis tool by doing one of the following:

– Click the Usage Analysis button in the DataStage Manager 
toolbar.

– Choose Tools ➤ Usage Analysis.

– Choose Usage Analysis from the shortcut menu.
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The DataStage Usage Analysis window appears with details of 

where the source item or items are used:

3 If you want usage analysis details for any of the target items that 
use the source item, click on one of them so it is highlighted, then 
do one of the following:

– Choose File ➤ Usage Analysis from the menu bar in the 
DataStage Usage Analysis window.

– Click the Usage Analysis button in the DataStage Usage 
Analysis window toolbar.

– Choose Usage Analysis from the shortcut menu.

The details appear in the window replacing the original list. You 

can use the back and forward buttons on the DataStage Usage 

Analysis window toolbar to move to and from the current list and 

previous lists.

The DataStage Usage Analysis Window
The DataStage Usage Analysis window displays a report showing all 

the items that use the source item. It is a snapshot of the relationships 

at the time the usage analysis request was made. If a report is 

refreshed after a source item has been deleted or renamed, then the 

nonexistent source item name is prefixed with an * (asterisk).

The report gives the following information about each of the items in 

the list:

Relationship. The name of the relationship from the source to 
the target.

Type. The type of the target item.

Name. The name of the target item.
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Category. The category where the item is held in the DataStage 
Repository. If the item is not visible in the DataStage Manager, for 
example, an output column, Category gives the category 
containing the Job. If the job is not contained in a category, this is 
blank.

Source. The name of the source item.

You can sort the information in the list on any of the columns by 

clicking the column title.

The Sources drop-down list shows all the source items used in 

generating the report. This is useful where you have requested a 

usage analysis report on multiple items. If you select All Sources 

from the list, the report shows all the target items for all the source 

items. Alternatively, select a particular source item from the list and 

the report shows only the target items for the chosen source item.

If the source item is a table definition, or if a particular table definition 

from a group of source items has been selected from the Sources 

drop-down list, the Select Columns button is enabled in the toolbar. 

Click this button to display a dialog box which allows you to filter the 

table columns that the report shows the usage of (the Select 
Columns command is also available from the shortcut menu and the 

View menu). For example, if the table definition contained 30 

columns, but you were only interested in 10 of these, you can use the 

Select Columns feature to select those 10 columns. The Usage 

Analysis tool then only shows details for those 10 columns.

Use the arrow keys to move columns back and forth between the 

Available columns list and the Selected columns list. The single 

arrow buttons move highlighted columns, the double arrow buttons 

move all items. By default all columns are selected for loading. Click 

Find… to open a dialog box which lets you search for a particular 

column. Click OK when you are happy with your selection. This closes 
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the Select Columns dialog box and loads the selected columns into 

the stage.

For mainframe stages and certain parallel stages where the column 

definitions derive from a CFD file, the Select Columns dialog box 

may also contain a Create Filler check box. This happens when the 

table definition the columns are being loaded from represents a fixed-

width table. Select this to cause sequences of unselected columns to 

be collapsed into filler items. Filler columns are sized appropriately, 

their datatype set to character, and name set to FILLER_XX_YY where 

XX is the start offset and YY the end offset. Using fillers results in a 

smaller set of columns, saving space and processing time and making 

the column set easier to understand.

If you are importing column definitions that have been derived from a 

CFD file into server or parallel job stages, you are warned if any of the 

selected columns redefine other selected columns. You can choose to 

carry on with the load or go back and select columns again.

The DataStage Usage Analysis window also contains a menu bar and 

a toolbar.

Menu Bar

The DataStage Usage Analysis window has a menu bar which 

contains the following menus:

File. Contains the following commands:

– Usage Analysis. Requests a further usage analysis report on 
the item selected in the current report.

– Edit. Allows you to edit the item currently selected in the 
report. Depending on the type of object selected, this either 
starts the relevant DataStage Manager editor, or starts the 
DataStage Designer.

– View HTML. Exports the report to an HTML file and opens a 
browser to view it with. From the browser you can save the 
HTML file or print it.

– Save. This command allows you to save details of the current 
report in a file. A Save As dialog box allows you to select a 
location for the file. The file has a .DSU suffix.

– Load. Allows you to load previously saved reports. An Open 
dialog box allows you to specify the location to load from and 
lists available files with a .DSU suffix.

– Exit. Closes the usage analysis report window.

View. Contains the following commands:

– Back. View the previous usage analysis report.
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– Forward. View the more recent usage analysis report.

– Locate in Manager. This returns to the DataStage Manager, 
with the item currently selected in the report list highlighted in 
the Manager tree.

– Select Columns. If the source item selected is a table 
definition, this command allows you to filter the table columns 
of which the report shows the usage.

– Condense Jobs and Shared Containers. Choose this 
command to view each job or shared container only once in 
the report. Otherwise it may appear several times, reflecting 
where, for example, a column from a source table definition 
may be reported as being used in several links of several 
stages of the same job.

– Refresh. Refreshes the report window so that it shows up to 
date details of objects as held in the DataStage Repository.

Help. Displays the DataStage Manager help topics for the 
DataStage Usage Analysis window.

Toolbar

Many of the DataStage Usage Analysis window menu commands are 

also available in the toolbar.

Shortcut Menu

Display the shortcut menu by right-clicking in the report window. The 

following commands are available from this menu:

Usage Analysis. Only available if you have selected an item in 
the report list. 

Edit. Only available if you have selected an item in the report list.

Back. 

Forward.

Refresh.

Locate in Manager. Only available if you have selected an item 
in the report list.

Load

Save

Usage Analysis

Back

Forward

Refresh

Edit

Locate in
Manager

Select Columns
Condense Jobs 

Help

or Shared Containers
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Visible Relationships
The following table lists the relationships that it is possible to view 

using the Usage Analysis tool:

Configuring Warnings
Usage Analysis options allow you to specify levels of warning that 

appear when you perform operations on referenced items. These are 

set using the Manager Options dialog box.

Source Relationship Target

Job/Job 
sequence

Depended on by Job Job

Shared 
container

Used in Container Stage of 
Job
Used in Container Stage of 
shared container

Container stage
Container stage

Stage Type Type of Stage Stage

Table 
Definition

Loaded into Column
Loaded into Column

Link column
Stage column

Transform Used in Constraint of Link
Used in Derivation of 
Column
Used in Derivation of Stage 
Variable

Link
Column

Stage

Data Element Output of Transform
Input of Transform
Type of Column
Type of Column Definition

Transform
Transform
Column
Column Definition

Routine Called Before Job
Called After Job
Called Before Stage
Called After Stage
Called By Transform
Used In Constraint of Link
Used in Derivation of 
Column
Used By External Routine 
Stage
Used in Derivation of Stage 
Variable

Job
Job
Stage
Stage
Transform
Link
Column

Stage

Stage

Machine 
Profile

Used in Stage
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To specify warnings levels:

1 From the DataStage Manager, choose Tools ➤ Options. The 
Options dialog box appears:

2 Choose the Usage Analysis branch in the tree, then select the 
required check boxes as follows:

– Warn if deleting/renaming referenced item. If you select 
this, you will be warned whenever you try to delete, rename, or 
move an object from the Repository that is used by another 
DataStage component.

– Warn if importing referenced item. If you select this, you 
will be warned whenever you attempt to import an item that 
will overwrite an existing item that is used by another 
DataStage component.

– Warn if compiling referenced routine. If you select this, 
you will be warned when you attempt to recompile a routine 
that is used by another DataStage component.

– Update internal references when modifying or deleting 
items. If you select this, DataStage will update references 
automatically where possible when an item is deleted or 
modified. References that can be automatically updated are 
TableDefinition.LoadedInto.JobLinkColumn and 
Job.DependedOnBy.Job. If jobs cannot be updated (because 
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they are locked by another user, or are read-only) then a failure 
report is generated and displayed in a window when the 
update is attempted.

3 Click OK to save your selections and close this dialog box.

Viewing the Report as HTML
You can view the Usage Analysis report in HTML format by choosing 

File ➤ View HTML. A temporary HTML file is created and displayed 

in your registered browser. The file is deleted when you close the 

Usage Analysis window, but you can save the file to a permanent 

location or print it.

The format of the file is determined by a template file called 

UsageRptXXX.htm, where XXX indicates the locale in which the 

template is intended. The template is held in the DataStage directory. 

You can edit the template to customize the layout of Usage Analysis 
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reports. The format of the template is described in Appendix C, 

“Usage Analysis HTML Template.”
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Reporting

This chapter describes how to generate reports from the DataStage 

Manager. 

The DataStage Reporting Tool is flexible and allows you to generate 

reports at various levels within a project, for example, entire job, 

single stage, set of stages, etc.

Information generated for reporting purposes is stored in a relational 

database on the DataStage client. This information can then be used 

to print a report, write a report to a file, or be interrogated by a third-

party tool.

A Microsoft Access database is provided on the DataStage client for 

this purpose. It offers a number of predefined report formats for you 

to choose from. You can extend or customize this database, or use 

some other SQL database for these purposes. It is possible to target 

any SQL database which is supported by a Level 2-compliant ODBC 

driver on the client machine. Create database scripts for most popular 

databases are provided in the documentation tool directory on the 

DataStage client (by default, C:\Program 

Files\ascential\datastage\documentation tool).

If you want to use an alternative database, run the script to create the 

database, assign it a DSN and then select that DSN on the Update 
Options page (see page 13-2) before clicking Update Now button.

The database used for reporting purposes must use the same 

language as the DataStage clients.

Note You can generate HTML format reports about jobs from the 

DataStage Designer – see "Job Reports" in DataStage 

Designer Guide.
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The Reporting Tool
The DataStage Reporting Tool is invoked by choosing Tools ➤ 
Reporting Assistant… from the DataStage Manager. The 

Reporting Assistant dialog box appears. This dialog box has two 

pages: Schema Update and Update Options.

Note If you want to use the Reporting Tool you should ensure 

that the names of your DataStage components (jobs, 

stages, links, etc.) do not exceed 64 characters. 

The Schema Update page allows you to specify what details in the 

reporting database should be updated and when. This page contains 

the following fields and buttons:

Whole Project. Click this button if you want all project details to 
be updated in the reporting database. If you select Whole 
Project, other fields in the dialog box are disabled. This is 
selected by default.

Selection. Click this button to specify that you want to update 
selected objects. The Select Project Objects area is then enabled.

Select Project Objects. Select the check boxes of all objects that 
you want to be updated in the reporting database. The 
corresponding tab is then enabled. For example, if you select the 
Jobs check box, you can go on to specify which jobs to report on 
in the Jobs tab.

The Update Options page allows you to make adjustments to any 

requested updates to the reporting database. 
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This page contains the following fields and buttons:

Target Schema DSN. Select the required database from the 
drop-down list box. All current DSNs available on the client 
machine are listed. The MS Access database supplied with 
DataStage is selected by default.

Line Fold Length. Select a value to determine where carriage 
returns will be inserted in potentially long properties. For 
example, the Description property may well run to hundreds of 
characters, so selecting 80 would specify that carriage returns are 
inserted every 80 characters. If there are already carriage returns 
in the text, these will be used in preference.

Suppress Transactions. Select this to suppress transaction 
handling when you update the underlying reports database. If you 
have a large project, it is recommended that you select this unless 
you have large rollback buffers. (This setting isn’t relevant if you 
are using the Documentation Tool).

Include Built-ins. Specifies that built-in objects should be 
included in the update.

List Project Objects. Determines how objects are displayed in 
the lists on the Schema Update page:

– Individually. This is the default. Lists individual objects of that 
type, allowing you to choose one or more objects. For 
example, every data element would be listed by name: 
Number, String, Time, DATA.TAG, MONTH.TAG, etc.
Manager Guide 13-3



The Documentation Tool Reporting
– By Category. Lists objects by category, allowing you to 
choose a particular category of objects for which to update the 
details. For example, in the case of data elements, you might 
choose among All, Built-in, Built-in/Base, Built-in/Dates, 
and Conversion.

The following buttons are on both pages of the Reporting Assistant 

dialog box:

Update Now. Updates the selected details in the reporting 
database. Note that this button is disabled if no details are 
selected in the Schema Update page.

Doc. Tool… . Opens the Documentation Tool dialog box in 
order to request a report. 

The Documentation Tool
The Documentation Tool dialog box is opened by clicking the Doc. 
Tool… button on the Reporting Assistant dialog box. It allows you 

to print predefined reports from the Microsoft Access database. The 

dialog box remains in view until you click Exit.

Each page has an Include in Report area which allows you to choose 

options for various types of report. Click the Preview button in the 

toolbar to see what a finished report will look like.

The toolbar has the following functions:
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Print. Prints a report of the format specified in the Report 
Configuration form.

Print Preview. Gets a preview of the form before you actually 
print it. To print from the preview, click the Print button.

Custom Reports. Gets a list of available reports. Use this to 
access reports added to the MS Access Documentation Tool 
besides those supplied with DataStage.

Exit. Exits the Documentation Tool when you have printed all 
required reports.

The Documentation Tool dialog box has a Report Configuration 

form which in turn has a page for every type of object. Each page has 

a list box that shows all objects of that type currently in the reporting 

database. Objects can be listed individually or by category (note that 

jobs can only be listed individually).

The Report Configuration form has the following fields and buttons:

Include in Report. This area lists the optional fields that can be 
excluded or included in the report. Select the check box to include 
an item in the report, clear it to exclude it. All items are selected by 
default.

Select All. Selects all items in the list window.

Project. Lists all the available projects. Choose the project that 
you want to report on.

List Objects. This area determines how objects are displayed in 
the lists on the Schema Update page:

– Individually. This is the default. Lists individual objects of that 
type, allowing you to choose one or more objects. For 
example, every data element would be listed by name: 
Number, String, Time, DATA.TAG, MONTH.TAG, etc.

– By Category. Lists objects by category, allowing you to 
choose a particular category of objects for which to update the 
details. For example, in the case of data elements, you might 
choose among All, Built-in, Built-in/Base, Built-in/Dates, 
and Conversion.
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Examples of some of the reports are given below:
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Managing Message Handlers

Parallel jobs This chapter describes how to manage message handlers that have 

been defined in DataStage.

What are message handlers? When you run a parallel job, any error 

messages and warnings are written to an error log and can be viewed 

from the Director. You can choose to handle specified errors in a 

different way by creating one or more message handlers. 

A message handler defines rules about how to handle messages 

generated when a parallel job is running. You can, for example, use 

one to specify that certain types of message should not be written to 

the log.

You can edit message handlers in the DataStage Manager or in the 

DataStage Director. The recommended way to create them is by using 

the Add rule to message handler feature in the Director (see "Adding 

Rules to Message Handlers" in DataStage Director Guide).

You can specify message handler use at different levels:

Project Level. You define a project level message handler in the 
DataStage Administrator, and this applies to all parallel jobs 
within the specified project.

Job Level. From the Designer and Manager you can specify that 
any existing handler should apply to a specific job. When you 
compile the job, the handler is included in the job executable as a 
local handler (and so can be exported to other systems if 
required).

You can also add rules to handlers  when you run a job from the 

Director (regardless of whether it currently has a local handler 

included). This is useful, for example, where a job is generating a 

message for every row it is processing. You can suppress that 

particular message. 
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When the job runs it will look in the local handler (if one exists) for 

each message to see if any rules exist for that message type. If a 

particular message is not handled locally, it will look to the project-

wide handler for rules. If there are none there, it writes the message to 

the job log.

Note message handlers do not deal with fatal error messages, these 

will always be written to the job log.

The Message Handler Manager
You can view, edit, or delete message handlers  from the Message 

Handler Manager. You can also define new handlers if you are familiar 

with the message IDs (although note that DataStage will not know 

whether such messages are warnings or informational). The preferred 

way of defining new handlers is by using the add rule to message 

handler feature.

To open the Message Handler Manager, choose Tools ➤ Message 
Handlers . The Edit Message Handlers dialog box appears.

To edit an existing handler:
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1 Choose an option to specify whether you want to edit the project-
level message handler, or edit a specific message handler. If you 
want to edit a specific message handler, select the handler from 
the drop-down list. The settings for whichever handler you have 
chosen to edit appear in the grid.

2 Edit the grid as required, you can:

– Choose a new Action for a particular message. Select a new 
Action from the drop-down list. Possible Actions are:

Suppress from log. The message is not written to the job's 

log as it runs.

Promote to Warning. Promote an informational message to a 

warning message.

Demote to Informational. Demote a warning message to 

become an informational one.

– Delete a message. Select the message in the grid, right-click 
and choose Delete Row from the shortcut menu.

– Add a new message. Right-click in the grid and choose Insert 
Row from the shortcut menu. You can then type in details of 
the message you want to add to the handler.

When you are done with your edits, click Save and choose Save 
Message Handler to save the handler with its current name or 

Save Message Handler As to save it as a new handler.

To delete a handler:

1 Choose an option to specify whether you want to delete the local 
runtime handler for the currently selected job, delete the project-
level message handler, or delete a specific message handler. If 
you want to delete a specific message handler, select the handler 
from the drop-down list. The settings for whichever handler you 
have chosen to edit appear in the grid.

2 Click the Delete button.

To define a new handler:

1 Choose Edit chosen message handler and select (New) from 
the drop-down list. The grid clears, allowing new message rules to 
be added.

2 Type in the message ID for the first message you want to add to 
the handler.

3 Choose an Action from the drop-down list. Possible Actions are:

– Suppress from log. The message is not written to the job's 
log as it runs.
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– Promote to Warning. Promote an informational message to a 
warning message.

– Demote to Informational. Demote a warning message to 
become an informational one.

4 Repeat this process until you have added all the required 
messages.

5 When you have defined all the required messages for the handler, 
click Save and choose Save Message Handler As from the 
menu. A dialog box opens and prompts you for the name of the 
new handler.

6 Type in the name for your new message handler.

Message Handler File Format
A message handler is a plain text file and has the suffix .msh. It is 

stored in the folder $DSHOME/../DataStage/MsgHandlers. The 

following is an example message file.

TUTL 0000311 1 The open file limit is 100; raising to 1024…
TFSC 0000011 2 APT configuration file…
TFSC 0000432 3 Attempt to Cleanup after ABORT raised in stage…

Each line in the file represents message rule, and comprises four tab-

separated fields:

Message ID. Case-specific string uniquely identifying the 
message

Type. 1 for Info, 2 for Warn

Action. 1 = Suppress, 2 = Promote, 3 = Demote

Message. Example text of the message
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Importing, Exporting,

and Packaging Jobs

This chapter describes how to use the DataStage Manager to import 

and export components, and use the Packager Wizard.

DataStage allows you to import and export components in order to 

move jobs between DataStage development systems. You can import 

and export server jobs and, provided you have the options installed, 

mainframe jobs or parallel jobs. DataStage ensures that all the 

components required for a particular job are included in the import/

export.

You can also use the export facility to generate XML documents which 

describe objects in the DataStage Repository. You can then use a 

browser such as Microsoft Internet Explorer Version 5 to view the 

document. XML is a markup language for documents containing 

structured information. It can be used to publish such documents on 

the Web. For more information about XML, visit the following Web 

sites:

http://www.xml.com

http://webdeveloper.com/xml

http://www.microsoft.com/xml

http://www.xml-zone.com

There is an import facility for importing DataStage components from 

XML documents.

You can also import meta data from MetaStage, and export projects to 

MetaStage.

DataStage also allows you to package server jobs using the Packager 

Wizard. It allows you to distribute executable versions of server jobs. 
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You can, for example, develop jobs on one system and distribute 

them to other systems with DataStage Director installed. The jobs can 

then be executed on that system.

Using Import
You can import complete projects, jobs, or job components that have 

been exported from another DataStage development environment. 

You can import components from a text file or from an XML file. You 

must copy the file from which you are importing to a directory you can 

access from your local machine. You can also import meta data from 

MetaStage.

Note You can import components that support mainframe 

functionality only into a DataStage system that has 

Enterprise MVS Edition installed. You should also ensure 

that the system to which you are importing supports the 

required platform type.

To import components:

1 From the DataStage Manager, choose Import ➤ DataStage 
Components… to import components from a text file or 
Import ➤ DataStage Components (XML) … to import 
components from an XML file. The DataStage Repository 
Import dialog box appears (the dialog box is slightly different if 
you are importing from an XML file, but has all the same controls):

2 Type in the path or browse for the file to import from.

3 To import objects from the file into the Repository, click the 
Import all option button and click OK. During import, you will be 
warned if objects of the same name already exist in the Repository 
and asked if you want to overwrite them. If you select the 
Overwrite without query check box before importing you will 
not be warned, and any existing objects will automatically be 
overwritten. 
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If you import job components, they are imported into the current 

project in the DataStage Manager. If you import a whole project, a 

new project branch is created in the Repository.

4 To import selected components from the file into the Repository, 
click the Import selected option button and click OK. The 
Import Selected dialog box appears. Select the required items 
and click OK. The selected job components are imported into the 
current project in the DataStage Manager.

5 To turn usage analysis off for this particular import, deselect the 
Perform Usage Analysis checkbox. (By default, all imports are 
checked to see if they are about to overwrite a currently used 
component, disabling this feature may speed up large imports. 
You can disable it for all imports by changing the usage analysis 
options – see "Configuring Warnings" on page 12-6.)

Using Import from the Command Line
DataStage also enables you to import components into the Repository 

from the command line. There are two ways of doing this. The 

dsimport command is a windows application and requires user 

interaction with message boxes (to import XML files in this way, use 

XML2DSX). The dscmdimport command is a command line 

application and can be run unattended (this imports both DSX and 

XML files). 

You can also import job executables from the DataStage engine shell 

using the DS_IMPORTDSX command, or, on UNIX servers, from the 

command line using dsjob with the -import option (for a description of 

dsjob see "Importing Job Executables" in Parallel Job Advanced 

Developer’s Guide and "Importing Job Executables" in Server Job 

Developer’s Guide).
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dsimport command

The dsimport command is as follows:

dsimport.exe /H=hostname /U=username /P=password /O=omitflag /NUA 
project|/ALL|/ASK dsx_pathname1 dsx_pathname2 ...

The arguments are as follows:

hostname. The DataStage Server to which the file will be 
imported.

username. The user name to use for connecting to the DataStage 
Server (not needed if omitflag = 1).

password. The user’s password (not needed if omitflag = 1).

omitflag. Set this to 1 to omit the username and password (only 
possible if you are connected to the DataStage Server via LAN 
Manager).

NUA. Include this flag to disable usage analysis. This is 
recommended if you are importing a large project.

project, /ALL, or /ASK. Specify a project to import the components 
to, or specify /ALL to import to all projects or /ASK to be prompted 
for the project to which to import.

dsx_pathname. The file to import from. You can specify multiple 
files if required.

For example, the following command imports the components in the 

file jobs.dsx into the project dstage1 on the R101 server:

dsimport.exe /H=R101 /O=1 dstage1 C:/scratch/jobs.dsx

dscmdimport command

The dscmdimport command is as follows:

dscmdimport /H=hostname /U=username /P=password /O=omitflag /NUA 
project|/ALL|/ASK pathname1 pathname2 ... /V

The arguments are as follows:

hostname. The DataStage Server to which the file will be 
imported.

username. The user name to use for connecting to the DataStage 
Server (not needed if omitflag = 1).

password. The user’s password (not needed if omitflag = 1).

omitflag. Set this to 1 to omit the username and password (only 
possible if you are connected to the DataStage Server via LAN 
Manager).

NUA. Include this flag to disable usage analysis. This is 
recommended if you are importing a large project.
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project, /ALL, or /ASK. Specify a project to import the components 
to, or specify /ALL to import to all projects or /ASK to be prompted 
for the project to which to import.

pathname. The file to import from. You can specify multiple files if 
required. The files can be DSX files or XML files, or a mixture of 
both.

V. Use this flag to switch the verbose option on.

For example, the following command imports the components in the 

file jobs.dsx into the project dstage1 on the R101 server:

dscmdimport /H=R101 /O=1 dstage1 C:/scratch/jobs.dsx

Messages from the import are sent to the console by default, but can 

be redirected to a file using '>', for example:

dscmdimport /H=R101 /O=1 /NUA dstage99 c:/scratch/project99.dsx /V > c:/
scratch/importlog

You can simply type dscmdimport at the command prompt to get help 

on the command options.

XML2DSX command

The XML2DSX command is as follows:

XML2DSX.exe /H=hostname /U=username /P=password /O= omitflag 

/N[OPROMPT] /I[INTERACTIVE] /V[ERBOSE] projectname filname /

T=templatename

The arguments are as follows:

hostname. The DataStage Server to which the file will be 
imported.

username. The user name to use when connecting (not needed if 
omitflag = 1)

password. The user’s password (not needed if omitflag = 1).

omitflag. Set this to 1 to omit the username and password (only 
possible if you are connected to the DataStage Server via LAN 
Manager).

NOPROMPT. If you include this flag, the import will run silently, 
overwriting any existing components in the DataStage Repository 
with the same name.

INTERACTIVE. If you include this flag, the DataStage Manager 
opens the standard Import DataStage Components dialog 
box. This allows you to choose which components should be 
imported.

VERBOSE. Displays details about the XML2DSX tool such as 
version number when it starts up.
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projectname. The name of the DataStage project to attach to on 
hostname.

filename. The name of the XML file containing the components to 
import.

templatename. Optionally specifies an XSLT template to be used 
to transform the XML file. If this is omitted, a default template is 
used. The default template is the one used when DataStage 
exports components into XML.

For example, the following command imports the components in the 

file jobs.xml into the project dstage1 on the R101 server:

XML2DSX.exe /H=R101 /O=1 /N dstage1 C:/scratch/jobs.xml

DS_IMPORTDSX Command

This command is run from within the DS engine using dssh. It can 

import any job executables found within specified DSX files. Run it as 

follows:

1 CD to the project directory on the server:

cd c:\ascential\datastage\projects\project

2 Run the dssh shell:

..\..\engine\bin\dssh

3 At the dssh prompt enter the DS_IMPORTDSX command (see 
below for syntax).

The DSXimport command is as follows:

DS_IMPORTDSX filename [[-OVERWRITE] -JOB[S] * | jobname …] | [-LIST]

The arguments are as follows:

filename. The name of the DSX file containing the components to 
import.

OVERWRITE. Specify this to overwrite any existing executables of 
the same name.

JOB[S]. Specify one or more job executables to import. 

LIST. Specify this to list the executables in a .DSX file rather than 
import them.

If you don’t specify a JOB or a LIST argument, the default is to import 

all job executables in the specified file.

Importing from MetaStage 
To import meta data from MetaStage: 
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1 Choose Import ➤ From MetaStage. The MetaStage Attach 
dialog box appears. 

2 Enter the required connection information to connect to a specific 
directory (as described in “Starting MetaStage and Connecting to 
a Directory” in the MetaStage help). The MetaStage Select 
Publication dialog box appears. 

3 Select one or more publication categories to import, and click 
Select.

The meta data in the publication categories is imported into 

DataStage using the DataStage MetaBroker. Table definitions, for 

example, appear in the Table Definitions category, in the DataStage 7 

MetaBroker sub-category. A log file named MetaStageImport.log is 

created in the DataStage client directory.

In DataStage Manager, click View ➤ Refresh to see the imported 

meta.

Using Export
You can use the DataStage export facility to move DataStage jobs or 

to generate XML documents describing DataStage components. You 

can also export one or more job executables. 

You can also export entire projects to MetaStage.

In all cases you use the Export command in the DataStage Manager.

Warning You should ensure that no one else is using DataStage 

when performing an export. This is particularly 

important when a whole project export is done for the 

purposes of a backup.

Moving DataStage Projects and Jobs
Exported projects or components are stored in text files with the suffix 

.dsx. You must choose what to export and the file to use.

To use Export:
Manager Guide 15-7



Using Export Importing, Exporting, and Packaging Jobs
1 From the DataStage Manager, choose Export ➤ DataStage 
Components… . The Export dialog box appears: 

2 Choose the file to export to by doing one of the following:

– Enter the directory path and file name in the Export to file 
field.

– Click … (browse) to search the system for an appropriate 
directory and file.

3 Select the Append to existing file check box if you want to add 
the exported items to the specified file. The check box is cleared by 
default, i.e., the exported items will overwrite any existing items in 
the file.

4 Choose what to export by clicking the appropriate option button:

– Whole project. All the jobs, data elements, shared containers, 
stage types, table definitions, transforms, job executables, 
routines, and machine profiles are exported. 

– Selection. An individual item or a selection of items in the 
current project is exported. 

5 If you clicked Selection, choose the items to export by selecting 
the appropriate check boxes. 

The following components are shown:
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– Job designs. The chosen job or job sequence designs are 
exported. 

– Shared containers. The chosen shared containers are 
exported.

– Data elements. The chosen data elements are exported. 

– Stage types. The chosen plug-in definitions are exported.

Note Export does not handle the associated plug-in DLLs. To 

deploy a plug-in, you must use the Packager Wizard 

instead. For more information, see "Using the Packager 

Wizard" on page 15-17.

– Table definitions. The chosen table definitions are exported.

– Transforms. The chosen transforms are exported.

– Job executables. The chosen job executables are exported. If 
you choose this option, you can also select the Program 
sources check box to export the associated source.

– Routines. The chosen routines are exported. Choosing this 
option allows you to select Source Code to export the 
associated source code.

– Machine profiles. The chosen machine profiles are exported.

– IMS databases. The chosen IMS database objects are 
exported.

– IMS viewsets. The chosen IMS viewset objects are exported.

A selection is already made based on the highlighted branch in the 

DataStage Manager when you chose Tools ➤ Export… . 

You can select all objects of a particular type to be exported or 

select a category of object to export from the drop-down list. For 

example, in the case of data elements, you might choose among 

All, Built-In, Built-In/Base, Built-In/Dates, and Conversion. 

It is possible to choose an individual object, but you must first 

click By individual component on the Options tab.

6 Click the Options tab, then select any required options as follows:

– Selection - By category. This is the default. The drop-down 
list boxes on the Components tab allow you to choose 
between all and the different categories of each object in the 
Repository.

– Selection - By individual component. This allows you to 
choose a single object per object type, so the drop-down list 
boxes on the Components tab list all the individual objects of 
that type.
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– Include in export - Defaulted properties. Select this check 
box to export the properties of the items being exported. By 
default, properties and default values are not included in the 
export file.

– Include in export - Read-only objects. Select this check box 
to export any read-only items selected in the Components 
tab. By default, read-only items are not exported.

– Use 7-bit format encoding. Select this check box if you are 
likely to e-mail the exported file. The check box is cleared by 
default.

7 To determine the behavior of the View button, click the View tab, 
then select the required setting as follows:

– Select Use default viewer to view the export file using the 
default program associated with the .dsx extension.

– Select Run this program to view the file using some other 
tool, and specify the executable for the tool in the text box.

– When you click the View button in the Export dialog box, the 
file to be exported is displayed in the chosen tool.

– Click OK. The chosen items are exported to the specified text 
file. This file can be imported into another DataStage 
development environment.

Generating an XML File
To generate an XML file:
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1 From the DataStage Manager, choose Export ➤ DataStage 
Components… . The Export dialog box appears: 

2 Select the Export as XML document check box.

3 Choose an XML file to export to by doing one of the following:

– Enter the directory path and file name in the Export to file 
field.

– Click … (browse) to search the system for an appropriate 
directory and file.

4 Choose what to export by clicking the appropriate option button:

– Whole project. All the jobs, shared containers, data elements, 
stage types, table definitions, transforms, routines, and 
machine profiles are exported. 

– Selection. An individual item or a selection of items in the 
current project is exported. 

5 If you clicked Selection, choose the items to export by selecting 
the appropriate check boxes. 

The following components are shown:

– Job designs. The chosen job or job sequence designs are 
exported. 
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– Shared containers. The chosen shared containers are 
exported.

– Data elements. The chosen data elements are exported. 

– Stage types. The chosen plug-in definitions are exported.

– Table definitions. The chosen table definitions are exported.

– Transforms. The chosen transforms are exported.

– Routines. The chosen routines are exported. Choosing this 
option allows you to select Source Code to export the 
associated source code.

– Machine Profiles. The chosen machine profiles are exported.

– IMS databases. The chosen IMS database objects are 
exported.

– IMS viewsets. The chosen IMS viewset objects are exported.

A selection is already made based on the highlighted branch in the 

DataStage Manager when you chose Tools ➤ Export… . 

You can select all objects of a particular type to be exported or 

select a category of object to export from the drop-down list. For 

example, in the case of data elements, you might choose among 

All, Built-In, Built-In/Base, Built-In/Dates, and Conversion. 

It is possible to choose an individual object, but you must first 

click By individual component on the Options tab.

6 Click the Options tab, then select any required options as follows:

– Selection - By category. This is the default. The drop-down 
list boxes on the Components tab allow you to choose 
between all and the different categories of each object in the 
Repository.

– Selection - By individual component. This allows you to 
choose a single object per object type, so the drop-down list 
boxes on the Components tab list all the individual objects of 
that type.

– Include in export - Defaulted properties. Select this check 
box to export the properties of the items being exported. By 
default, properties and default values are not included in the 
export file.

– Include in export - Read-only objects. Select this check box 
to export any read-only items selected in the Components 
tab. By default, read-only items are not exported.

7 Click the XML tab, then select required XML settings as follows:
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– Include DTD in document. Select this check box to specify 
that the generated XML document will contain a DTD in its 
preamble. The DTD is generated by DataStage.

– Properties. You can choose to output object properties as 
internal values or as externalized strings. Internal values are 
numeric, and are not necessarily intelligible when viewed in a 
Web browser. Externalized strings are the user-visible form and 
are localized where appropriate.

For example, If you choose Output internal (stored) values, 

the character ‘1’ would be output to represent the SQLtype 

property Char. If you chose Output as externalized strings, 

the string “char” would be output to represent the SQLtype 

property Char.

– Style Sheet. You can specify a style sheet to use when 
formatting the XML document for viewing in a Web browser. 
Select the Include reference to style sheet in document 
check box to take advantage of this feature. Specify the type of 
style sheet in the Type box and supply the name of the style 
sheet in the Reference box. An XSL style sheet, called 
DSExport-HTML.xsl is supplied with DataStage, and is located 
in the DataStage home directory.

8 To determine the behavior of the View button, click the View tab, 
then select the required setting as follows:

– Select Use default viewer to view XML files using Microsoft 
Internet Explorer Version 5.

– Select Run this program to view the file using some other 
tool, and specify the executable for the tool in the text box.

When you click the View button in the Export dialog box, the 

XML file is displayed in the chosen tool.

9 Click OK. The chosen items are exported to the specified text file. 
This file can be imported into another DataStage development 
environment.

Publishing to the Web

You can use the Export as XML feature to publish DataStage meta 

data to the Web. To do this:

1 Choose to export as XML.

2 Choose the Output as externalized strings option in the 
Properties area of the XML tab.

3 Include a reference to the DSExport-HTML.xsl style sheet in the 
Style Sheet area of the XML tab.
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4 Ensure that you have Microsoft Internet Explorer Version 5 or 
some other XML-capable browser installed.

Exporting Job Executables
The Export ➤ Executable Job… command enables you to export 

job executables for deployment on another machine. You can also 

export job executables using the Export ➤ DataStage 
Components… command, but the specialized executable job 
dialog box allows you select jobs from a tree structure. This is 
the recommended way of exporting multiple job executables.

To export job executables:

1 In the manager tree, select a compiled job, or a category 
containing compiled jobs. 

2 From the DataStage Manager, choose Export ➤ Executable 
Job… . The Export dialog box appears. The dialog depends on 
whether you have selected a single job, or a category or multiple 
jobs. 

– If you have selected a single job, the following form of the 
dialog box appears:
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– If you have selected multiple jobs or a job category, the 
following form of the dialog box appears:

3 Type in, or browse for, the name of the file you are exporting to in 
the Export to file field.

4 If you are exporting multiple job executables, you can use the 
check boxes in the selection tree to determine which ones to 
export. The Selected field tells you how many jobs are currently 
selected.

Note The export executable job feature is primarily intended for 

parallel jobs, which are complete in themselves. You can 

export server job executables in this way, but be warned 

that you have to export job dependencies, such as routines 

and transforms, separately if they do not already exist on 

the target system.

Using Export from the Command Line
DataStage also enables you to export components to a file from the 

command line. There are two ways of doing this. The dsexport 

command is a windows application and requires user interaction with 

message boxes. The dscmdexport command is a command line 

application and can be run unattended.

dsexport command

The dsexport command is as follows:

dsexport.exe /H hostname /U username /P password /O omitflag project 
pathname1

The arguments are as follows:
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hostname specifies the DataStage Server from which the file will 
be exported.

username is the user name to use for connecting to the DataStage 
Server.

password is the user’s password.

omitflag set this to 1 to omit the username and password (only 
possible if you are connected to the DataStage Server via LAN 
Manager).

project. Specify the project to export the components from.

pathname. The file to which to export.

For example, the following command exports the project dstage2 

from the R101 to the file dstage2.dsx:

dsexport.exe /H R101 /O 1 dstage2 C:/scratch/dstage2.dsx

dscmdexport command

The dscmdexport is as follows:

dscmdexport /H hostname /U username /P password /O omitflag project 
pathname /V

The arguments are as follows:

hostname. Specifies the DataStage Server from which the file will 
be exported.

username. The user name to use for connecting to the DataStage 
Server.

password. The user’s password.

omitflag. Set this to 1 to omit the username and password (only 
possible if you are connected to the DataStage Server via LAN 
Manager).

project. Specify the project to export the components from.

pathname. The file to which to export.

V. Use this flag to switch the verbose option on.

For example, the following command exports the project dstage2 

from the R101 to the file dstage2.dsx:

dscmdexport /H R101 /O 1 dstage2 C:/scratch/dstage2.dsx

Messages from the export are sent to the console by default, but can 

be redirected to a file using '>', for example:

dscmdexport /H R101 /O 1 dstage99 c:/scratch/project99.dsx /V > c:/
scratch/exportlog

You can simply type dscmdexport at the command prompt to get 

help on the command options.
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Export Error Log
If any errors occur during an export (whether initiated from the 

Manager or the command line), an error log is generated. This is 

placed in the same folder as the target export file, and is called 

DSExporttimestamp.log, where timestamp gives the date and time it 

was generated. You should ensure that these log files are regularly 

deleted.

Exporting to MetaStage
To export a project to MetaStage:

1 Choose Export ➤ To MetaStage. The MetaStage Attach dialog 
box appears.

2 Enter the required connection information to connect to a specific 
directory (as described in “Starting MetaStage and Connecting to 
a Directory” in the MetaStage help).

A new import category, containing the entire contents of the project as 

viewable through the DataStage MetaBroker, is created in the 

specified MetaStage directory. The import category is named 

ComputerName_DataStageProjectName-Timestamp (for example, 

HAL_OracleJobs-4/21/2003 2:24:14 PM). A log file named 

MetaStageExport.log is created in the DataStage client directory.

Using the Packager Wizard
Server jobs If you have developed a server job or plug-in, you can distribute it to 

other DataStage systems using the Packager Wizard. This utility is run 

from the Manager. 

You install the finished package on the target system using the 

DataStage Package Installer, as described in "Installing DataStage 

Packages" in DataStage Administrator Guide.

When you use the Packager Wizard, you must specify the type of 

package to create:

Job Deployment. Contains executable job or job sequence 
definitions (for each job in the package). The package contains 
information about the job itself and other dependencies such as 
transforms, data elements, and plug-ins.

Note You can only package released jobs. For more 

information about releasing a job, see "Debugging, 

Compiling, and Releasing a Job" in Server Job 

Developer’s Guide.
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Design Component. Contains plug-in definitions and associated 
DLLs.

To package a job or plug-in:

1 From the DataStage Manager, choose Export ➤ Packager 
Wizard… . The DataStage Packager Wizard appears:

2 Specify the type of package you want to create by clicking Job 
Deployment or Design Component.

3 Click Next>. The wizard displays the next set of prompts.

4 Enter the name of the package, a description, and a target 
directory on the server in the appropriate fields. 

Note You can use Browse… to search the system for a 

suitable directory.

5 Click Next>. 

6 Select the jobs or plug-ins to be included in the package from the 
list box. The content of this list box depends on the type of 
package you are creating. For a Job Deployment package, this list 
box displays all the released jobs. For a Design Component 
package, this list box displays all the plug-ins under the Stage 
Types branch in the Repository (except the built-in ones supplied 
with DataStage).

7 If you are creating a Job Deployment package, and want to include 
any other jobs that the main job is dependent on in the package, 
select the Automatically Include Dependent Jobs check box. 
The wizard checks the dependency tree to make sure all the 
required jobs exist and informs you of any errors. 
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8 Click Next>. The wizard confirms the package name, destination, 
and chosen jobs or plug-ins. If you are packaging jobs and have 
included dependent jobs, these are shown indented in the list.

9 Click Finish to create the package. The package is created in the 
chosen directory using the specified name. 

You can now distribute the package for use on other DataStage 

systems. 

Note When you install packaged jobs on the target machine, they 

are installed into the same category. DataStage will create 

the category first if necessary.

Releasing a Job
If you are developing a job for users on another DataStage system, 

you must label the job as ready for deployment before you can 

package it. For more information about packaging a job, see "Using 

the Packager Wizard" on page 15-17.

To label a job for deployment, you must release it. A job can be 

released when it has been compiled and validated successfully at 

least once in its life. 

Jobs are released using the DataStage Manager. To release a job:

1 From the DataStage Manager, browse to the required category in 
the Jobs branch in the project tree.

2 Select the job you want to release in the display area. 

3 Choose Tools ➤ Release Job. The Job Release dialog box 
appears, which shows a tree-type hierarchy of the job and any 
associated dependent jobs.

4 Select the job that you want to release.

5 Click Release Job to release the selected job, or Release All to 
release all the jobs in the tree.

A physical copy of the chosen job is made (along with all the routines 

and code required to run the job) and it is recompiled. The Releasing 
Job dialog box appears and shows the progress of the releasing 

process.

The released job is automatically assigned a name and version 

number using the format jobname%reln.n.n. jobname is the name of 

the job you chose to release and n.n.n is the version number. When 

you refer to a job by its released name, this is known as a “fixed job 

release,” which always equates to that particular version of the job.
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You can use the Designer to view the design of a released job. 

However, if you edit the job design you cannot save the changes. The 

meta data and settings displayed in the job design are stored as part 

of the released job and these may not match the information currently 

held in the Repository. This is especially true if you developed the 

table definitions, transforms, routines, or job design after the job was 

released. 

If you want to develop and enhance a job design, you must edit the 

original job. To use the changes you have made, you must release the 

job again.

Note Released jobs cannot be copied or renamed using the 

Manager. 

The Job Release dialog box is shown below:

This dialog box contains a tree-type hierarchy showing the job 

dependencies of the job you are releasing. It displays the status of the 

selected job as follows:

Not Compiled. The job exists, but has not yet been compiled 
(this means you will not be able to release it).

Not Released. The job has been compiled, but not yet released.

Job Not Found. The job cannot be found.

Released. The job has previously been released.

Release Exists. The selected job is a fixed version (i.e., has a 
particular release number) and that version of the job exists.

The dialog box also displays the highest released version of the 

selected job. When the selected job is a fixed version job (i.e., has a 

particular release number), then it displays Fixed Job Release.

If a dependent job appears in more than one branch of the hierarchy, 

then only the one at the highest level is displayed.
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Using MetaBrokers

MetaBrokers allow you to exchange enterprise meta data between 

DataStage and other data warehousing tools. For example, you can 

use MetaBrokers to import into DataStage table definitions that you 

have set up using a data modelling tool. Similarly you can export 

meta data from a DataStage job to a business intelligence tool to help 

it analyze your data warehouse.

To use MetaBrokers, you need to install MetaBrokers for any tools 

with which you want to exchange meta data. MetaBrokers are 

provided on a separate CD. Instructions for installing MetaBrokers are 

in "Installing MetaBrokers" in DataStage Administrator Guide.

This chapter tells you how to use MetaBrokers from the DataStage 

Manager. The instructions given are generic. Instructions for using 

particular MetaBrokers are in technical bulletins included on the 

installation CD in the relevant MetaBroker directory.

The MetaBrokers allow you to either import meta data into DataStage, 

or to export it from DataStage.

Importing Meta Data
Importing meta data into DataStage has two main phases. After you 

have specified the tool from which you are importing and the source 

for the import meta data, the MetaBroker for that tool extracts the 

meta data from the source. This is phase one. The MetaBroker then 

displays a list of extracted meta data from which you can select what 

you actually want to import into DataStage. Once you have done this, 

the DataStage MetaBroker imports the meta data into the DataStage 

Repository. This is phase two.
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To use MetaBrokers to import data into DataStage:

1 Start the DataStage Manager.

2 Choose Import ➤ Via MetaBrokers… . The MetaBroker 
Selection dialog box appears:

3 Select the MetaBroker for the tool from which you want to import 
the meta data and click OK. The Parameters Selection dialog 
box appears:

4 Specify the required parameters for the import (these vary 
according to MetaBroker, but typically specify data source and log 
file). Click OK. The Status dialog box appears.
16-2 Manager Guide



Using MetaBrokers Importing Meta Data
5 The process of extracting meta data from the import source to the 
MetaBroker is started. The status of the extraction is displayed in a 
text window: 

6 When the extraction is completed, the Select All and Filter 
buttons are enabled. If you want to import all the meta data, click 
Select All and continue from step 9. If you want to import 
selected meta data, click Filter. The Meta Data Selection dialog 
box appears. It shows the meta data that the MetaBroker has 
extracted from the source, and allows you to specify what you 
actually want to import into DataStage. The dialog box shows all 

the classes of object that can be imported in a tree structure. Click 
one of the plus symbols to expand the tree. Click one of the minus 
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symbols to shrink it again. Click in one of the square boxes to 
select a class, the class then appears in the Selection Status 
pane on the right.

The arrows indicate relationships and you can follow these to see 

what classes are related and how (this might affect what you 

choose to import). 

7 Specify what is to be imported:

– Select boxes to specify which instances of which classes are to 
be imported.

– Alternatively, you can click Select All to import all instances of 
all classes.

– If you change your mind, click Clear All to remove everything 
from the Selection Status pane.
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8 When you are satisfied that you have selected all the meta data 
you want to import, click OK. The Parameters Selection dialog 
box appears:

9 Specify the required parameters for the import into DataStage. 
These allow you to specify whether you should be prompted to 
confirm overwrites to the DataStage Repository, and whether 
verbose output is enabled. Click OK. The Status dialog box 
appears.

10 The DataStage MetaBroker copies the selected data into the 
DataStage Repository. The status of the import is displayed in a 
text window. Click Finish when it has completed the import.

When the import is complete, you can see the meta data that you have 

imported under the relevant branch in the DataStage Manager. For 

example, data elements imported from ERWin appear under the Data 
Elements ➤ ERWin35 branch.

You may import more items than you have explicitly selected. This is 

because the MetaBroker ensures that data integrity is maintained. For 
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example, if you import a single column, the table definition for the 

table containing that column is also imported.

Exporting Meta Data
Exporting meta data from DataStage to another data warehousing 

tool has two main phases. After you have specified the tool you want 

to export to, the DataStage MetaBroker extracts the meta data from 

the DataStage Repository. This is phase one. The MetaBroker then 

displays a list of extracted meta data from which you can select what 

you actually want to export. Once you have done this, the MetaBroker 

for the selected tool exports the meta data to the tool. This is phase 

two.

To use MetaBrokers to export data from DataStage:

1 Start the DataStage Manager.

2 Choose Export ➤ Via MetaBrokers… . The MetaBroker 
Selection dialog box appears:
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3 Select the MetaBroker for the tool to which you want to export the 
meta data and click OK. The Parameters Selection dialog box 
appears:

4 Specify the required parameters for the export from DataStage. 
These allow you to specify the name of a log file and whether 
verbose output is enabled. Click OK. The Status dialog box 
appears.

5 The process of extracting meta data from the DataStage 
Repository is started. The status of the extraction is displayed in a 
text window: 

6 When the extraction is completed, the Select All and Filter 
buttons are enabled. If you want to export all the meta data, click 
Select All and continue from step 9. If you want to export 
selected meta data, click Filter. The Meta Data Selection dialog 
Manager Guide 16-7



Exporting Meta Data Using MetaBrokers
box appears. It shows the meta data that the MetaBroker has 
extracted from the DataStage Repository, and allows you to 
specify what you actually want to export.

7 Specify what is to be exported in the same way as described for 
importing from a MetaBroker on page 16-4.

8 When you are satisfied that you have selected all the meta data 
you want to export, click OK. The Parameters Selection dialog 
box appears:

9 Specify the required parameters for the export into the data 
warehousing tool. These vary according to the tool you are 
exporting to, but typically include the destination for the exported 
data and a log file name.
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10 Data is exported to the tool. The status of the export is displayed 
in a text window. Depending on what tool you are exporting to, 
another application may be started to receive the exported data. 
When the export has completed, click Finish. 
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Importing Web Service Routines

You can construct DataStage routines from operations defined in 

WSDL files. You can then use these routines in derivation expressions 

in server jobs. For example, you could use one in a Transformer stage 

to determine how a column value within a row is computed from the 

column values of the input rows.

Note Before you can use the Import Web Service routine facility, 

you must first have imported the meta data from the 

operation you want to derive the routine from. See 

"Importing a Table Definition" on page 3-13.

To construct a DataStage routine from a web service WSDL file:
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1 Import the meta data for the web service operation. This is done 
using Import ➤ Table Definitions ➤ Web Services WSDL 
Definitions (see page 3-16).

2 Choose Import ➤ Web Service Function Definitions… . The 
Web Service Browser appears.

The upper right panel shows the web services whose meta data 

you have loaded. Select a web service to view the operations 

available in the web service in the upper left pane. 

3 Select the operation you want to import as a routine. Information 
about the selected web service is shown in the lower pane

4 Either click Select this item in the lower pane, or double-click the 
operation in the upper right pane. The operation is imported and 
appears as a routine in the Web Services category under a 
category named after the web service.

Once the routine is imported into the Repository, you can open the 
Server Routine dialog box to view it and edit it. See "The Server 

Routine Dialog Box" on page 8-4.
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DataStage uses grids in many dialog boxes for displaying data. This 

system provides an easy way to view and edit tables. This appendix 

describes how to navigate around grids and edit the values they 

contain. 

Grids
The following screen shows a typical grid used in a DataStage dialog 

box: 

On the left side of the grid is a row selector button. Click this to select 

a row, which is then highlighted and ready for data input, or click any 

of the cells in a row to select them. The current cell is highlighted by a 

chequered border. The current cell is not visible if you have scrolled it 

out of sight. 

Some cells allow you to type text, some to select a checkbox and 

some to select a value from a drop-down list. 

You can move columns within the definition by clicking the column 

header and dragging it to its new position. You can resize columns to 

the available space by double-clicking the column header splitter.
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You can move rows within the definition by right-clicking on the row 

header and dragging it to its new position. The numbers in the row 

header are incremented/decremented to show its new position.

The grid has a shortcut menu containing the following commands:

Edit Cell. Open a cell for editing.

Find Row… . Opens the Find dialog box (see"Finding Rows in the 
Grid" on page A-4).

Edit Row… . Opens the relevant Edit Row dialog box (see 
"Editing in the Grid" on page A-4).

Insert Row. Inserts a blank row at the current cursor position.

Delete Row. Deletes the currently selected row.

Propagate values… . Allows you to set the properties of several 
rows at once (see "Propagating Values" on page A-6).

Properties. Opens the Properties dialog box (see "Grid 
Properties" on page A-2).

Grid Properties
The Grid Properties dialog box allows you to select certain features 

on the grid.
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Select and order columns. Allows you to select what columns 
are displayed and in what order. The Grid Properties dialog box 
displays the set of columns appropriate to the type of grid. The 
example shows columns for a server job columns definition. You 
can move columns within the definition by right-clicking on them 
and dragging them to a new position. The numbers in the position 
column show the new position.

Allow freezing of left columns. Choose this to freeze the 
selected columns so they never scroll out of view. Select the 
columns in the grid by dragging the black vertical bar from next to 
the row headers to the right side of the columns you want to 
freeze.

Allow freezing of top rows. Choose this to freeze the selected 
rows so they never scroll out of view. Select the rows in the grid 
by dragging the black horizontal bar from under the column 
headers to the bottom edge of the rows you want to freeze.

Enable row highlight. Select this to enable highlighting of 
selected rows, disable it to highlight only the current cell.

Excel style headers. Select this to specify that selected row and 
column header buttons should be shown as raised when selected.

Apply settings to current display only. Select this to apply the 
selected properties to only this grid.

Save settings for future display. Select this to apply setting to 
all future displays of grids of this type.

Navigating in the Grid
You can move around the grid by using the mouse and scroll bars, or 

the keyboard. Table A-1 shows the keys that are used for navigation in 

the grid. 

Table A-1 Keys Used in Grid Navigation

Key Action

Right Arrow Move to the next cell on the right.

Left Arrow Move to the next cell on the left.

Up Arrow Move to the cell immediately above.

Down Arrow Move to the cell immediately below.

Tab Move to the next cell on the right. If the current cell is in the 
rightmost column, move forward to the next control on the form.
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Finding Rows in the Grid
The Find facility allows you to locate a particular row in a table 

definition. To find a particular row, choose Find row… from the 

shortcut menu. The Find dialog box appears, allowing you to specify 

the column to search and what is to be searched for.

Editing in the Grid
You can edit grids by using mouse and keyboard to directly modify 

the fields, or you can choose Edit Row… from the shortcut menu to 

open a dialog box enabling you to edit individual rows. The dialog 

box differs slightly depending on what type of grid you are editing. 

Additional controls are available to make the task simpler if you are 

editing a grid that defines one of the following:

Column definitions in a Table Definition dialog box

Column definitions in a server or mainframe stage editor

Arguments in a mainframe routine definition

Shift-Tab Move to the next cell on the left. If the current cell is in the 
leftmost column, move back to the previous control on the form.

Page Up Scroll the page down.

Page Down Scroll the page up.

Home Move to the first cell in the current row.

End Move to the last cell in the current row.

Table A-1 Keys Used in Grid Navigation

Key Action
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Editing the Grid Directly
These edit commands work on any type of grid. You can edit the 

contents of the current cell in three ways:

Start typing in the cell.

Press the F2 key to put the cell into edit mode.

Choose the Edit cell… command from the shortcut menu.

When you start editing, the current contents of the cell are highlighted 

ready for editing. If the cell is currently empty, an edit cursor appears. 

Table A-2 shows the keys that are used for editing in the grid. 

Adding Rows

You can add a new row by entering data in the empty row. When you 

move the focus away from the row, the new data is validated. If it 

passes validation, it is added to the table, and a new empty row 

appears. Alternatively, press the Insert key or choose Insert row… 

from the shortcut menu, and a row is inserted with the default column 

name Newn, ready for you to edit (where n is an integer providing a 

unique Newn column name).

Table A-2 Keys Used in Grid Editing

Key Action

Esc Cancel the current edit. The grid leaves edit mode, and the cell 
reverts to its previous value. The focus does not move.

Enter Accept the current edit. The grid leaves edit mode, and the cell 
shows the new value. When the focus moves away from a modified 
row, the row is validated. If the data fails validation, a message box is 
displayed, and the focus returns to the modified row.

Up Arrow Move the selection up a drop-down list or to the cell immediately 
above. 

Down 
Arrow

Move the selection down a drop-down list or to the cell immediately 
below.

Left Arrow Move the insertion point to the left in the current value. When the 
extreme left of the value is reached, exit edit mode and move to the 
next cell on the left.

Right Arrow Move the insertion point to the right in the current value. When the 
extreme right of the value is reached, exit edit mode and move to the 
next cell on the right.

Ctrl-Enter Enter a line break in a value.
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Deleting Rows

To delete a row, click anywhere in the row you want to delete to select 

it. Press the Delete key or choose Delete row from the shortcut 

menu. To delete multiple rows, hold down the Ctrl key and click in the 

row selector column for the rows you want to delete and press the 

Delete key or choose Delete row from the shortcut menu.

Propagating Values

You can propagate the values for the properties set in a grid to several 

rows in the grid. Select the column whose values you want to 

propagate, then hold down shift and select the columns you want to 

propagate to. Choose Propagate values... from the shortcut menu 

to open the dialog box.

In the Property column, click the check box for the property or 

properties whose values you want to propagate. The Usage field tells 

you if a particular property is applicable to certain types of job only 

(e.g. server, mainframe, or parallel) or certain types of table definition 

(e.g. COBOL). The Value field shows the value that will be propagated 

for a particular property.

Editing Column Definitions in a Table Definitions Dialog 
Box

To edit column definitions:

1 Do one of the following:

– Right-click in the column area and choose Edit row… from the 
shortcut menu.
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– Press Ctrl-E.

– Double-click on the row number cell at the left of the grid.

The Edit Column Meta Data dialog box appears. It has a 

general section containing fields that are common to all data 

source types, plus three tabs containing fields specific to meta 

data used in server jobs or parallel jobs and information specific 

to COBOL data sources.

Descriptions of each of the fields in this dialog box are in "Entering 

Column Definitions" on page 9-14.

2 Enter the general information for each column you want to define.

3 If you are specifying meta data for a server job type data source or 
target, then the Edit Column Meta Data dialog bog box appears 
with the Server tab on top. Enter any required information that is 
specific to server jobs.

4 If you are specifying meta data for a parallel job type data source 
or target, then the Edit Column Meta Data dialog bog box 
appears with the Parallel tab on top. Enter any required format 
information that is required by a parallel job.

5 If you are specifying meta data for a mainframe job type data 
source or target, then the Edit Column Meta Data dialog bog 
box appears with the COBOL tab on top. Enter any required 
information that is specific to mainframe jobs.

6 Use the buttons at the bottom of the Edit Column Meta Data 
dialog box to continue adding or editing columns, or to save and 
close. The buttons are:
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– <Previous and Next>. View the meta data in the previous or 
next row. These buttons are enabled only where there is a 
previous or next row enabled. If there are outstanding changes 
to the current row, you are asked whether you want to save 
them before moving on.

– Close. Close the Edit Column Meta Data dialog box. If there 
are outstanding changes to the current row, you are asked 
whether you want to save them before closing.

– Apply. Save changes to the current row.

– Reset. Remove all changes made to the row since the last time 
you applied changes.

7 Click OK to save the column definitions and close the Edit 
Column Meta Data dialog box. 

You can also edit a columns definition grid using the general grid 

editing controls, described in "Editing the Grid Directly" on page A-5.

Editing Column Definitions in a Mainframe Stage Editor
Editing the columns in a mainframe stage editor is similar to editing 

any column definitions. The same controls are available; the 

differences lie in the fields that are presented to be edited. 

There are three versions of the Edit Column Meta Data dialog box, 

depending on what type of mainframe stage you are editing.

The fields for all variants of the Edit Column Meta Data dialog box 

for mainframe stage types are described in Mainframe Job 

Developer’s Guide.
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The dialog box for the Complex Flat File stage is:

The dialog box for the Fixed Width Flat File and Relational stages is:

(Note there is no Date Format field in relational stages.)
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The dialog box for other stages is:

Editing Column Definitions in a Server Job Stage
Editing the columns in a server job stage editor is similar to editing 

any column definitions. The same controls are available; the 

differences lie in the fields that are presented to be edited. 

There are different versions of the Edit Column Meta Data dialog 

box, depending on what type of server job stage you are editing and 

whether it is an input or output link. The fields in the top portion of the 

dialog box are the same, but fields in the Server tab differ.

The fields for all variants of the Edit Column Meta Data dialog box 

for server stage types are described in Server Job Developer’s Guide.
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The following is an example dialog box for a Sequential File stage:

Editing Arguments in a Mainframe Routine Dialog Box
Editing the arguments for a mainframe routine is similar to editing 

column definitions. The same controls are available; the differences 

lie in the fields that are presented to be edited. 

There are three types of mainframe routine, external routine, external 

target routine, and external source routine. The fields are described in 

Mainframe Job Developer’s Guide.
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The Edit Routine Argument dialog box for external routines is as 

follows:

The Edit Routine Argument dialog box for external source routines 

is as follows:
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The Edit Routine Argument dialog box for external target routines 

is as follows:

Editing Column Definitions in a Parallel Job Stage
Editing the columns in a parallel job stage editor is similar to editing 

server job column definitions. The same controls are available; the 

differences lie in the fields that are presented to be edited in the Edit 
Column Meta Data dialog box. 
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Troubleshooting

This appendix describes problems you may encounter with DataStage 

and gives solutions. 

Cannot Start DataStage Clients
Check that the DataStage Engine is actually running on the server. 

On Windows servers, ensure that the DataStage Engine Resource 

service, RPC service, and DataStage Telnet service are all started.

On UNIX servers, ensure that the RPC daemon (dsrpcd) is started.

Problems While Working with UniData 
For more information about connecting to UniData sources, see the 

technical bulletin Accessing UniVerse and UniData Databases from 

DataStage (74-0121). This is supplied with the DataStage online 

documentation.

Connecting to UniData Databases
When the DataStage server is installed, a copy of the UniData API 

configuration file UNIAPI.INI is installed in the Windows directory. If, 

when you first attempt to connect to your UniData server, you get an 

error message similar to:

UniData Client error: call to UniOpenPos returned 45 - Client version 
(11) and server version (12) are incompatible
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then you must edit the UNIAPI.INI file and change the value of the 

PROTOCOL variable. In this case, change it from 11 to 12:

PROTOCOL = 12

Importing UniData Meta Data
When importing UniData meta data, note that the server name 

required in the DataStage Manager dialog box is the UniData server 

node name, not the ObjectCall (UNIAPI.INI) file entry name. 

If the UniData server is on the same node as the DataStage server, 

then the name localhost can be used.

Using the UniData Stage
The UniData stage uses the UniData Basic ITYPE function to evaluate 

virtual attributes and this requires that the virtual attributes are 

compiled. If they are not, when the link is opened an error occurs 

which indicates the first uncompiled I-type/virtual attribute it finds. In 

this instance, the solution is to compile all of the I-types/virtual 

attributes, not just the first one reported in the error message.

There are certain verbs that need to be available for use on the 

UniData database when the job containing the UniData stage is first 

run, or when the Data Browser is first used in the stage. These are:

BASIC

CATALOG

NEWPCODE

The BP directory file must also be available.

After the initial job run or first use of the Data Browser, these can be 

removed or disabled if required for security reasons.

Problems with the Documentation Tool

Installing the Documentation Tool
You should avoid trying to install the Documentation Tool in a 

directory with insufficient disk space. If the install runs out of space, 

an error can occur which removes the Tahoma font from the system, 

and that can subsequently cause problems with Microsoft Word. If 

this situation arises, the Tahoma font can be found in the 

Documentation Tool install directory, from where you can reinstall it.
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You should avoid running the setup program from within the 

Documentation Tool directory to remove or reinstall the tool. The 

operation will fail. Always use the main setup program on the 

DataStage CD.

Using Plug-In Reports
The report for a plug-in stage type does not include information as to 

whether the stage supports reference links.

Problems Running Jobs

Server Job Compiles Successfully but Will Not Run
Check that your job design does not have cyclic dependencies within a 

sequence of active stages. This may cause your job to fail as one 

stage waits for another, which is in turn waiting for it.

Server Job from Previous DataStage Release Will Not 
Run

If you run a job created using an earlier DataStage release, you may 

get the message:

Job has not been compiled with compatible compiler

The solution is to recompile, rerelease, and, if necessary, repackage 

jobs under the later release of DataStage.

Miscellaneous Problems

Landscape Printing
You cannot print in landscape mode from the DataStage Manager or 

Director clients.

Browsing for Directories
When browsing directories within DataStage, you may find that only 

local drive letters are shown. If you want to use a remote drive letter, 

you should type it in rather than relying on the browse feature.
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Usage Analysis
HTML Template

This appendix describes how to edit the template to customize the 

DataStage Usage Analysis HTML report format. The template is called 

UsageRptXXX.htm, where XXX indicates the locale for which the 

template is intended. The template is held in the DataStage directory.

The Usage Analysis tool allows you to check where items in the 

DataStage Repository are used. Usage Analysis gives you a list of the 

items that use a particular source item. You can in turn use the tool to 

examine items on the list, and see where they are used. You can view 

the Usage Analysis report in a browser in HTML format. The template 

file determines the format of the report.

The Usage Analysis tool is described in Chapter 12, "Usage Analysis."

This appendix describes the structure of a template and tells you how 

to modify it.

Template Structure
The default template file describes a report containing the following 

information:

General. Information about the system on which the report was 
generated.

Report. Information about the report such as when it was 
generated and its scope.

Sources. Lists the sources in the report. These are listed in sets, 
delimited by BEGIN-SET and END-SET tokens.
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Columns. Lists selected columns if the source is a table definition. 
These are listed in sets, delimited by BEGIN-SET and END-SET 
tokens.

Used. Information about the targets. These are listed in sets, 
delimited by BEGIN-SET and END-SET tokens.

The template file uses tokens to represent the real Usage Analysis 

information that will be inserted when an HTML report is generated. 

You can use these tokens when defining a different layout for the 

template.

Tokens
Template tokens have the following forms:

%TOKEN%. A token that is replaced by another string or set of 
lines, depending on context.

%BEGIN-SET-TYPE% … %END-SET-TYPE%. These delimit a 
repeating section, and do not appear in the generated document 
itself. TYPE indicates the type of set and is one of SOURCES, 
USED, or COLUMNS as appropriate.
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General Tokens

Report Tokens

Source Set Tokens

Used Set Tokens

Token Usage

%NOW% The current date and time in local format

%COMPANY% Company name

%BRIEFCOMPANY% Brief company name

%CLIENTPRODUCT% Client product name

%SERVERPRODUCT% Server product name

%CLIENTPATH% Client product installed path

%SERVERPATH% Server product installed path

%CLIENTVERSION% Client product version

%SERVERVERSION% Server product version

%PROJECT% Current project name

%SERVERNAME% Current server name

%USER% Current user name, if any

%INDEX% Index of current item within list context, 
reset to 1 whenever a new set begins

Token Usage

%CONDENSED% “True” or “False” according to 
state of the Condense option

%SOURCETYPE% Type of Source items

%SELECTEDSOURCE% Name of Selected source, if more 
than one used

%SOURCECOUNT% Number of sources used

%SELECTEDCOLUMNS-
COUNT%

Number of columns selected, if 
any

%TARGETCOUNT% Number of target items found

%GENERATEDDATE% Date Usage report was generated

%GENERATEDTIME% Time Usage report was generated

Token Usage

%INDEX% Index of current item within set

%NAME% Name of current item

Token Usage

%INDEX% Index of current item within set
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Columns Set Tokens

Default Templates
The following is a listing of the default templates supplied with 

DataStage.

See "Viewing the Report as HTML" on page 12-8 for an example of an HTML report 
generated with this template.

<!--
//*
//*''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''
//*'
//*'  UsageRpt.htm - HTML template for Usage Analysis Report
//*'
//*' (c) Copyright 1999 Ardent Software Inc. - All Rights Reserved
//*'   This is unpublished proprietary source code of Ardent Software Inc.
//*'   The copyright notice above does not evidence any actual or intended
//*' publication of such source code.
//*'
//*''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''
//*'
//*'   Description:
//*'
//*'   This file contains the HTML template that is used to generate 
//*' reports from Usage Analysis.
//*'
//*''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''
//*
-->
<HTML>
<HEAD>
<TITLE>
Usage Analysis - %SERVERNAME%\%PROJECT% - %SOURCETYPE% </TITLE>
</HEAD>

<H1 ALIGN="CENTER">Usage Analysis - %SERVERNAME%\%PROJECT% - %SOURCETYPE% </H1>

<P>
Usage Analysis Report for Project '%PROJECT%' on Server '%SERVERNAME%' (User '%USER%').<br>

Generated at %GENERATEDTIME% on %GENERATEDDATE%.<br>
Source items are of type '%SOURCETYPE%', %SOURCESCOUNT% used, '%SELECTEDSOURCE%' selected, 
%TARGETCOUNT% targets found.

%NAME% Name of current target item

%RELN% Name of current relationship

%TYPE% Type of current target item

%CATEGORY% Category of current target item

%SOURCE% Name of source for current target item

Token Usage

%INDEX% Index of current item within set

%NAME% Name of current item
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<P>Report Condensed = %CONDENSED% </P>

<hr size=5 align=center noshade width=90%>

<P>Sources:
<OL>
%BEGIN-SET-SOURCES%
<LI>%NAME%</LI>
%END-SET-SOURCES%
</OL>

<hr size=5 align=center noshade width=90%>

<P>Target Count = %TARGETCOUNT% </P>
<TABLE BORDER CELLSPACING=0 WIDTH=100%>
<TR BGCOLOR=#C0C0C0>
<TD><P ALIGN="CENTER"><B>Index</B></TD>
<TD><P ALIGN="CENTER"><B>Relationship</B></TD>
<TD><P ALIGN="CENTER"><B>Type</B></TD>
<TD><P ALIGN="CENTER"><B>Category</B></TD>
<TD><P ALIGN="CENTER"><B>Name</B></TD>
<TD><P ALIGN="CENTER"><B>Source</B></TD>
</TR>

%BEGIN-SET-USED%
<TR>
<TD>%INDEX%</TD>
<TD>%RELN%</TD>
<TD>%TYPE%</TD>
<TD>%CATEGORY%&nbsp;</TD>
<TD>%NAME%</TD>
<TD>%SOURCE%</TD>
</TR>
%END-SET-USED%

</TABLE>

<br>
<hr size=5 align=center noshade width=90%>

<P>Selected Columns (if source is Table definition) - %SELECTEDCOLUMNSCOUNT% selected:
<OL>
%BEGIN-SET-COLUMNS%
<LI>%NAME%</LI>
%END-SET-COLUMNS%
</OL>

<hr size=5 align=center noshade width=90%>

<FONT SIZE=-1>
<P>
Company:%COMPANY% (%BRIEFCOMPANY%)
<P>
Client Information:<UL>
<LI>Product:%CLIENTPRODUCT% </LI>
<LI>Version:%CLIENTVERSION% </LI>
<LI>Path:%CLIENTPATH% </LI>
</UL>

<P>
Server Information:
<UL>
<LI>Name:%SERVERNAME% </LI>
<LI>Product:%SERVERPRODUCT% </LI>
<LI>Version:%SERVERVERSION% </LI>
<LI>Path:%SERVERPATH% </LI>
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</UL>
</FONT>

<A HREF=http://www.ardent.com>
<img src="%CLIENTPATH%/company-logo.gif" border="0" alt="%COMPANY%">
</A>

<FONT SIZE=-2>
HTML Generated at %NOW%
</FONT>

</BODY>
</HTML>
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